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        JAGAT GURU NANAK DEV PUNJAB STATE OPEN UNIVERSITY, PATIALA 

 (Established by Act No. 19 of 2019 of the Legislature of State of Punjab) 

         

PREFACE 

 

Jagat Guru Nanak Dev Punjab State Open University, Patiala was established in December 2019 

by Act 19 of the Legislature of State of Punjab. It is the first and only Open University of the 

State, entrusted with the responsibility of making higher education accessible to all, especially to 

those sections of society who do not have the means, time or opportunity to pursue regular 

education. 

In keeping with the nature of an Open University, this University provides a flexible education 

system to suit every need. The time given to complete a programme is double the duration of a 

regular mode programme. Well-designed study material has been prepared in consultation with 

experts in their respective fields.  

The University offers programmes which have been designed to provide relevant, skill-based and 

employability-enhancing education. The study material provided in this booklet is self-

instructional, with self-assessment exercises, and recommendations for further readings. The 

syllabus has been divided in sections, and provided as units for simplification.  

The Learner Support Centres/Study Centres are located in the Government and Government aided 

colleges of Punjab, to enable students to make use of reading facilities, and for curriculum-based 

counselling and practicals. We, at the University, welcome you to be a part of this institution of 

knowledge. 

 

 

 

 

         Prof. G.S Batra 

Dean Academic Affairs 

 

 

 

 

 

 

 

 



 

 

                                                            M.COM 

                                                SEMESTER-II 

(MCMM21201T): COMPUTER APPLICATIONS IN ACCOUNTING 

 
MAX. MARKS: 100 

EXTERNAL: 70 

INTERNAL: 30 

PASS: 40 % 

Credits:6 

Objective: To provide computer skills and knowledge for commerce students and  to 

enhance the student understands of usefulness of information technology tools for business 

operations. 

 
INSTRUCTIONS FOR THE PAPER SETTER/EXAMINER: 

1. The syllabus prescribed should be strictly adhered to. 

2. The question paper will consist of three sections: A, B, and C. Sections A and B will 

have four questions from the respective sections of the syllabus and will carry 10 marks 

each. The candidates will attempt two questions from each section. 

3. Section C will have fifteen short answer questions covering the entire syllabus. Each 

question will carry 3 marks. Candidates will attempt any ten questions from this section. 

4. The examiner shall give a clear instruction to the candidates to attempt questions only at 

one place and only once. Second or subsequent attempts, unless the earlier ones have 

been crossed out, shall not be evaluated. 

5. The duration of each paper will be three hours. 

INSTRUCTIONS FOR THE CANDIDATES: 

Candidates are required to attempt any two questions each from the sections A and B of the 

question paper and any ten short questions from Section C. They have to attempt questions 

only at one place and only once. Second or subsequent attempts, unless the earlier ones have 

been crossed out, shall not be evaluated. 
 

SECTION A 

Computer Fundamentals 

Unit -1 Introduction to Computer, Windows Operating System (Dr.  Monika)  

Unit -2 MS Word, MS PowerPoint and MS Excel (Dr.  Monika)
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Computerised Accounting 

Unit-3 Computer and Computerized Accounting System (Outside) 

Unit-4 Electronics Spreadsheet, Use of Spreadsheet in Business Application (Outside) 

 
Application of Computer in Financial Accounting 

 

Unit-5 Graphs and Chart -I (Outside) 

Unit-6 Graphs and Chart –II Graphs and Chart –III (Outside) 

 

SECTION B 

Management Information System 

Unit -7 Management Information System: Basic Concepts (Outside) 

Unit -8 MIS Applications in Organization (Outside) 

Unit -9 MIS Issues and Challenges (Outside) 
 

Database Management System in Accounting  

Unit-10 Introduction of Database Management (Dr.  Monika) 

Unit-11 Introduction to Accounting (Outside) 

Unit-12 Accounting System using Database Management System (Outside) 

 

 
Suggested Reading: 

1. Hunt, R., J. Shelley, Computers and Commonsense, Prentice Hall of India. 

2. Sinha, Pradeep K. and Preeti Sinha, Foundation of Computing, BPB Publication. 

3. Saxena, Sanjay, A First Course in Computers, Vikas Publishing House. 

4. Leon A. & Leon M., Introduction to Computers, Leon Vikas Publications 

5. N. Subramanian, Introduction to Computers, Tata McGraw-Hill. 

6. Peter Nortorn, Introduction to Computers, Seventh Edition 
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SECTION A 

UNIT NO. UNIT NAME 

UNIT 1 Introduction to Computer 

UNIT 2 MS Word, MS PowerPoint and MS Excel 

UNIT 3 Computer and Computerised Accounting System 

UNIT 4 Electronics Spreadsheet, Use of Spreadsheet in Business Application 

UNIT 5 Graphs and Chart –I 

UNIT 6 Graphs and Chart –II Graphs and Chart –III 

 

SECTION B 

UNIT No.  UNIT NAME 

UNIT 7 Management Information System: Basic Concepts 

UNIT 8 MIS Applications in Organization 

UNIT 9 MIS Issues and Challenges 

UNIT 10 Introduction of Database Management 

UNIT 11 Introduction to Accounting 

UNIT 12 Accounting System using Database Management System 
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M.COM  

                                        SEMESTER II 

                        Course: Computer Applications in Accounting 

UNIT 1: Introduction of Computer & Windows Operating System 

 

1.1 Computer 

1.2 Characteristics of Computer 

1.3 Use of Computers 

1.4 Block Diagram of Computer 

1.5 Computer Generations 

1.6 Input Output Devices  

1.7 Classification of Computers 

1.8 Operating System 

1.9 Functions of Operating System 

1.10 Window Operating System 

 

1.1 WHAT IS COMPUTER 

 The word "Computer" comes from the word "Compute", which means, "to calculate". 

 In a layman language, a computer is a fast calculating device that can perform arithmetic 

operations. Although the computer was originally invented mainly for doing high speed and accurate 

calculation, it is not just a calculating device.  The computer can perform any fiend of work 

involving arithmetic and logical operations are data.  It gets the data through an input device 

processes at as per the intuitions given and gives the information as output. We can define a 

computer as follows:- 

 A computer is a fast electronic device that processes the input data according to the 

instructions given by the programmer/ uses and provides the desired information as output.  

 More accurately we can define a computer as a device that operates upon data.  

1.2 CHARACTERISTICS OF COMPUTER 

 Increasing popularity of computers has proved that it is powerful and useful tool the power 

and usefulness of this popular tool are mainly due to its following characteristics.  

1) Automatic :-  Computers are automatic machines because once started on a job they carry 

out the job normally any human assistance until  it is finished. However, computers being 
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machines cannot start them solves and cannot go out and find there own problems and 

solutions we need to instruct a computer using coded instructions that spicily exactly how it 

will do a particular job.  

2) Speed :- A computer is a very fast device.  It amount of work that a human being can do in 

on entire year.  

 A powerful computer is capable of performing several billing (10)
9
 single arithmetic 

operations per second.  

3) Accuracy :-  In addition to being very fast computer are very accurate.  accuracy of a 

computer is consistently right and degree of its accuracy depends upon its deign.  A computer 

performs every calculation with the same accuracy.  

 However errors can occur in a computer these errors ore mainly due to human rather than 

technological weaknesses.  

4) Diligence:-  Unlike human beings, a computer is fire from monotony, tiredness and lack of 

concentration. It can continuously work for hours without creating any error and without 

rumbling.  It ten million calculation rave to be performed a computer will perform the last 

one with exactly the same accuracy and speed as the first one.  

5) Versatility :-Versatility is one of the most computer. One moment it is preparing results of an 

examination next moment it is busy preparing electricity bills and in between, it may be 

helping an office secretary to trace an impotent letter in seconds in brief a computer is 

capable of performing almost any task.  

6) Power of Remembering:- As a human being acquires new  knowledge his/her brain 

subconscious  selects what it feels to be important and worth retaining in memory.  The brain 

relegates unimportant details to back of mint or just forgets them.  This is not the case with 

computers.  A computers can store and recall any amount of information because of its 

secondary storage ca type of detachable memory capability.  

7) No IQ:-   A computer is not a magical deice it possesses no intelligence of its own its I.Q. is 

zero, at least until today.  It has to be told what to do and  in what sequence.  A computer 

cannot take its own decision in this regard.  

8) No feelings :-  Computers are devoid of emotions they are machines. No Computers 

possesses the equivalent at a human heart and soul.  Based on our feelings tests, knowledge , 

and experience we often make certain judgments in our day to day life but computer make 

judgments based on the instructions given to them in the form of program that are written by 

is chairman beings.  
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1.3 USE OF COMPUTERS :- 

  Computers our being used in many areas application like business, industry, scientific 

research, Defense, Space, Communications, medicine, education etc.  The utilization of 

computers in different fields is summarized as follows:- 

1) Scientific Research:- Used to resolve complex scientific problems accurately in a short time.  

2) Industry:- Used in electricity, steel, paper, printing, engineering and other  industries for 

production.  

3) Business:- Used in banks airports, hotels export hones, Govt. offices and other for computer 

sing business applications like financial accounting etc.  

4) Defense:- Used to computers liver planes ships, radars etc.  

5) Space :-Used to design computerised space satellites rockets and related technology. 

6) Data Communication:- Used to computers geo- graplrically separated offices through 

networking.  

7) Telecommunication :- Used in E-mail, Internet, Video Conferencing, Cellular phones etc.  

8) Medicine :-  Used in hospitals and nursing home/clinics for maintain medical records, 

prescription writing and computerised scanning etc.  

9) Education:- Used in development of CBT (Computer Bored Teaching programmers for 

education.  

10)  Law and order:- Used to records data of vehicles criminals finger prints etc.  

11) Libraries :-  Used to develop library management systems.  

12) Publishers - Used for designing and printing of books.  

13) Engineering :- Used for CAD (Computer sided designing by engineering companies.  

14) Emerging Technologies :- Used in Artificial Intelligence like Robotics.  

 

1.4 BLOCK DIAGRAM OF COMPUTER:-  

 Computer has following components:-  

1) Input unit  

2) Output unit 

3) Storage Unit  

4) Arithmetic logic unit 

5) Control Unit 

6) Central Processing Unit.  

  The block diagram of basic computers organisation is as follows: this figure, solid 

lines indicate flow of instruction and data and doled lines represent control exercised by 
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control unit. These units correspond to the basic operations performed by all computer 

systems.  

 

 

 Program Data      Informatic (Results) 

 

 

 

             

             

             

           

          Indicates flow of  

                  instruction and data  

 

         Indicate the control   

        exercise control unit  

     Central Processing Unit  

      (CPU) 

1) Input Unit:-  Data and instructing must enter a computer system before the computer can 

perform any computations enter a computer through an input unit in a form that depends upon 

the input device used. Input unit performs the following functions:- 

 1) It accepts instructions and data from outside world. 

 2)  It convert these instructions and data in computer readable form.  

 3) It supplies the converted instructions and data to computer system for   

 further.  

2) Output Unit:- An output unit performs the reverse operation of that of an input unit. It 

supplies information obtained from data processing to outside word means it present a data in 

a from people can understand. An output unit performs following functions:- 

 1) It reads the results produced by a computer, which are in coded from and we cannot 

 easily understand them.  

 2) It converts these coded results to human readable form.  

 3) It supplies the converted results to outside world.  

Secondary 

storage 

Primary 

Storage  

Input Unit Output Unit 

Control Unit 

Arithmetic 

unit  
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3) Storage Unit:- Data and instructions entered into a computer system through input units rave 

to be stored inside the computer before actual processing starts, Similarly, results produced 

by a computer after processing have to be kept somewhere inside the computer system before 

being passed on to an output unit storage unit of a computer system caters to all these needs.  

 A storage unit world:- 

 1) Data and instructions required for processing received from input  devices. 

 2) Intermediate results of processing.  

 3) Results for output before they are released to an output device.  

 Storage unit of all computer is of following two types :- 

a. Primary Storage  

b. Secondary Storage  

a. Primary Storage :-  Primary storage of computer also known as its main memory.  

  2) It is used to hold pieces of program instructions and data and   

 intermediate results of processing.  

  3) However primary storage can hold information only while  computer system 

  is on. As soon as the computer system switches off or resets the information 

  held in primary storage is erased.  

  4) Primary storage normally has limited storage capacity because   

  it is very experience  

  5) Primary storage of modem computer system is made of    

  semiconductors devices.  

         b. Secondary Storage:- It is also known as  auxiliary storage it is used to takes care of the 

limitations of primary  storage.  That is it supplements the limited storage capacity and the 

volatile characteristic of primary is much cheaper then primary storage and it can retain 

information even when a computer system switches off or resets.   

4) Arithmetic logic unit:- It is the place where actual execution of instructions takes tons are 

performed and all comparisons are made in ALU. Data and instructions stored in primary 

storage before processing are transferred as and when needed to the ALU. Where processing 

takes place Intermediate results generated in the ALU are temporarily transferred back to 

primary storage until needed later.  In short, data may move firm primary storage to ALU and 

back again to storage many times before processing is over.  

5) Control Unit :-How does the ALU know what should be done with data once they are 

received? How it is that only results for output are sent to an output device and not the 

intermediate results? All this is possible due to the control unit of the computer system it does 
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not perform any actual processing on data. It manages and co-ordinates the entire computer 

system. It obtains instructions from the program stored in main memory interprets the 

instructions and issues signals causing other units of the system to execute them. 

6) Central Processing Unit:- Control unit and arithmetic logic unit of a computer system we 

together known as central  processing unit (CPU) . The CPU is brain of a computer system in 

a computer system all major calculations and comparisons take place inside the CPU and the 

CPU is responsible for activating and controlling the operations of other units of the computer 

system.  

 

1.5 COMPUTER GENERATIONS:- 

  "Generation" in computer talk is a step in technology. It provides a framework for the 

growth of computer industry.  

  There are tonally give computer generation known till today.  Generations are major 

stages in the historical development of computing.  

1) First Generations (1942-1955):- 

  First Generation computer used thousands of vacuum tubes.  A vacuum tube was a 

fragile says device which used filaments and could control electronic signals first generation 

computer were the only high speed electronic device available in these days. These vacuum 

tube computer could perform computations in milliseconds and known as first generation 

computers. 

  All data and instructions were fed into the system from punched cards.  Only few 

specialists understand how to program these early computers.  Machine and assembly 

languages are used.  

1) They were too bulky in size, requiring large rooms for installation. 

2) First generation computers used thousands of vacuum tubes that emitted large amount of heat. 

These computers were located has to be properly air conditioned.  

3) They were the fastest calculating devices of their time.  

4) Power consumption of these computers were very high because each vacuum tube consumed 

about hey a watt of power.  

5) As vacuum tubes used filaments they had a limited life.  These computers were prone to 

frequent hardware failures.  

6) Production of these computers was difficult and costly because thousands of components 

were assembled manually.  
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2) Second Generation (1955-1964):- 

  The second generation computers were manufactured using transistors instead of 

vacuum tubes.  Second generations computers were more powerful more reliable less 

expensive smaller, and cooler to operate than the first generation computers.  

  Punched cards were still popular and widely used for entering data to these computer 

high level programming languages (FORTAN, COBOL) were easier for people to understand 

and work with than assembly or machine languages features:- 

1) Second generation computers were more than ten times faster than the first generation 

computers.  

2) They were smaller than first generation computers and required smaller space.  

3) They could switch much faster than tubes.  

4) They were more reliable than first generation computers.  

5) They had faster and larger primary and secondary  storage as compared to first generation 

computers.  

6) They consumed less power than first generation computers. 

7) They were easier to use than the first generation computers.  

8) They were less expensive to produce.  

3) Third Generation (1964-1975):- 

  Computers built using integrated circuits characterized the third generation.  

 Integrated circuits are circuits consisting of several electronic components like transistors, 

resistors grown on a single chip of silicon. Were Smaller less expensive to produce more 

reliable faster in operation dissipated less heat and consumed less power hence, third 

generation computers were more powerful more reliable less expensive smaller and cooler to 

operate than second generation computers.  

Features:- 

1) They are more powerful than second generation computers. 

2) They were smaller than second generation computers. Hence requiring smaller space.  

3) They consumed less power and dissipated less heat than second generation computers. Third 

generation computers were located still required to be properly air conditioned.  

4) They were more reliable and less prone to hardware failures than second generation 

computers.  

5) These had faster and larger primary and secondary storage as compared to second generation 

computers.  
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6) Commercial production of these systems were easier and cheaper because their manufacture 

did not require manual assembly  of individual components.  

4) Fourth Generation (1975-1989):- 

  Fourth generation computers started a new social revolution personal computer (PC) 

revolution. 

 During fourth generation memories replaced by large random access memories with very fast 

access time. Hard disks became cheaper, smaller and larger in capacity. Magnetic takes 

became very popular as a portable medium for forting data from one computer to another.  

Features:- 

1) PCs were smaller and cheaper than third generation computers.  

2) No air conditioning was required for PCs.  

3) They consumed less power than third generation computers.  

4) They were more reliable and less prone to hardware failures than third generation computers.  

5) They had faster and larger primary and secondary storage as compared to third generation 

computers.  

6) They were general purpose machines.  

7) Commercial production of these systems were easier and cheaper because their 

manufacturing did not require manual assembly of individual components.  

8) Programs or data could be easily ported from one computer to another computer.  

9) PCs were powerful tool for both office and home usage.  

5) Fifth Generation (1989- Present):- 

  During fifth generation there was tremendous out growth of computer network. 

Communication technologies become faster day by day and more and more computers were 

networked together. This trend resulted in emergence and popularity of the Internet and 

associated technologies and applications. The internet made it possible for computer were 

sitting across the globe to communicate with each other within minutes by use of e-mail 

(electronic mail) facility.  

Features:- 

1. Portable computer (Note book computers) are much smaller and handy than PCs of fourth 

generation computer.  

2. Fifth generation computers are several times more powerful than PCs of fourth generation.  

3. No air-conditioning is normally required for notebook computers.  

4. They consume less power than fourth generation computers. 

5. They are more reliable and less prone to hardware failures than fourth generation computers.  
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6. They have faster and larger primary and secondary storage as compared to fourth generation 

computers.  

7. They are general purpose machines.  

8. In fifth generation computers there are computers for almost any type of user whether the 

user is a child or a scientist.  

 

1.6 INPUT- OUTPUT DEVICES (PERIPHERAL DEVICE):-  The computers are useful only 

when these are able to communicate with users or external environment or operators.  For this 

input and output devices are used.  These are also called as peripheral devices jointly. The 

term peripheral means all devices attached to computer.  

  Input devices is used to enter data in computer.  Output device display data form 

memory of computer.  

  Now a dark a variety of input and output device are available. User can use these 

device according to their need.  Some devices are used for Input as welt as output.  

 Input         Result of   

         processing in   

         human acceptable form 

 

 

(a) Input devices:-   An input device is an electromechanical device which is used to enter data 

or instructions from outside to computers main memory.  

  Input unit performs the following functions:- 

1. It accepts instructions and data from outside world.  

2. It converts these instructions and data in computer readable form.  

3. It supplies the converted instructions and data to computer system for further processing.  

 Various types of input devices are as follows :- 

 1. Keyboard 

 2. Mouse 

 3. Trackball 

 4. Space ball 

 5. Joy stick  

 6. Light pen 

 7. Touch screen or Touch pannel 

 8. Data glove 

Input 

device 

CPU 

memory  

Output 

devices   
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 9. Image scanner 

1. Keyboard:-  The most commonly used input device is keyboard the data is entered by 

pressing set of keys.  All keys are labeled. A keyboard with 101 keys is called as qwerty 

keyboard.  

  The keyboard has alphabetic as well as numeric keys some special keys are available. 

2. Mouse:-  A mouse is small hand held box.  Wheels are provided on bottom of mouse. Mouse 

is rotated on flat surface. Mouse can  be picked and moved to other place without change the 

position of screen courser. 

  Mouse can have two button or three button. Buttons are provided at top of mouse.  

Mouse is attached with CPU using wire.  

Advantage:- 

 1) It is simple to operate.  

 2) It is low cost device 

 3) It can select graphic object fastly.  

 4) It is used for quick positioning of curser on an item.  

Disadvantage :-  Small rotation of mouse can cause error in readings.  

3. Trackball :-  It also is a pointing device. It is similar to mouse except that you don't have to 

move the enter device like mouse rather only the ball is used for cursor movement. Ball is 

rolled with fingers. It requires less space for performing its operation. Sometimes it is fixed 

with mouse sometimes with keyboard.  

  Due to limitation of space in laptop it is not suitable as part of keyboard. 

  It can be rotated with palm also to produce curser movements on screen.  

4. Space Ball:-  It is similar to trackball but it can move in six direction whereas trackball can 

move in two directions only. It can be pushed and pulled in various directions.  

5. Joystick:-  It is a pointing device its working is same as that of trackball but instead of  

moving with hand ball is moving using stick ball is fixed socket. On socket stick is mounted 

stick can be moved in left right top down direction.  The stick is also called as lever.  The 

joystick can be mounted on keyboard. The stick is moved in any direction and amount of 

movement of cursor corresponds to amount of movement of stick. Joystick are less 

expensive. 

 Uses:-  1. It is used to play video games.  

  2. Joystick is used by flight stimulatory 

  3. It is used for controlling industrial robots. 
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6. Light Pen:-   It also is a pointing device its shape is like pen or penal. It can detect light 

coming from points on CRT screen. Pen with not detect light emitted from background 

sources. When pen is on it is pointed on screen than bean will light up that spot it will 

generate pulse.  

Disadvantage:-   

1.  It pen is used for longer period of time then it courses arm fatigue.  

2. It gives false readings due to background light in room.  

7. Touch Screen or Touch Panel:-  It allows display of objects using a touch of finger.  

Touch panel will select any icon as option from set of icons displayed on screen.  

Advantage:-   

1. It is a simple method of selecting graphical object.  

2. It is an easy way of input.  

Application:- 1. These are used as information work for displaying.     

 information at hotel restaurants.  

   2. In public places like parks these are used to guide people by   

 displaying information.  

8. Data Glove :-  It is a glove that you can wear in your hand. Glove can grasp virtual objects. 

Glove has a series of sensors.  The seniors can detect movement of hand and fingers.  

9. Image Scanner:-  It is an input device the data or text is rewritten on paper.  The paper is 

feeded to scanner.  The paper  written information is converted into electronic format. This 

format is stored in computer. The input documents can contain text, handwritten material 

picture etc.  

  By storing the document in computer, it becomes safe for longer period of time.  The 

document will be permanently stored for future we can print the document when needed.  

Output devices:-  An output device generally is an electromechanical device which accepts data 

from a computer and translates then into a form understand able to users.  It is as important as input 

device. It perfumer the reverse operation of that of in input unit.  

  An output unit performs following functions:- 

1. It accepts the results produced by a computer, which are in coded form and we cannot  easily 

understand them.  

2. It converts these coded results to human readable form.  

3. It supplies the converted results to outside world.  

There are many types of output devices.  Some commonly used output devices are as follows:- 

1. Monitors or VDU (Video display unit)  
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2. Printers 

3. Plotters  

4. Speakers.  

An output device can be one of the following tow types.  

(a) Soft copy devices.  

(b) Hard Copy devices.  

Soft Copy device:-  The output is produced on device not on paper.  The output is temporary and 

erased when device is switched off.  The output displayed on monitor is soft copy.  

Hard Copy device:-   It is output produced on paper. It can be touched.  We can carry out paper to 

other place.  It can be shown to other people also.  It is not erasable.  It can be stored permanently for 

future purposes.  Output produced by platter and printer are example of these.  

1. Monitors:-  It is most popular device for producing soft copy output.  It is also called as 

VDU (Visual display Unit). A monitor is attached with keyboard and CPU.  The keyboard will be 

used to enter data. The CPU will process the data.  The output will be displayed on monitor.  

2. Printers:-  A printer is an output device that produces text and graphics on paper.  Printer is 

used to get the "Hard copy" of that documents.  Printer is divided into two types.  

(a) Impact Printers.  

(b) Non Impact Printer. 

(a) Impact Printers:-  The printers in which there is a mechanical contact between printer head and 

paper for printing are called impact printers.  These are noisy printers. These are similar to 

typewriter. 

For example :- 1. Dot Matrix  

   2. Line Printers 

1. Dot Matrix :-  Dot matrix printer is an impact printer that produces text and graphics when tiny 

wire pins on the print head strike the ink ribbon.  

 Higher number of pins means that the printer prints more dots per character thus resetting in 

higher print quality.  

Advantages:-   

1. Low printing cost per page 

2. Retable, colorable 

Disadvantages :-  

1. Noisy  

2. Limited print quality  

3. Low printing speed 
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4. Limited color printing.  

2. Line Printers:-  Line printers are impact printers used with most medium and large computer 

systems for producing high volume paper output.  They are fast printers having speeds in the range of 

300 to 2500 lines per minute.  

(b) Non-Impact Printers:-  The printers in which there is no mechanical contact between paper and 

printer are called non impact printers. These are not noisy.  

For example:- 1. Inkjet Printers 

   2. Laser Printers.  

1. Inkjet Printers:-   

 Inkjet printers are non impact printer which print text and images by spraying tiny droplets of 

liquid ink onto paper.  They are most popular printers for home use.  Inkjet printers produce 

high quality output.  

Advantages:-  1. Low cost 

   2. Good for printing pictures  

   3. High quality of output  

   4. Easy to use  

   5. Reasonably fast 

Disadvantages :-  1. Ink bleeding causing blurred effects one some paper  

   2. Ink is sensitive to water, even a small drop of water can   

   course blurring.   

2. Laser Printers:_  Laser Printers are non impact printers which can print text and images in high 

speed and high quality resolution. Laser printer are page printers. An entire page is processed 

at a time. They use laser beam to produce an image of the page.  

Advantage :-  1. High Print speed. 

   2. Printout is not sensitive to water.  

   3. Good for high volume printing.  

Disadvantages :-  1. More expensive than inkjet printers 

   2. Bulkier than inkjet printers.  

   3. Laser printers are less capable of print high quality    

 images such as photos.  

3. Plotters :-  Plotters are output devices. They are used to produce good quality graphics and 

drawing under computers control.  They use ink pen to draw graphics or drawings. Either 

single color or multicolor pens can be employed. 
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  Pen plotters are slow devices.  A pen plotter can take from several seconds (for simple 

drawings) to several minutes (for complex drawings) to produce a drawing.  But it takes 

much less time as compared to traditional hand methods of producing drawing.  

There are two types of plotters :- 

1. Drum Plotter  

2. Flat bed plotter  

1. Drum Plotter:- In drum plotter, the paper on which the graph is to be drawn is mounted on a 

rotating drum.   

  The drum can rotate in either clockwise or anticlockwise direction under the control 

of the plotting instructions sent by the computers.  

  The pen can move left to right or right to left.  The pen can also move up or down.  

The movement of the pen and drum are controlled by the graph plotting program.  

2. Flat Bed Plotter:-  A flat bed plotter has a surface on which paper is fixed. 

  The pen can be moved up or down.  This type of plotter is called a flat bed plotter 

because it plots on paper which rests on a flat bed.  

4. Speakers:-  Computer speakers or multimedia speakers are speakers external to a computer that 

disables the lower fidelity built in speaker.  A voice response system has an audio response 

device i.e. speaker which produces audio output obviously the output is temporary soft copy 

output. Banking industry uses speaker in ATM . 

 

1.7 CLASSIFICATION OF COMPUTERS:-  

 Today computers are classified based on their made of use.  According to this classification 

computers are classified as notebook computers personal computers workstations, mainframe 

systems super computers and client and saver computers.  

1. Note book Computers (LAPTOPS) :- 

 Notebook computers are portable computers use by people who need computing resource 

wherever they go notebook computers can easily fit in a briefcase. Notebook computers are 

light in weight weighing around. 2 kg. They are also known as Laptop PCs (Laptop personal 

computers or simply Laptop) because they are as powerful as a moderate PC, and their size 

and weight allows them to be used comfortably. 

  We can use Laptop even at places where there is no eternal power source available 

(for example while travelling in a tram or airplane). Hence they are designed to operate with 

chargeable batteries with a fully battery a laptop can operate for a few hours.  
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2. Personal Computers (PCs)  :- Micro computers a PC is a non portable general purpose computer 

that fits on a normal size office table and is used by one present at a time.  Users use PCs for 

their personal computing needs either at their work places or at their homes.  PCs have 

changed the work habits of organizations. An increasing proportion of office work now 

involves use of computers.  

  Those employees who could not work during traditional office hours due to personal 

reasons can now work part of their time in office and remainder at home by having a PC at 

their homes. Several individuals also keep a PC at their homes to run business firm homes. 

Children use PCs for education and entertainment.  

  Hence, PCs are now very common everywhere, and can be found in offices 

classrooms, homes, hospitals, shops, clinics etc. It is also known as microcomputers. 

3. Workstations:-  

  A workstation is a powerful desktop computer designed to meet computing needs of 

engineers architects and  other professionals who need greater processing power large storage 

and better graphics display facility than normal PCs provide for example workstations are 

used commonly for complex scientific and engineering problems. A workstation is almost 

similar to high end PC, and is used typically by one person at a time.  

4. Mainframe Computers:-  

  Mainframe computers are computer systems that are mainly used for handling data 

processing needs of large size organizations. There are several large size organizations such 

as banks hospital, railways etc, that need on line processing of large number of transactions.  

  Mainframe computers are very large and fast computers.  They are used in centralized 

location where many terminals (input/output devices) are connected with one CPU and thus 

allow different users to share the single CPU. They have a very high memory and can support 

thousands of were.  

  Mainframe systems are much bigger and several time more expensive than 

workstations.  

5. Super Computer:-   

  Super computers are the most powerful and expensive computers available at any 

given time.  They are mainly designed for complex scientific applications that require 

enormous processing power.  

  Super computers have many CPUs which operate in parallel to make it as a fastest 

computer.  

  It is mainly used for following applications:- 
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 1. Weather information  

 2. Defence 

 3. Medicine etc . 

6. Client and Server Computers:- 

  With increased popularity of computer networks, it has become possible to 

interconnect several computers that can communicate with each other over the network.  

 

1.8 Operating System (OS) 

 A set of programs that control how the system works.  It is the most important program that 

runs on a computers (Program and data) 

  All computers must have an operating system used for starting the computer and to 

run other programs. It provides an interface between a user of a computer and the computer 

hard work.  

  Operating system perform basic tasks such as recognizing input from keyboard 

sending output to the display screen, keeping track of files and controlling peripheral devices 

such as printers.  

  The operating system is also responsible for security ensuring that unauthorized users 

do not access the system. It is like a traffic cop it makes sure that different program and users 

running at the same time do not interfere each other.  

 

1.9 Functions of Operating System 

  The following are the main functions performed by an operating system:- 

1. It works as an interface between hardware and software.  

2. Memory management allocation of main memory and other storage areas to the system 

program as well as user program.  

3. Input/Output management assignment of the different Input/output device while they are 

being executed.  

4. Processor management assignment of processor to different tasks being performed by the 

computer system  

5. File management creation of a new file copying moving a file from one storage location to 

another.  

6. Priority system It determines and maintains the order in which jobs are to be executed in the 

computer system.  

7. Data Security and Data Integrity unauthorized users do not access the system.  
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1.10 Window Operating System 

 Window is an operating system with a graphical user interface. We can open more than one 

window at a time.  

Key Points: 

 Windows support networking. 

 2. We can set the wallpaper Multiuser OS 

 3. We can set the time dire city.  

 3. Windows is Multitasking.  

 4. We can set the dire city.  

 4. Windows has a GUI (Graphical user interface) which means you can use a, mouse, new 

pictures, icons etc.  

 5. We can change the time zone 

 5. Windows is easy to learn and understand.  

 6. We can set the screen saver  

 6. Windows is more preferable operating system.  

 7. We can enjoy playing games notching movies and listening songs.  

 8. Windows operating system is user friendly 

 9. Windows performs operation sleekly 

 10. It can detect and installs new hardware automatically. 
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2.1 Word Processing 

Word processing was one of the first applications developed for computers and is one of the most used 

applications for personal and office productivity. Originally it was an application developed for the 

production of print material as a replacement for the typewriter. The advantages of using a word processor 

over the typewriter is that mistakes can be corrected easily and documents can be saved for future use and 

edited as needed. 

Development of the Word Processor 

The term ―word processing‖ was coined by IBM in the late 1960s and was used to describe the 

―combination of people, processes and equipment used to transform ideas into printed communication‖ 

(New York Times, September 12, 1972). Soon after the term was understood to mean a typewriter with 

automatic features for editing and correcting documents electronically, making it possible to produce a 

perfect original document. 

Originally word processors had no screens and saved copies of documents on magnetic tape for retyping, 

corrections or printout. Later models could display one line of text on a small screen, making it easier to 

edit documents. The labour and cost savings of word processing technology were immediate. Documents 

no longer had to be retyped to fix simple errors and could be saved, stored, reused and worked on later. 

The next generation of word processors consisted of dedicated machines with CRT monitors capable of 

displaying many lines of text at once. 

These word processing appliances were produced by large companies such as IBM and sold for as much as 

US $10,000. Hand in hand with the development of word processing technology was the development of 

new technologies for storing and printing documents, such as the floppy disk and daisy wheel printer. 

In the early 1980s the development of word processing software and the pricing of personal computers was 

the beginning of the end for word processing devices. Personal computers had the advantage because they 

came with other software, such as spreadsheets and eventually the graphical user interface to make working 

with documents easier. 

 

2.2 Word processing concepts 

Modern word processors 

Word processors have evolved into multifunctional publishing applications. Some of the tasks 

modern word processing applications are capable of are: 

 Preparing batch mailings by combining a form letter template with a database file 

containing individual information 

 Creating keyword indexes 

 Creating tables of contents with page numbers 



 Creating footnotes 

 Grammar checking, spell checking and thesaurus functions 

 Creating custom headers and footers for documents 

Design considerations for word processed documents 

At its most basic level a word processed document is a means to convey your message. Incorporating the 

fundamentals of good design in your documents makes it easier for the reader to understand that message. 

Even a well-written document that is not laid out well can be hard to read, resulting in your message being 

lost. 

Effective documents are organised so that information is presented in easily digestible pieces, important 

information is emphasised and ideas are presented logically. Here are some guidelines: 

• Write effective paragraphs 

An effective paragraph organises a sentence or group of sentences around a single main idea. There is no 

ideal paragraph length although a paragraph that is overly long can be harder to read thus hiding your 

message. Make sure your paragraphs have one main idea and split paragraphs if necessary. 

• Write effective sentences 

Just as with paragraphs, a reader understands of your message depends on logically organised sentences. 

Good sentences are clear, coherent and have good ―flow‖. 

• Use headings and subheadings 

Headings and subheadings serve as guideposts for your reader. They help to organise material into smaller 

sections within a common theme, breaking up your document into digestible pieces. 

• Use bulleted or numbered lists 

Lists help organise parallel ideas or ideas that need to be presented in a sequence. For a list to be effective, 

it should: 

 form a logical group 

 use parallel structure 

 use words, phrases or short sentences  

 use numbers to imply a hierarchy or order, either for a list of items in priority sequence or a set of 

step-by-step procedures 

 Use white space to separate and emphasize points 

White space is the space in your document that has no text or graphics. White space is a good way to 

separate points or sections in your document and makes your document easier to read. 

• Use graphics and illustrations effectively 

Graphics are also a good way to make your document seem less text-heavy but they should only be used 

when they have a direct relationship with the message of your document. Graphics should be placed close 



to the text they refer to, in a way that doesn’t obstruct the flow of the reader. Graphics should be of good 

quality, clear and have descriptive captions. 

• Emphasize headings 

Use larger type, a different typeface, surrounding white space or bold type for headings to draw the 

reader’s attention. 

• Use a different typeface for contrast 

Capitalize words used as headings for emphasis. Use italics or bolding for phrases or single words for 

emphasis. 

• Choose the right font 

Fonts can create a visual impression that acts upon your reader. Use at least a font size of 10. Limit the 

number of different fonts you use in a document. Colour, highlighting and other decorative elements 

should be used sparingly and only for emphasis when needed. Serif fonts have ornamental strokes at the 

ends of letters and work well for bold type and for printed copies. Sans serif fonts are simpler and are easier 

to read on a computer screen. 

 

2.3 Use of Templates 

A template is a document with a design that can be used by other documents. Templates are 

very useful if you are working with a group of documents that should all look the same. 

For example, a manager may have a set of templates for letters, memos, faxes and reports. An accounting 

clerk may have templates for invoices and account statements. Each template would be designed differently 

and any document created from a template would start out having the same design as the template. 

1. Click on File on the menu Bar 

2. Click on New on the drop down menu 

3. Click on Templates and Documents 



 

This will open the Template dialogue window. 



Double-click on the Business Correspondence link to see the templates in that category. 

 

4. Select the Project Proposal template and click on the Open 

Button to open it. The document that opens looks like this: 



As you can see the document already has much of the formatting done for you, making it easy 

for you to create a new project proposal document based on this template. 

You can also create and save your own templates in Open Office Writer. We will discuss this more in a 

later section. 

2.4 Working with Word Document 

2.4.1 Editing text 

Once you have typed your text into Microsoft Word, you will probably want to edit and format 

your document to make it more appealing. The best thing about Word is that it highlights any errors that 

you have made, whether it is a typo, a misspelling, or a grammar error. Some errors will be automatically 

corrected as you type. For instance, if you type the word 'example', Word will correct it for you 

automatically. 

Follow these steps to add, replace, and format text in Word. 

Add text 

To enter text, in most cases just begin typing. As you type, the insertion point moves and your text 

automatically continues on the next line. 

 Place the cursor where you want to add the text. 

 Start typing. 

Moving or copying text 

You can move text, or a copy of it, to another location. When you use the Cut or Copy command in the 

Edit menu, the selected text is placed in a holding area called the Clipboard, where the text remains until 

you choose Cut or Copy again or you turn off your computer. The Clipboard holds the contents of only one 

Cut or Copy at a time 

To remove text from one location and move it to another: 

 Select the text and choose Cut from the Edit menu. 

 Click with the I-beam pointer where you want to move the text and choose Paste from the Edit 

menu. 

Replace text 

 Select the text you want to replace. 

 To select a single word, double-click it. 

 To select a line, click to the left of it. 

 Start typing. 

 



Format text 

 Select the text you want to format. 

 Select an option to change the font, font size, font colour, or make the text bold, italics, or 

underline. 

 

Delete text 

To remove text without placing a copy on the Clipboard: 

 Select the text and choose clear from the Edit menu or press the Delete key. 

2.4.2 Find and replace text 

The Find and Replace tool allows you to search for words or phrases— or, for that matter, for any 

combination of characters in a document—and replace them with the text you want 

 

Searching for text 

1. From the Edit menu, click on Find and Replace 

2. In the Search for input box, type in the text you would like to search 

for. 

 

 



 

3. Click on the Find button to find the first instance of your search text. 

4. Clicking again on the Find button will search through the document to 

find further instances of your search text. 

Replacing text 

1. From the Edit menu, click on Find and Replace. 

2. In the Search for input box, type in the text you would like to search 

for. 

3. In the Replace with input box, type in the text you would like to 

replace the search text with. 

 

 

4. You can either replace instances of the search text all at once or one at 

a time. To replace one at a time: 

a. Click on the Find button to find the first instance of your 

search text. 

b. Click on Replace to replace that instance. 

c. Continue until you have finished making replacements. 

5. To replace all instances: 

a. Click on Replace All button. 

6. Click Close to return to your document when you are finished 

replacing text. 



2.4.3 Formatting 

Text Formatting 

The following exercises will guide you through applying formatting to text, but also apply to formatting 

paragraphs. It’s important to note that formatting should be used to enhance the readability of your 

document, according to the guidelines discussed earlier in this module. Overusing formatting can detract 

from your document’s readability. 

Fonts and font sizes 

Your choice of fonts should set the tone for a design, provide the best readability and convey 

the right image. There are certain established guidelines and best practices for selecting fonts 

for the best results, but these are not hard and fast rules: 

 Don’t use more than 3 or 4 fonts in your document. 

 Avoid mixing two very similar fonts. 

 Serif faces are the norm for most books and newspapers, 

making them familiar and comfortable to readers and a 

good choice for many printed documents. 

 Sans serif fonts are a good choice for documents that 

are read from a computer screen. Sans serif fonts are 

generally more readable when the font size is small (e.g. 

for footnotes or captions). 

 For most documents, a font size of between 10 point and 12 

point is appropriate. 

 

To choose a font and font size: 

 

1. Highlight the text that you want the font applied to. 

2. From the formatting toolbar, click on the down arrow next to the 

font box and choose a font from the list. 

3. From the formatting toolbar, click on the down arrow next to the 

font size box and choose a font size from the list. 



Bold, italics and underlining 

You can use bold, italics and underline to place emphasis where needed in your document. 

Bold face is often used to draw attention to a block of text by making it stand out from the 

surrounding text. Bold face is also often used for headings. 

 

Italic face can also be used for emphasis, but its impact is more subtle than bold face. Italic 

face is often used for titles (e.g. book titles, movie titles), the proper names of ships or trains 

(e.g. the Orient Express) or for foreign words or phrases within text. Be careful not to create 

long blocks of text with italic face, since it is more difficult to read. 

 

Underlining text can also be used to emphasize parts of your document. However, since 

underlining is used to denote a web link in HTML, its use should be limited. 

 

To apply bold, italics or underline: 

 Highlight the text that you want the font face applied to. 

 From the formatting toolbar, click on the icon for bold, italics or underline. 

Superscript and Subscript 

Superscript is when text is raised above the baseline and is often used to indicate a footnote, to 

represent an exponent in mathematics (e.g. 5
2
 = 25) or to indicate an ordinal number (e.g. 25

th
). 

Subscript is when text is dropped below the baseline and is typically used in chemical formulas 

(e.g. H2O). 

To apply superscript or subscript commands: 

 Highlight the text that you want the style applied to. 



1. Choose Format->Character from the Writer menu. 

2. Click on the Position tab. 

 

 

3. Choose superscript or subscript from the dialogue 

window. You can also choose how much to raise or lower 

the text by or what size to make the text. 

4. Click OK when you are finished. 

 

Text decoration 

Text decoration includes such things as text color, highlighting and line- through. Text 

decoration, like bold and italics, can be used to emphasize text in a document, but should be 

used sparingly because it can be distracting. 



To apply text decoration: 

 

1. Highlight the text that you want the font applied to. 

 

2. From the formatting toolbar, click on the icon for 

the text decoration you want to use. 

3. Choose Format->Character from the Writer menu. 

4. Click on the Font Effects tab. 

5. Choose the font effect you want to apply: 

underlining, strikethrough, font colour or other 

effects. 

 



6. Click on the OK button to save your changes. 

Automatic hyphenation 

Automatic hyphenation can be used to automatically break words at the end of a line of text so 

that part of the word wraps to the next line of text. This has the effect of making your lines of 

text more even in length. 

In practice, it is usually better to not use automatic hyphenation. You will typically get better 

results by looking at your document after you have 

 

typed it and creating manual hyphenations where needed. One reason for this is natural 

variations in line length enhance the readability of your document by making a distinction 

between one line and the next. If a line of text is extraordinarily short, you can use hyphenation 

on the first word of the next line to ease this. 

To turn automatic hyphenation on: 

1. Choose Format->Paragraph from the Writer menu. 

2. Click on the Text Flow tab. 

3. Click on the checkbox to set hyphenation automatically.



Paragraph Formatting 

As discussed earlier, an effective paragraph organizes a sentence or group of sentences around 

a single main idea. There is no ideal paragraph length, although a paragraph that is overly long 

can be harder to read. 

Too many one-sentence paragraphs in a document is also distracting. Please sue one-

sentence paragraphs only when really necessary – to emphasize a specific point. 

Make sure your paragraphs have one main idea. If there is more than one main idea, split the 

paragraph up. 

Creating and merging paragraph 

When you create a new document in Open Office Writer, you are automatically places at the beginning of 

your first paragraph. Type the sentences you want for your paragraph and when you are finished, press 

the Enter or Return key on your keyboard to end the paragraph and begin a new one



Any formatting that you applied to your first paragraph is automatically carried over to the 

next paragraph. 

Two paragraphs can be merged by placing your cursor at the beginning of the second paragraph 

and pressing the Backspace key or placing your cursor at the end of the first paragraph and 

pressing the Delete key. 

Text alignment 

There are four forms of alignment for text in your document: 

1. Left alignment: Text is aligned so as to be even along the 

left side of a paragraph. The lines are uneven along the 

right side of the paragraph. 

2. Right alignment: Text is aligned so as to be even along 

the right side of a paragraph. The lines are uneven along 

the left side of the paragraph. 

3. Centre alignment: Text is aligned so as to be centered in 

the document. The lines are uneven along both the left and 

right side of the paragraph. 

4. Full alignment: Text is aligned so as to be even along 

both the left and right sides of a paragraph. This is 

accomplished by adjusting the spacing between words 

where necessary. 

 

 

Generally you should use left alignment in your documents because it enhances readability. 

Use the other forms of alignment for special effect when necessary. 

To set the alignment of your documents: 

1. Select the paragraph you want to apply the alignment to. 



2. On the formatting toolbar, click on the button for the 

alignment you want applied. 

Using tabs 

Tabs are used to position text horizontally within a document. By default, tab stops are placed 

every half inch if your measurements are set in inches or every 1.25 centimeters if your 

measurements are set in metric units. 

There are 4 types of tabs you can set in Writer: 

 Left tab: the text starts at the tab position. 

 

 

 Right tab: the text stops at the tab position. 

 

 

 Centre tab: the text is centred at the tab position. 

 

 

 Decimal tab: used for positioning a series of 

numbers. The decimal points line up over the tab 

position. 



 

 

There are two steps to using tabs: 

1. Setting tab positions (or tab stops). 

2. Placing text at the tab positions from within the document. 

3. Setting tab positions 

Tab positions can be set on the ruler or using the tab format options. 

To set a tab on the ruler, simply click on the ruler at the position 

you want the tab. You can reposition the tab by clicking and 

dragging it to the left or right. By default, tabs that you set this way 

are Left tabs. You can change the tab type by double-clicking on 

the tab and setting the tab type from the dialogue box. 

 

To set tabs using the tab format options: 

1. Place your cursor at the point in the text you wish to 

position with a tab. 

2. Choose Format->Paragraph from the Writer menu 



3. Click on the Tabs tab. 

4. Choose the position you want the tab, the type of tab and 

the fill or leader you want. 

 

Placing text at the tab position 

Once you have your tabs set, you can position your text by placing your cursor at the start of 

the text you want to position and then pressing on the Tab key on your keyboard. 

Paragraph spacing 

Paragraph spacing can be used to make your paragraphs more readable and visually presentable 

by making paragraphs stand out from each other. You can set spacing between paragraphs or 

on each side of a paragraph (indentation). 

Spacing between paragraphs and indentation should be done using the paragraph formatting 

options rather than typing an extra paragraph marker by pressing the return key twice. This 

way you can control the paragraph spacing throughout your entire document. 

1. Select the paragraphs you want to space or indent. 

2. Select Format->Paragraph from the Writer menu. 

3. Click on the Indents & Spacing tab. 



 

 

4. Set the amount of left and right indentation. You can 

also set additional indentation for the first line of 

paragraphs. 

5. Set the amount of spacing above and below each paragraph. 

6. Click the OK button when you are finished. 

Working with Lists 

Lists enhance the readability of your document by organizing parallel ideas or ideas that need 

to be presented in a sequence. Lists should form logical groups and should be written using 

parallel structure. 

Unordered lists 

Unordered lists are used to organize ideas when the order of the ideas is not important to their 

presentation. Each list element in an unordered list is started with a bullet. To create an 

unordered list: 

1. Type your list elements, creating a new paragraph with 

each element. 

2. Select all of the list elements. 

3. On the formatting toolbar click on the unordered list icon.



 

 

 

 

 

 

Ordered lists 

 

Ordered lists are used when the order of the list elements are 

important, such as a set of instructions or a list of priorities. Each 

list element in an ordered list is started with a number of letter. 

To create an ordered list: 

 

1. Type your list elements, creating a new paragraph with 

each element. 

2. Select all of the list elements. 

3. On the formatting toolbar click on the ordered list icon. 

 

 



Modifying list format 

 

You can modify your lists by changing the list type (ordered or 

unordered), changing the bullet style for unordered lists or 

changing the number or letter style for ordered lists. To change 

the list format: 

 

1. Select the list elements you want to change. 

2. To change the list type, click on the appropriate button 

from the format toolbar. 

3. To change list style options, click on Format-

>Bullets and Numbering from the Writer menu. 

4. Choose the type of numbering or bullets you want to use 

for your list. 

 

 

 

From the Bullets and Numbering dialogue you can also format 

your list to create outlines or use graphics as bullets. As with other 

elements of word processed documents, keeping the style simple is 

usually preferable. 

Paragraph borders and shading 

Borders and shading can also make a paragraph stand out from 

the other paragraphs and content in a document. A border is a 

rectangular area surrounding a paragraph. Shading refers to the 

color or image behind a paragraph or block of text. 



Setting borders 

You can choose to display and set features of borders: 

1. Select the paragraph you would like the formatting applied to. 

2. Choose Paragraph->Borders from the Writer menu. 

3. From the Borders dialogue, choose the border features you 

want, such as line arrangement, border colour and 

thickness, spacing and shadow. 

Setting shading 

1. Choose Paragraph->Shading from the Writer menu. 

2. Click on the Background tab. 



3. Set the background color or image from the 

dialogue window. 

Creating and Applying Styles 

Styles allow you to save formatting options for the content in 

your document and to easily apply this formatting to other 

content in the document. Writer has many pre-defined styles 

built in to the program. You can use these styles as they are, 

edit them or create new styles 

 

To apply a style: 

1. Select (highlight) the content you want to apply the style to. 

2. Choose Format->Styles and Formatting from the Writer menu. 

 

 

3. Apply the style you want to use by double-clicking on the 

style. You can choose styles for paragraphs, characters, 

frames, pages or lists by clicking on the icons at the top of 

the style dialogue. 

 

 



 

You may want to create a new style specifically for your document. To create a new style: 

1. Choose Format->Styles and Formatting from the Writer menu. 

2. Choose a style from the list to base your new style on. 

3. Click on the New Style from Selection button and choose 

New Style from Selection. 

 

 

 

4. Type a name for your new style and click OK. You now 

have created a new style. 

 

To modify a style: 

1. Right-click on the style and choose Modify from the 

context menu. 

2. From the style window that opens, select the features you 

would like in your new style. 



2.4.4 Spell check 

It offers the ability to check the spelling of the words in your 

document. Although this is a great tool, it shouldn't replace careful 

spelling and proofreading. Just because a word is spelled correctly 

doesn't mean that it is used correctly, as in this sentence: 

Also, some words may appear as incorrect in your document, 

when they are indeed correct. For example, the British spelling of 

―colour‖ appears as incorrect in may spell check programs. 

Thankfully, writer also gives you the ability to add to its internal 

dictionary. 

Grammar check is a useful tool to pick up grammatical errors, 

but like spell check, it's not a replacement for careful editing and 

proofreading. 

You can perform a spell check on your document at any time, but 

Writer monitors your spelling for you as you are typing and 

indicates a misspelled word with a wavy line underneath. 

 

To spell check your document: 

 

1. Choose Tools->Spelling and Grammar from the Writer menu. 

2. The spell check program will scan your document for 

errors and when it finds one it will offer suggestions to 

correct the error. 



 

3. You can then choose to ignore the suggestion, add the 

word to the dictionary or correct the spelling based on 

the suggestions. 

2.4.5 Autocorrect 

AutoCorrect is a software feature commonly found in word processing programs, such as 

Microsoft Word. As the name implies, this feature automatically corrects misspellings and common typos 

in a document. 

The AutoCorrect feature automatically corrects common typographical errors when you make 

them. 

Step 1 − Click the File tab, click Options, and then click the Proofing option available in the left most 

column, it will display the Word Options dialog box. 

Step 2 − Click the AutoCorrect Options button which will display the AutoCorrect dialog box and then 

click the AutoCorrect tab. Now you have to make sure all the options are enabled, especially the Replace 

Text as you type option. It is also recommended to be careful when you turn off an option. 

Step 4 − Click OK to close the AutoCorrect Options dialog box and again click OK to close the Word 

Options dialog box. Now try to type Marketing and as soon as you type this word, Microsoft Word 

autocorrects it with the correct word Marketing word. 

2.4.6 Auto text 

AutoText is a common type of building block that stores text and graphics. You can use the Building 

Blocks Organizer to find or edit a building block. 

To use predefined AutoText, select the Insert tab. In the Text group, select Quick Parts > AutoText. 

Choose a predefined AutoText entry. 

2.4.7 Bullets and Numbering 

Lists enhance the readability of your document by organizing parallel ideas or ideas that need 



to be presented in a sequence. Lists should form logical groups and should be written using 

parallel structure. 

Unordered lists 

 

Unordered lists are used to organize ideas when the order of the ideas is not important to their 

presentation. Each list element in an unordered list is started with a bullet. To create an 

unordered list: 

 

 Type your list elements, creating a new paragraph with 

each element. 

 Select all of the list elements. 

 On the formatting toolbar click on the unordered list icon. 

 

 

 

 

 

Ordered lists 

Ordered lists are used when the order of the list elements are important, such as a set of 

instructions or a list of priorities. Each list element in an ordered list is started with a number 

of letter. To create an ordered list: 

 

 Type your list elements, creating a new paragraph with 

each element. 



 Select all of the list elements. 

 On the formatting toolbar click on the ordered list icon. 

 

Modifying list format 

 

You can modify your lists by changing the list type (ordered or 

unordered), changing the bullet style for unordered lists or 

changing the number or letter style for ordered lists. To change 

the list format: 

 

 Select the list elements you want to change. 

 To change the list type, click on the appropriate button 

from the format toolbar. 

 To change list style options, click on Format-

>Bullets and Numbering from the Writer menu. 

 Choose the type of numbering or bullets you want to use 

for your list. 



 

 

 

 

From the Bullets and Numbering dialogue you can also format 

your list to create outlines or use graphics as bullets. As with other 

elements of word processed documents, keeping the style simple is 

usually preferable. 

2.4.8 Tabs 

Tabs are used to position text horizontally within a document. By default, tab stops are placed 

every half inch if your measurements are set in inches or every 1.25 centimeters if your 

measurements are set in metric units. 

There are 4 types of tabs you can set in Writer: 

 

 Left tab: the text starts at the tab position. 

 

 

 Right tab: the text stops at the tab position. 

 

 

 Centre tab: the text is centred at the tab position. 



 

 

 Decimal tab: used for positioning a series of 

numbers. The decimal points line up over the tab 

position. 

 

 

There are two steps to using tabs: 

 

 Setting tab positions (or tab stops). 

 Placing text at the tab positions from within the document. 

 Setting tab positions 

 

Tab positions can be set on the ruler or using the tab format options. 

To set a tab on the ruler, simply click on the ruler at the position 

you want the tab. You can reposition the tab by clicking and 

dragging it to the left or right. By default, tabs that you set this way 

are Left tabs. You can change the tab type by double-clicking on 

the tab and setting the tab type from the dialogue box. 



 

To set tabs using the tab format options: 

 

5. Place your cursor at the point in the text you wish to 

position with a tab. 

6. Choose Format->Paragraph from the Writer menu 

7. Click on the Tabs tab. 

8. Choose the position you want the tab, the type of tab and 

the fill or leader you want. 

 

Placing text at the tab position 

Once you have your tabs set, you can position your text by placing 

your cursor at the start of the text you want to position and then 

pressing on the Tab key on your keyboard. 



 

 

2.5 Introduction to Presentation 

What is a good presentation? 

The main purpose of creating a presentation is to: 

 show a message in key points 

 enhance the message with multimedia, i.e. text, graphics, 

animations and sound 

A presentation has the advantages of: 

 increasing the understanding of a message and reducing confusion 

 increasing audience involvement 

 drawing the audience attention to key points 

 making a presentation more interesting 

 guiding the presenter through a presentation, assist him/her to keep 

to the time allocated for a presentation and giving him/her a feeling 

of confidence and control 

The disadvantages of using a presentation are: 

 too many or using the wrong animations 

 sound, colour and graphics create confusion and pull the attention 

away from the main message 

 multimedia entertains without enhancing the message 

 the presenter focuses on the screen, reads long parts from the screen 

and loses contact with the audience 

 it gives too much information 

 Design principles 

Depending on the purpose and audience of the presentation, there are a few 

considerations in the design of presentations: 

 

 All slides should be well designed to fit the specific purpose and 

audience 

 using excessive animations is distracting; unless it fits the purpose 

avoid them 

 Do not use sounds in the transition of slides, unless you want to 

create a specific effect. Avoid sound effects in formal presentations. 



 

 graphical images explain more than words alone; use them when you 

can 

 where there are generally accepted abbreviations and acronyms use 

them to minimise text usage 

 Ensure that your choices of colours are legible from a distance. 

Light fonts on dark backgrounds are good for textual material, but 

scientific graphs often work better on a light background. Keep the 

background colour simple. 

 Use the right type-faces and fonts, emphasising with bold-face or 

different colours. It is advisable though to keep the colours on your 

screen to a maximum of four. 

 Use descriptive headings. Don’t let your audience guess or 

experience difficulties in deciphering the meaning or purpose of a 

slide. Use of descriptive headings not only asserts the reader with the 

slide, but also leads to fewer slides. 

 use short, concise phrases 

 Make use of bullet points. Golden rule is no more than five bullets 

per slide, then it becomes too much. 

 Make use of numbered lists. The same rule for bullets applies for 

numbers – less is more. Do not use more than five numbers per 

slide. 

The Design Process 

To create and convey a successful presentation you need to: 

 plan carefully: 

o What do you want the audience to know once you have 

finished the presentation? 

o What do you want the audience to believe once you have 

finished the presentation? 

 do your research 

 know your audience 

 time your presentation 

 practice your presentation 

 speak comfortably and clearly 



 

Purpose of the Presentation 

Presentations are an effective way to communicate or sell an idea to a large crowd of people at the same 

time. However, it is not just about communicating information or selling ideas. Determining the purpose 

of your presentation involves finding answers to the following questions among others: 

 Why do you want to make a presentation? 

 What do you want to communicate? 

 What do you aim at achieving with the communication? 

 Do you really need to use a presentation to achieve this? 

2.6 Structure of the Presentation 

A hierarchical structure organizes information from more-general to more 

specific dimensions, so that information at the top of the hierarchy is more 

general than information at the bottom. And it is advisable to use such a 

structure when creating your presentations. 

A hierarchical structure is used: 

1. to comprehend information – the more marked the hierarchical 

structure, the easier it is for us to understand 

2. to commit information to memory and later retrieve it 

3. to decide about the importance of information – we assume 

information at the top of the hierarchy is more important than lower 

information, so we pay more attention to it and learn it better 

Also remember to add an introduction and conclusion to your 

presentation. The introduction is key to an effective presentation. 

Introductions should have the following components: 

 background and motivation 

 objective (of the briefing or the research in general) 

 an overview or outline of the rest of the briefing 

The conclusion at the end will give an overview of findings, 

recommendations and implications. Typically in the conclusion will be a 

way forward. The conclusion can be more than one slide. 

 



 

Type Style 

There are significant differences in the choice of typefaces between 

printed information and a presentation. While a serif typeface like 

Garamond might look presentable on paper, on a presentation it can be 

difficult to read. Sans serif fonts generally look better on computer 

displays and presentations than serif fonts (serifs are the little hooks on the 

ends of letters). 

Serif 

(Garamond 36 point) 

Sans Serif 

(Verdana 28 point) 

 

Also depending on the audience and the purpose of the presentation, some fonts might be more 

suitable than others. For example, for formal or official presentations, Arial would be suitable 

while Comic Sans might be suitable for a very informal presentation. 

Type Size 

Depending on the audience and the presentation room, some font sizes might be more 

legible than others. It is always important to consider the room where the presentation will 

take place when choosing the size. In large rooms, with the audience seated a distance from 

the projection screen, large font sizes will be better than small ones. 

Upper or Lower Case 

Although upper case letters might be good to emphasize a point, their use should be 

sparing or avoided. Upper case letters occupy more space on the slide and are slow to read. For 

some audiences, the use of all upper case characters might be perceived as ―SCREAMING‖. 

Formatting Types (bold, italics, underline) 

Bold face makes letters more readable and appears clearer 

when   projected on a screen. 

Italics are slow to read especially from a distance and should be 

avoided or used sparingly. 

Underlining is not very effective in a presentation and must be 

avoided. Use other means such as size, color, bold to emphasize 

your main points. 



 

Colour Considerations 

Colour can have a great impact on the effectiveness of a presentation, and so colour choice 

deserves some thought. Improper use of colour can affect readability, recognition, retention 

and communication. Some colours are perceived to have meanings in different cultures and 

therefore their use should be in accordance to those cultures. Colour has also been used to 

evoke moods or states of mind. Some people also believe that colour enhances their learning. 

While it is important to choose a colour theme that is line with your  organization's colours, it 

is important to consider these other issues: 

 colour contrast 

 background effects 

 colour blind people 

Colour Contrast 

Highly contrasting colours improve the readability of the slides. Care, however, should be 

taken not to use very sharp colours as they are tiring to the eyes. 

Background Effects 

Bright backgrounds can also be tiring to the eyes when a presentation is displayed using an 

overhead projector, since the bright light used by these projectors is reflected back to the 

audience. 

Graphics and illustrations 

It is important to include visual elements to break the monotony and to illustrate important 

points. Graphics and illustrations are visual representations of the discussion and can greatly 

improve understanding and retention. Charts and graphs can help illustrate technical data or 

trends, and can be easily incorporated into your presentations. 

Consider the following when using graphics or illustrations: 

 

 choose images that help support the content rather than just decorate the page 

 use text to augment the graphic, not dominate it 

 Graphics should be easily viewable and not too complex. For complex illustrations, 

show the illustration in its entirety, then zoom in to see the key features, or simplify the 

graphic by cutting out nonessential elements 

 charts and graphs are excellent ways to display numerical information or trend 

data (for example, changes over time) 



 

 limit graphics to one or two per page 

 Try to avoid using too much movement in transition of graphs and charts. When using 

photos or drawings, animation might be effective 

 Avoid using sound effects unless it is effective and needed. 

Most Common Mistakes in Presentations 

Avoid these common mistakes: 

 Illegible content – Slides that contain information that is not easily readable force the 

audience to try and guess what is written. Audiences tend to lose interest in the 

presentation if they cannot see what is being presented. 

 Poor organisation – Slides that are poorly organised make it difficult for your audience 

to understand the message of your presentation. Information that is poorly ordered is 

disruptive for the presenter and intimidating for the audience. 

 Information overload on a slide – Too many details on a slide is intimidating and 

detracts from comprehension and retention of the information in the slide. 

 Typographical and spelling errors – ―typos‖ and spelling errors undermine your 

audience’s confidence in you and detract from the message of your presentation. 

 Irrelevant colour, sounds, graphics and animation. Avoid what is called ―bells and 

whistles‖. 

2.7 Working with Presentation 

Impress Window Layout 

When you launch Impress, a new, blank document, or default window, opens. Shown below is the 

OpenOffice Impress default window. 

It shows the three main working areas of the Impress window, viz. Slides pane, Workspace and 

Task pane as well as different ribbons and toolbars across the window. 



 

 

Here is a brief explanation of the Impress window. 

 

Title Bar 

The title bar is the upper most band on your Open Office Impress window. 

 

The Title bar displays both the name of the presentation and the 

name of the application. 

 The name of the presentation is Proposal to Funders.odp 

(hence the ―Proposal to Funders‖ in the title). 

 The name of the application is Open Office Impress 

(hence the name OpenOffice.org Impress). 



 

 

Menu bar 

The Menu bar is made of text menus displayed below. The Menu bar displays all the tools that 

are available in Impress. Each button displays a text menu (dropdown menu) when clicking on 

it. 

 

Other Toolbars 

A Toolbar contains commands that have pictures or icons associated with them. These pictures 

may also appear as shortcuts in the Menu Bar: 

 

Changing toolbars 

There are several toolbars built into Impress. These are: 

 

 

You can: 

 display toolbars by ticking them off on the dropdown menu 

 hide toolbars by un-ticking them on the dropdown menu 



 

 move toolbars around by grabbing the toolbar handle on 

the left side of the toolbar and dragging it. You can dock 

them somewhere else or leave them floating in the 

Workspace. 

 close toolbars by dragging them into 

the workspace and press the on the toolbar 

Task Pane 

The Task pane, which by default appears on the right hand side 

of Open Office Impress, provides you with cascading menu 

options for: 

 Master Pages (choice of 28 slide masters) 

 Layouts (choice of 20 layouts) 

 Table Design (choice of 11 standard tables) 

 Custom Animations (a variety are listed and can be 

changed or removed later) 

 Slide Transitions (56 transitions are available, you can 

change the speed or to do it manually/automatically and 

timing of automatic transition) 

Any one of the menu options can be maximized by clicking on 

the . The menu with the displays the full menu. 

 

To close the task pane, click on the or unstick on View Task 

Pane. To restore the task pane, tick Task pane on View Task 

Pane.



 

                               Slides Pane 

The Slides pane contains thumbnail pictures of the slides in your 

presentation; in the order they will be shown. Clicking on a slide 

in the Slides pane selects it and places it in the Workspace. While 

it is there, you can apply any changes desired to that particular 

slide. 

 

Several operations can be performed on one or more slides in the 

Slides pane: 

 add new slides at any place within the presentation after 

the first slide 

 mark a slide as hidden so that it will not be shown as part 

of the slide show 

 delete a slide from the presentation if it is no longer needed 

 move slides around 

 

To close the slides pane click on the or untick on View Slide Pane. 

 

To restore the task pane, tick Task pane on View Slide Pane. 

Page View Buttons 

 

 

The Workspace has five tabs: Normal, Outline, Notes, Handout, and Slide Sorter. These 

five tabs are called Page View Buttons. You can access these by clicking on the tab in the 

Workspace or by choosing View  and the appropriate view. 

Each button reveals a view that is designed to make completing certain tasks easier. In 

summary: 

 Normal view is the main view for creating individual slides. Use this view to format 

and design slides and to add text, graphics, and animation effects. 

 Outline view shows topic titles, bulleted lists, and numbered lists for each slide in 

outline format. Use this view to rearrange the order of slides, edit titles and headings, 

rearrange the order of items in a list, and add new slides. 



 

 Notes view lets you add notes to each slide that are not seen when the presentation is 

shown. This is typically used for speaking notes that accompany each slide. 

 Slide Sorter view shows a thumbnail of each slide in order. Use this view to 

rearrange the order of slides, produce a timed slide show, or add transitions between 

selected slides. 

 Handout view lets you print your slides for a handout. You can choose one, two, 

three, four, or six slides per page from the Tasks pane. 

Open, Save and Close a Presentation and Exit the Impress Program 

You will make use of the file menu in opening, saving and closing presentations and exiting 

the programme as you have done in other applications. The file menu in Impress is similar to 

the one you used in the other Open Office applications. If you haven’t used any of the other 

applications, you will need to learn how to use the file menu for basic navigation. 

As seen in the illustration below, when you click on File, you have a selection of actions to 

choose from. We start off by discussing the basic terms. 

 

 

New 

Used to create a new presentation. 

Open 

Used to open an existing file from a floppy disk or hard drive 

of your computer. 

Close 

Used to close a presentation. 

Save 

Used to save a file that you have changed. If you close the 

presentation without saving it, the changes you made will 

be lost. Save As 

Used to save a new file for the first time or save the existing 

file with a different name. 

Print 

Used to print the presentation. 

Exit 

Used to exit Impress or any other application in the 

OpenOffice.org software suite. 



 

 

Opening an Existing Presentation Using the File Menu 

You can open any presentation that has been named and previously saved from the File Menu 

or with the Wizard                                               

  To open an existing presentation: 

1. Click the Open existing presentation button. 

 The Open dialogue box opens. 

2. In the Look-in list, click the drive, folder, or Internet address 

where the file that you want to open is located. 

3. In the folder list, open the folder that contains the file, 

and then click in the file you want to open. 

 

4. Click the Open button. The presentation will open. 

 

Opening more than one Presentation 

 You can open more than one presentation. Without closing one, just follow the same 

instructions and open another presentation. You now have two presentations on your 

desktop, the one on top of the other one. 

 You can switch between the two open presentations: 



 

 If your presentations are not maximised (you can see part of the second presentation), 

you can click on the one that you want to work on. It will move to the front and you 

can work on it. If you want to work on the one behind, just click anywhere on the 

presentation and it will move to the front. The active one’s title bar will be in the 

default colour and the other one will be grey. 

 If the presentations are maximised, you can work on one, minimise it, and work on 

the back one. To maximise it again, pick it up from the bottom of your screen. 

Saving a Presentation 

 You must assign a distinguishable name to every presentation that you create in 

Impress. If you don’t name the file, you won’t be able to open and update it in the 

future. 

 The first time you save a presentation, Impress will prompt you to assign a name 

through the Save As operation. You must then identify the location (folder and sub-

folder) on the drive (A:, C:, D: etc) you want to save it to. 

 You can make additional changes to a file – add a slide, change text, add a picture, etc. 

– and then only use the Save option. The presentation will be saved to the original 

location and file name, thus overwriting the previous saved version. 

 To save a new Impress presentation: 

1. Choose File  Save As from the menu bar. 

2. The Save As dialog box appears. 



 

Click on the Save In: drop-down menu and locate where you want to save the file. 

Choose: 

 3 ½ Floppy (A:) to save the file to a floppy disk; 

 Local Disk (C:) to save the file to your hard disk; or 

 D: onwards means any other device you have 

installed to save in. It can be a network, flash 

memory stick or an external hard drive. Check the 

description. 

3. Type a name for your file in the File name: box. 

4. Click the Save button. 

 

To save changes that you’ve made to an existing presentation: 

 

1. Choose File Save from the menu bar, or 

2. 

Click the Save button on the Standard toolbar (third button 

from left on top row). 

 



 

 

To save changes that you’ve made to another 

presentation/under a different name: 

1. Choose File Save As from the menu bar. 

2. You can now do one of the following: 

a. Choose an existing presentation that you want to 

overwrite. Click on the presentation name and hit 

Save. 

b. Type in a new file name to save the current 

presentation with the changes to a new name and 

hit Save. 

c. Change the folder of the file, by copying the 

existing presentation to a new folder under the 

same or different name and hit Save. 

d.   Saving a Presentation in Different Formats 

If you look at the File Save As dropdown menu, you will see that there are several formats 

that you can save a presentation in. These are: 

 ODF Presentation (.odp) – a normal presentation that you can edit in Impress 

 ODF Presentation Template (.otp) that you can save as another file, edit and reuse 

 various other versions of OpenOffice – both as presentations and templates 

 various other versions of office applications such as MS Word, StarDraw – both as 

presentations and templates 

 drawing object (image file format) – (odg) 

 

Check the options that are given in the Save as type dropdown menu. 

Export a Presentation in Different Formats (.pdf and .swf) 

If you want to save the file in another format than what is available in the dropdown menu, you 



 

have to export the file to another format.  

To execute choose File Export. You have several choices, but the following two are 

useful to save as: 

 Portable Document Format (.pdf) gives you the ability to print and send a file in its 

final form. 

 Macromedia Flash file (.swf) gives you the ability to 

view the presentation as a Flash show. Just remember 

you have to download the Adobe Flash Reader for 

reading this file. 

 

Saving a Presentation in Rich Text Format 

 

To save as Rich Text Format, you must copy and paste the content of your slides from the 

Outline View into Writer and use the Save As function in Writer to save as Rich Text 

Format. 

Rich Text formatted files are often called RTF files. RTF files can be opened and used with 

any word processor, including Open Office, WordPad, Note Pad, Word, and Star Office. An 

Open Office file can be saved in RTF through Writer. The RTF format can be a good way for 

Open Office to exchange text files with users of other operating systems such as Microsoft 

Word. 

Saving a Presentation in Different Versions 

To save a file as another version, press File Versions. Click on the Save New Version 

button. You will be given the option to insert a version comment e.g. Ver1.0. Press OK. The 

versions already saved will be reflected in the look-in list. Press Close. 

 

If you have saved several versions and you want to access them, you can press File 

Versions. In the look-in list, highlight the version you want to open and press Open. 



 

Through the same procedure you can also delete a version by pressing Delete. After you have 

completed the action, you press Close. 

Closing an Impress Presentation 

To close an existing presentation chooses File Close from the 

menu bar. The presentation in the Impress window closes. 

Alternatively – just click on the Close button to close the program.  

Impress prompts you to save your work if you have made any 

changes to the presentation between the last save and the time the 

file is closed. 

Exiting Impress 

To exit Impress choose File Exit from the menu bar. 

Slide Navigation – Moving Around the Presentation 

You can move around the presentation in several different ways. 

You will need to know how to do this in order for you to navigate 

through your slides and presentation. 

Scroll Through a Slide Using Scroll Bars 

To move up and down in a presentation slide in the Workspace, 

particularly when working with magnification, use the vertical 

scroll bar located along the right edge of the Workspace. To move 

left or right, use the horizontal scroll bar, located at the bottom of 

the Workspace. 



 

 

2.8 Creating a New Presentation 

Practice makes perfect is the only way to master a 

presentation. The following sections will enable you to 

perform the tasks. 

Using Pre-defined Presentation Templates 

Using Pre-defined Presentation Templates in Your Presentation 

 

Impress comes with two pre-defined presentations that you can copy and use for your own 

presentation. Each presentation is formatted and contains pre-written content. 

You can select the presentation templates whenever you create a new presentation from a 

template using the Wizard. You have two options: 

 ―Introducing a New Product‖; or 

 ―Recommendation of a Strategy‖. 

Compare the content below: 



 

Remember that you can also change your presentation from the design and content of the template. 

 

Impress is also equipped with different presentation backgrounds that you can use in your 

presentation. You can select these presentation backgrounds whenever you create a new empty 

presentation using the Wizard. Once you make a selection, Impress then displays the available 

templates for the selected option. If you select one, you will create a similar presentation to the 

one you see in the thumbnail on the right hand side of your screen. 

 

 

Creating a Full Presentation from a Template 

 

You are now going to use the Wizard to create a new presentation 

based on the full existing presentation template of 



 

―Recommendation of a Strategy‖. 

 

To create a new presentation based on the pre-designed template: 

1. Choose File New  Presentation from the menu bar. 

2. On the Wizard Presentation dialogue box, click on the 

From Template button. 

3. Choose Presentations. 

4. Choose Recommendation of a Strategy. 

 

5. Click the Next>> button to display the second screen of the Wizard.



 

In this screen you can select the slide design. 

 

1. Select the presentation background to be used in your 

presentation (check the design in the thumbnail on the right). 

 

 

2. Click the Next>> button to display the third screen of the wizard. 

 

In the third screen you can select a slide transition of your slides: 

 Effect – How one slide will change to the following one; and 

 Speed – The speed between the transitions (slow/medium/fast). 

 

You can also select the presentation type: 

 Default – You can present your slides by clicking the 

mouse or press the Page Down or →/↓ arrows; or 

 Automatic – Your presentation runs automatically and 

you can set the time you can view a slide and the time to 

move over to a next slide. 



 

 

You can also decide if you want to show the logo on each 

page by marking the appropriate block. 

 

 

In order to make these choices: 

 

1. Under Select a Slide Transition, click in the drop-down 

area to select any of the 57 available effect transitions. 

The right hand area of the screen provides an example of 

each effect as you scroll through the available choices. 

2. Under Select a Slide Transition, click in the drop-down 

area to select the Speed of the slide transition (Slow, 

Medium, or Fast). 

3. Under Select the presentation type, select either Default or 

Automatic to define whether the presenter will manually 

advance slides in the presentation (default), or whether the 

slides will automatically advance based on Duration of page 

and Duration of pause timing definitions. 

4. Click the Next>> button to display the fourth screen of the wizard. 

 

In the fourth screen you will provide basic information 

on the presentation you are developing. 

 

Type information in each of the three questions displayed on the screen: 



 

 

 

Click the Next>> button to display the fifth screen of the 

wizard. In the fifth screen, you have to choose your topics 

or pages. 

The presentation comes with seven pre-written slides. Remember, 

on page 26 we explained that the template has pre-written content 

under seven headings. These slides/pages are the same as the 

content displayed on page 26. Please check carefully that you 

understand where this is coming from. 

 

Here you have the choice to remove/include the content displayed 

in the template. All slides that contain a checkmark in the Choose 

your pages area will be included in the new presentation. 

Uncheck any slides that you do not want to include in the 

presentation. 



 

Click the Create button to create the presentation and display 

the first slide. 

 

It is advised that at this stage you save your document under a new 

name. Please be careful in deciding in which folder you save your 

document. 

You must be able to retrieve your document again. 

 

You are now ready to popularize your presentation using the 

template. You can enter text in all the slides. 

 

Creating a Presentation from Scratch 

It is not always convenient to use a template if you have to 

make too many changes. It is sometimes better to create a 

presentation from scratch. If you want to create a presentation 

from scratch, you start the same way as on page 27. 

 

When you want to do this, first plan your presentation. Write on a 

piece of paper what you want to put on each slide. Use the 

information from the first section of this module. If you are satisfied 

with your plan, you can start. 

 

1. Choose File New  Presentation from the menu bar. 

2. On the Wizard Presentation dialogue box, click on the 

Empty presentation radio button. 



 

 

Go through the rest of the screens 2 – 5 as above. On screen 5 

you will see that you cannot choose Next>>, choose Create. 

 

You will be able to start your presentation from scratch now. 

 

Slide Backgrounds 

 

In the first section you have been introduced to the 

importance of choosing the right colour and design for a 

background. Impress has several backgrounds that you can 

choose from.



 

Some examples are: 

 

 

 

 

 

 

 

 

Play around with different backgrounds and see for yourself what 

effect different backgrounds have on a presentation. 

 

You can also just choose a background colour without any 

design for your presentations. 

 

On any slide of the presentation, choose Format Page. 

Click on the Background tab to access the drop-down menu. Choose 



 

 

color, and make your choice of colour. 

 

You will be asked: 

 

If you select yes, all the slides will have the 

chosen colour background. If you select no, 

only the one slide that you are working on 

will have the background colour.



 

 

By doing the same you can change the background colour to 

have different appearances e.g. 

 

 

 

 

 

 

 

 

To summarize, if you want to use a bitmap, colour, gradient or 

hatching pattern for the slide background: 

 

1. Start a new presentation or open an existing one. 

2. Click Format  Page on the menu bar. 

3. Click on the Background tab on the Page Setup dialogue box. 

4. In the Fill area, do one of the following: 

a. Select Color, and then click a colour in the list. 

b. Select Gradient, and then click a gradient style 

in the list. 

c. Select Hatching, and then click a hatching style 

in the list. 

d. Select Bitmap, and then click a bitmap style in the list. 



 

5. Click the OK button. 

6. Click either the Yes or No buttons in the Page Settings 

dialogue box to answer the question to change the 

―Background settings for all pages‖ 

7. Slide Layouts 

 

Impress allows you to select from many different Layout slide 

templates to use in your presentation. Impress prompts you to 

assign a layout each time you add a new slide. You can change the 

layout assigned to any slide in the presentation at any time. 

 

 

The type of slide layout you should use depends on what you 

want to include into your presentation, whether it is to add only 

text or add text, graphics and charts. 

 

To apply a layout to an existing slide: 

 

1. Click on an existing slide without text in the slide pane to 



 

activate it in the Workspace. 

2. Ensure that the Layout menu is active on the right-hand side 

of the screen by either clicking on the Layouts bar or 

choosing Format  Slide Layout from the menu bar. On 

the right a variety of thumbnail layout slides will appear. 

3. Click on the appropriate layout slide (thumbnail) to 

apply that layout to your slide. 

 

Once you have clicked on the thumbnail it will apply that layout 

to your current slide. 

2.9 Adding, Copying and Deleting Slides 

 

Inserting Slides 

 

Each Impress presentation that you create will begin with a single 

slide. After you change the opening slide, you’ll want to add more 

slides to your presentation. The number of slides that you add to 

the presentation is dependent on the length of your presentation. 

 

To insert a new slide in a presentation you can do one of four actions: 

 

1. Choose Insert  Slide from the menu bar. A new slide will 

be added after the active slide on your Workspace. The slide 

will have the same layout as the slide on your workspace. 



 

                                                                                

2. You can also hit the  button on the tool bar. A new 

slide will be added after the active slide on your 

Workspace. The slide will have the same layout as the slide 

on your workspace. 

3. Another way to insert a slide is to go to the slide pane, click 

on a slide to activate it in your workspace, right-click and 

select Slide  New Slide from the menu. A new slide will 

be added after the one that you have first clicked on. The 

slide will have the same layout as that slide on your 

Workspace. 

4. You can also go to the position for the new slide on the 

slide pane (between two slides), right click and hit new 

slide. The new slide will have the same format as the 

previous one. 

 

After you have inserted the slide, you can change the layout by 

clicking on any of the 20 different Layout thumbnail images in 

the Task pane to apply that design to the new slide. 



 

Duplicating Slides 

 

Duplicating or copying a slide is another technique that you may 

use as you work on your slide presentation. For example, you 

may want to repeat a slide later in the presentation or copy a slide 

and make small changes to it to make a different point. When 

you duplicate a slide, you make an exact copy of it. 

 

To duplicate a slide in the presentation: 

 

1. Navigate to the slide that you would like to duplicate, 

either by paging through the presentation in the Workspace 

or by selecting the slide on the Slide Pane. 

2. Choose Insert  Duplicate Slide from the menu bar. 

 

3. A new slide, an exact duplicate of the original slide, will 

appear at the bottom of the original slide and will be 

displayed on the screen.



 

 

 

You can now move the slide to another position by 

dragging it on the slide bar. 

To duplicate a slide in the presentation, you can also copy 

and paste it to the position you want it to appear: 

 

1. Navigate to the slide that you would like to duplicate, 

either by paging through the presentation in the Workspace 

or by selecting the slide on the slide pane. 

2. Click on the slide on the slide pane so that it is highlighted. 

3. Do one of the following: 

 Choose Edit Copy from the menu bar 

 Right-click and choose copy 

 Press on the tool bar 

 Press Ctrl+c 

4. Move to the desired location for the slide to appear on the 

slide pane and paste it by: 

 Choosing Edit Paste from the menu bar 

 Right-click and choose paste 

 Press on the tool bar 

 Press Ctrl+v 

A new slide, an exact duplicate of the copied slide, will 



 

appear at the pasted location and will be displayed on the 

screen. 

 

You can use the same procedure to copy slides from one 

open presentation to another. 

 

Follow the following steps: 

 

1. Ensure that both presentations are open on your desktop. 

2. Follow steps 1 – 3 on the presentation that you want to 

copy from. 

3. Activate the second presentation (see page 16). 

4. Follow step 4 above. 

 

Deleting Slides 

 

Sometimes you may want to take one or more slides out of your 

presentation. With Impress, you can delete any slide from a 

presentation, even if it has text or a picture on it. 

 

To delete a slide from the presentation: 

 

1. Navigate to the slide that you want to delete from the 

presentation, either by paging through the presentation or by 

selecting the slide on the slide pane. 

2. Do one of the following: 

 Choose Edit Delete Slide from the menu bar 

 Press the delete key 

 Right click and choose Delete Slide from the 

shortcut menu 

 Press Ctrl+x



 

If a dialog box appears (if the slide you are deleting contains 

information on it and you have used the first option), click the Yes 

button to remove the slide and all the data on it. 

 

2.10 Introduction of Spreadsheet 

A spreadsheet is a table of rows and columns, creating a grid of cells in which numeric or text 

values are displayed. In most situations, spreadsheets are used for manipulating numeric data. 

The spreadsheet computer application is designed to enable you to model and observe the 

relationships among data in the respective rows and columns. 

 

Spreadsheets can be useful in a variety of contexts, e.g., to analyze business data, to track 

personal finances, or to create charts for visual interpretation of data. 

The two features of a good spreadsheet are: 

 Good data, and 

 Good design. Good design makes it easier to enter data and retrieve valid results. 

Poor design can make a spreadsheet unusable despite having excellent data to 

work with. 

 

 

2.11 Spreadsheet and its Business Applications 

The spreadsheet has been instrumental in helping personal computers gain widespread acceptance in the 

business community. Called a ―killer‖ application, spreadsheets made such an immediate impact on 

financial accounting that businesses couldn’t afford to not take notice. 

Spreadsheets, in their original paper form, have been used in financial accounting for hundreds of years. 

A spreadsheet is a large sheet of rows and columns that lays out information about a financial 

transaction, including things like costs, taxes, income, etc., so that a business person or manager can 

easily make decisions. 

2.12 Managing worksheets 

Creating a new spreadsheet 

 

When you launch the Calc application, a blank spreadsheet is 

created for you automatically. To create a new spreadsheet from 



 

within the Calc application: 

 

1. Click on File on the menu Bar. 

2. Click on New on the drop down menu. 

3. Click on Spreadsheet. This will display a blank spreadsheet. 



 

Your work area is one of the worksheets of the spreadsheet that 

you are working on. The tabs in the bottom left corner of the work 

area allow you to switch between worksheets. If the tab for Sheet 1 

is highlighted, then it is the first worksheet that is being displayed. 

If you click on Sheet 3, then the third worksheet replaces the first 

on the screen. The spreadsheet consists of all these worksheets. 

 

A spreadsheet consists of text, numbers and formulas that are 

entered into the cells of its worksheets. Collectively, text, numbers 

and formulas are referred to as data. Spreadsheets that contain data 

are saved as files, just as in the case of word processed documents. 

 

Opening an existing spreadsheet from within Calc 

 

1. Click on File in the menu bar. 

2. Click on Open. This brings up the Open Dialogue 

window. The dialogue lists a series of directories and files. 

3. Locate the directory in which the desired file is held. 

4. Click on the directory to open it. 

5. Highlight the file. 

6. Click Open. 



 

 

Closing a single spreadsheet 

 

Before we perform this task, we need to be clear about the 

difference between the 'close' and 'exit' commands. Close closes 

the spreadsheet, but leaves the program Calc and other 

spreadsheets open. Exit closes the  

spreadsheet you are working on, any other spreadsheet that is 

open, as well as Calc. 

 

1. Click on File on the menu bar. 

2. Click on Close. This command is in the top section of the 

drop down menu. Exit is in the bottom section. 



 

 

Working with multiple spreadsheets 

 

If you need to work on more than one spreadsheet at the same 

time, you can open multiple spreadsheets and move between 

them. You may want to do this if you need to copy data from one 

spreadsheet to another. 

 

1. Click on File then Open. 

2. Locate the directory containing the files you wish to open. 

3. Click on the first file. 

4. Hold down the CTRL key and click on each of the 

additional files you wish to open. 



 

 

5. Click Open. The last of the files loaded will appear in the 

window. This will be the active spreadsheet. The others 

are also loaded but are in the background. 

 

You can make one of the other spreadsheets active as follows: 

 

1. Click on Window to list the spreadsheets that are loaded. 

2. Click on the spreadsheet that you wish to make active. 

 

 

Close more than one spreadsheet 

 

If you wish to close some but not all the spreadsheets you have loaded, then you will use the Close 

command for each separately. If you want to close all spreadsheets as well as exit CALC, then you will 

use the Exit command. 

Saving spreadsheets 

You will want to save your documents often so that you don’t lose 

data if your computer crashes or if your application is inadvertently 

closed. If you exit the application without saving, Calc will prompt 

you to save your work. 

 

Saving on the hard drive of your computer 

 

1. Click on File, then click Save As. This will bring up the 



 

Save As dialogue. 

2. Locate the drive and /or the directory in which you wish to 

save the file. You can save files to your hard drive, floppy 

drive, Flash Memory stick, or many other storage memory 

devices. 

3. Enter the name of the file in the File Name window. 

4. Click Save. 

 

 

Save an existing file under another name 

 

Sometimes we may want to have the same spreadsheet saved 

under a number of different names. Alternatively, we may want 

to save a spreadsheet before making changes. We would then 

have a copy of the new version as well as the version before 

changes were made. Suppose we have a spreadsheet loaded as 

shown below. In this case the spreadsheet already has the name 

demo.sxc. 

 

We can now save what is displayed on the screen in two ways: 

 

 As the existing file: After loading demog.sxc from the hard 

disk, we made some changes to it. Those changes exist only 



 

on the version on the screen and will not automatically be 

made to the file that is located on the hard disk. To replace 

the version on the hard disk with the contents as displayed 

on the screen. 

 

Click on File, then 

Save. Under another 

name: Suppose we do 

not want to overwrite 

the contents on disk 

but would still like to 

save what is on the 

screen. 

 

Click on File, then Save as. 

 

This will bring up the Save As dialogue. You use this in 

exactly the same way as you would if you were saving a 

completely new file. 

 

Save in another file type 

 

Sometimes it is useful to convert the spreadsheet format into 

another format, for example, a text file that can be manipulated 

using a word processor. Alternatively, you may wish to save the 

spreadsheet in a format used by another spreadsheet program such 

as Microsoft Excel. To save a spreadsheet in a different format: 

 

1. Click on File, then Save as 

2. Click on the File Type window. This will display a list of file types 

3. Use the vertical scroll bar to view all the file formats. 



 

 

 

The following table lists some of the main file formats and a 

brief explanation of each. 

 

File type Extensio

n 

Explanation 

OpenOffice.org Calc 

Spreadsheet 

sxc This is the format of Calc itself 

OpenOffice.org 

Spreadsheet 

template 

stc A template is an outline for new 

templates. This may include text, 

values and formulas that are 

automatically inserted when a new 

template is created using template. It 

could also include formatting of cells 

such as font 

type and colour. 

dBase dbf This would save the spreadsheet in a format 

used by some database programs. These 

 

 

 



 

2.13 Formatting 

Selecting cells and cell ranges 

 

In Calc you select cells with your mouse: 

 

1. If you want to select a group of cells in a single row, click 

on the left-most cell, hold the left mouse button down, and 

drag your mouse to the right (alternatively, click on the 

right most cell, hold the left mouse button down and drag 

left). 

2. If you want to select a group of cells in a column, click on 

the top most cell and drag down, or click on the bottom 

most cell and drag up. 

3. If you want to select a group of cells spanning a number 

of columns and rows, click on one of the corner cells in 

the range 

4. you want, and drag left or right and up or down until the 

range you want is selected. 

5. To select a whole row, click on the row heading (the 

number along the left side of the worksheet). 

6. To select a whole column, click on the column heading (the 

letter at the top of the worksheet). 

7. If you want to select the whole worksheet, click on the 

top left corner of the worksheet (to the left of column 

heading A and above row heading 1). 



 

 

Formatting cells 

 

You’ve already learned how to format cells for the type of data 

they contain (numerical, date, or text). You can also apply many of 

the formatting options that are available in other applications such 

as Writer. 

 

As in other applications, the objective of adding formatting is to 

enhance the visual appearance of your documents in order to make 

them more readable and better understood. 

 

Formatting appearance 

 

You can format the appearance of cell contents by applying font 

choices, borders and shading, and alignment. 

 

Font appearance 

 

1. Select the cells you want to format. 

2. From the formatting toolbar, apply the font formatting 

options you want. 

For your precipitation spreadsheet, bold the column 

headings (months). 



 

 

 

Borders and shading 

 

Borders and shading can help make your worksheets more 

readable by providing emphasis to some of your worksheet cells. 

For example, row and column headings can be shades to set them 

off from the rest of the data. Cells that form a table can be 

enhanced by placing a border around them. 

 

To apply shading: 

 

1. Select the cells you want to shade. 

2. Choose Format->Cells from the Calc menu. 

3. Click on the Background tab. 

 

4. Choose a background colour for your cells. 

 

To apply borders: 

 



 

1. Select the cells you want to apply a border to. 

2. Choose Format->Cells from the Calc menu. 

3. Click on the Borders tab. 

4. Choose the line arrangement for borders. The default 

settings are no border, outside border, outside border with 

horizontal inside border, or outside and inside borders. 

Further, you can set you own borders by using the user-

defined option. 

5. Choose the line style and colour. 

6. Choose the border spacing. 

7. If you like, include a shadow for your bordered section. 

 

Here is what our precipitation worksheet looks like with bold, 

shading, and borders applied: 

 

 



 

Merging cells 

 

You may find that you want to create an area for information that 

is larger than a single cell. Calc gives you the option of merging 

cells to make a larger area. (Please do not confuse it with Mail 

Merge in Writer) The merged cell acts as one cell. 

 

To merge adjacent cells: 

 

1. Select the cells you want to merge. 

2. Choose Format->Merge Cells from the Calc menu. 

3. Place your content into the merged cell. 

Copying and Moving cells 

 

To copy cells: 

1. Select the cells you want to copy. 

2. Choose Edit->Copy from the Calc menu. 

3. Click where you want the cells to be placed. 

4. Choose Edit->Paste from the Calc menu. 

 

To move cells: 

1. Select the cells you want to copy. 

2. Choose Edit->Cut from the Calc menu. 

3. Click where you want the cells to be placed. 

4. Choose Edit->Paste from the Calc menu. 



 

 

Using Autofill 

 

Auto fill is useful if you are placing the same content in the cells 

of a column, or when you are placing incremental content (e.g. the 

months of the year) in the cells of a column. 

 

To use Auto fill with incremental content: 

 

1. Type the first entry into a cell (for example, January) 

 

 

2. Click somewhere else on the worksheet (click out of the 

cell). Then move your mouse to the bottom-right corner of 

the cell with the data in it, until your cursor turns to a 

crosshair. 



 

3. Hold the mouse button down, and drag down the 

column to complete the Auto fill. 

 

 

To use Autofill with repeating content: 

 

1. Type the first entry into a cell (for example, January) 

 

 

2. Click somewhere else on the worksheet (click out of the 

cell). Then move your mouse to the bottom-right corner of 

the cell with the data in it, until your cursor turns to a 

crosshair. 



 

3. While pressing the <Ctrl> key, hold the mouse button 

down, and drag down the column to complete the Autofill. 

 

 

 

Working with rows and columns 

Earlier you learned how to select a whole row or column by 

clicking on the row headings and column headings. When you 

select rows or columns, any of the formatting options you apply are 

applied to the whole row or column. You can also set the row height 

and column width to fit your data, and insert or delete columns or 

rows as needed. 

 

Inserting and deleting rows and columns 

 

To insert a row or column: 

 

1. For rows, click on the row heading where you want the 

new row to be created. 

2. Choose Insert->Row from the Calc menu. 

3. The new row is inserted above the row you selected. 

4. For columns the process is the same, using the column heading. 



 

 

 

 

 

Delete a row or column 

 

1. For rows, select the row or rows you want to delete. 

2. Choose Edit->Delete cells from the Calc menu. 

3. For columns the process is the same. 

 

Formatting rows and columns 

 

Row height 

 

You can set the height of a row manually by dragging on the 

bottom of the row header, or by using the menu options. The 

menu options give much greater control over the row height: 

 

1. Select the row or rows you want to format. 

2. Choose Format->Row->Height from the menu. 

3. Type in the height you want to set the rows. All of the 

rows you have selected will change to that height. 

 

Column width 

 

1. Select the column or columns you want to format. 

2. Choose Format->Column->Width from the menu. 



 

3. Type in the width you want to set the column. All of the 

columns you have selected will change to that width. 

 

2.14 Entering data 

Entering data in cells 

 

We enter data into cells by clicking on a cell and typing in our data 

using the keyboard. Remember that it’s good practice to leave a 

few blank rows at the top of a worksheet for totals, headings, etc. 

1. Enter the months of the year in Row 4 of your spreadsheet. 

These are our column headings. 

2. To move vertically or horizontally in a spreadsheet, 

either use your mouse to click on the next cell, or use the 

arrow keys on your keyboard. 

3. To enter a list of data, enter the data for the first cell and 

then type the <Enter> key to go to the cell directly below. 

Keep doing this for each column until the list is finished. 

4. Enter the precipitation measurement for each month in the 

three rows beneath the column headings. Your spreadsheet 

should now look like this: 



 

 

Editing data 

 

If you make a mistake entering data into cells, you can correct it 

easily by clicking on the cell and typing the new data. You can do 

this either in the cell itself or in the input line in the spreadsheet: 

 

To edit data in the cell: 

 

1. Double-click in a cell, and then highlight the data you 

want to replace. 

2. Type in the new data. 

 

To edit data using the input line: 

 

1. Click inside the cell. 

2. In the input line, highlight the data you want to replace. 

3. Click on the Checkmark to accept the new data. 

 

Using Undo/Redo 

 

If you make a mistake when you are inputting data, 

applying formatting, or just about an other action in 

Calc, you can use the Undo button to go back one step. 

 

 



 

The Redo button will take an action you have just 

finished and repeat it. This is handy if you need to repeat 

the same action on a number of cells. 

 

 

Numerical data 

 

Calc tries to interpret whether the data in our spreadsheet is 

numerical or text. By default, text data is aligned to the left of a 

cell, and numerical data is aligned to the right. 

 

Numerical data can be formatted a number of ways, depending 

on the nature of the data. For example, our precipitation data is an 

integer with one digit after the decimal point. 

 

To set the type of numerical data in a spreadsheet: 

 

1. Select the cells you want to format 

2. Choose Format->Cells from the Calc menu. 

3. Choose the category: 

 Number: for general numerical data 

 Percent: display numerical data as a percent 

 Currency: for currency data. Negative 

values are generally displayed in red type. 

 Date: To display data as a date, in a variety of formats. 

 Time: To display data as a time, in a variety of formats. 

 Scientific: for exponent data. 

 Fraction: to display numbers as fractions. 

 Boolean value: displays True or False. 

 Text 

4. Choose the format. For numerical data, your choice is 

with or without a comma separating the hundreds, 

thousands, millions, etc. 



 

5. Choose the number of places after the decimal point. 

 

We can see from the data in our spreadsheet that if the digit after 

the decimal point was zero, it was automatically dropped. 

Change the data format for all of our cells to include 1 digit after 

the decimal point. 

 

Your worksheet should now look like this: 

Date format of data 

 

You can format a cell that contains date data a number of different ways: 

 

 Long text: December 31, 1999 

 Abbreviated text: Dec. 31, 1999 

 Numerical format: 31/12/1999 

 Abbreviated numerical format: 31/12/99 



 

Replacing text or data 

 

1. Choose Edit->Find & Replace from the Calc menu. 

2. In the Search for box type the text or data you want to 

search for. 

3. In the Replace with box, type in the text or data you 

would like to replace the search term with. 

4. You can either replace instances of the search term all at 

once, or one at a time. 

 

Sorting data 

 

As much as possible, it is helpful to sort the data you are working 

with in a way that makes sense. For example, you may want to sort 

rainfall data from largest to smallest amount. You may want to sort 

birth date data chronologically. Or you may want to sort name data 

alphabetically. 

 

To sort data in a Calc worksheet: 

 

1. Highlight the cells that you want to sort. 

 

 

2. Choose Data->Sort from the Calc menu. 

3. Select the sort criteria you want to use first, and then 



 

choose to sort either in ascending or descending order. If 

you like, set further sort criteria. These will be applied in 

order (e.g. first by name, in ascending order 

alphabetically, then by age, in ascending order). 

4. 

 

 

                                      5.   View the results. 

 

Using Find and Replace 

 

Find and replace in Calc functions much like in Open Office 

Writer. Finding text or data: 

1. Choose Edit->Find & Replace from the Calc menu. 



 

 

 

2. In the Search for box type the text or data you want to 

search for. 

3. Click on the Find button to find the first instance of your 

search term. 

4. Clicking again on the Find button will search 

through the document to find further instances of 

your search term. 

 

Text wrapping 

 

If the content you want to place in a cell is too long for the cell, 

you can choose to wrap the text so that it will go on to a second 

line once it reaches the full width of the cell. 

 

To wrap text in a cell: 

1. Select all the cells that you want the text to break at the 

right border. 

2. Choose Format->Cells from the Calc menu. 

3. Click on the Alignment tab. 

4. Check the box for Wrap text automatically. 



 

 

 

It will look like this: 



 

 

 

2.15 Editing a worksheet 

We now move from working with cells, rows, and columns to 

working with worksheets. You can think of a worksheet as the 

basic functional unit of your spreadsheet – it can contain the data 

from cells, the functions that are used to modify the data, and 

graphs and charts to interpret the data. The worksheet can stand on 

its own as a document. 

Rename a worksheet 

 

The default names of worksheets are Sheet1, Sheet2, and 

Sheet3. You can change the name of a worksheet as follows: 

 

1. Select the worksheet you wish to rename by clicking on the 

tab for that worksheet. 

2. Choose Format->Sheet->Rename from the Calc menu.. 

3. Enter the new name in the dialogue. 

4. Click OK. 

 

Switch between worksheets 

To switch between the different worksheets, you simply click on 

the tab of the worksheet you wish displayed. 

 

 



 

Insert a new worksheet 

 

1. Click on the tab next to the location where you wish to 

insert the new worksheet. 

2. Click Insert->Sheet. This displays the Insert worksheet dialogue. 

 

 

3. Choose the position before or after the selected sheet. 

4. Choose the number of worksheets you wish to insert. If you 

choose only one sheet, you have the option to enter the name 

of that sheet in the Name window. 

5. Click OK 

6. Duplicate a worksheet 

 

You may duplicate a worksheet either within the same 

spreadsheet or between spreadsheets. The other spreadsheet may 

be one that is already open or a new one to be created. In all 

cases, you will use the Copy command to carry out this task. 

 

1. Right-click on the worksheet you wish to duplicate. 

2. Choose Edit->Move/Copy Sheet from the context menu. 



 

 

 

The Move/Copy Sheet dialogue box appears. 

 

 

3. If you want to copy the worksheet to a new location, check 

the Copy checkbox. If you want to move the worksheet 

without making a copy, leave it unchecked. 

4. Select the document you want to move/copy the worksheet 

to. The current document is the default choice. 

5. Select the position for the worksheet in the Insert before window. 

6. Click OK. 

7. Rename the duplicate worksheet if you wish
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Delete a worksheet 

 

1. Right click on the tab of the worksheet you wish to delete. 

2. Select Delete in the menu that appears. A dialogue 

will appear asking you to confirm that you wish to 

permanently delete the worksheet and its contents. 

3. Click Yes to confirm that you wish to delete the worksheet or 

Cancel if you do not wish to. 

 

2.16 Printing a worksheet 

Worksheet orientation 

Worksheet orientation is a style that applies to the whole document. 

By default, when you create a new spreadsheet it is oriented in 

portrait mode. 

 

You can edit the orientation of your document as follows: 

 

1. Choose Format->Page from the Calc menu. 

2. Click on the Page tab. 
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3. Select the size of paper you will be printing on. If you 

choose one of the standard formats from the Format list, 

the paper size will be set automatically. You can also 

create a custom paper size by inputting values for the 

paper height and width. 

4. Choose Portrait or Landscape for your document's orientation. 

5. Set the margins to the desired width 

Printing worksheets 

The steps you have gone through prior to printing your 

document help to ensure that your document is as polished and 

as correct as possible. 

 

You are now almost ready to send your document to print. As a 

final step, you should preview what your document will look 

like when it's printed to make sure that pagination, margins, and 

formatting appear correctly. 

 

To preview your document: 

 

1. Choose File->Page Preview from the Calc menu. 

2. Scroll through your document to view the pages as they 

will look when printed. 

 

                                                            Setting the print area 

 

1. With your mouse, select the area of the worksheet 

you want printed. 
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2. Choose Format->Print Ranges->Add to add your 

selection to the print area.                                                    

Printing 

 

To print your document: 

1. Choose File->Print from the Calc menu. 

3. Choose your printer and adjust the printer properties if 

necessary. Some printer properties are specific 

depending on the type of printer you are using. For 

example, you may need to set properties for your printer 

if you are printing in high quality colour. 

4. Choose the pages you would like printed (by default the 

complete document is printed). 

5. Choose the number of copies you want to print (by 

default one copy is printed). 

6. Click on the OK button to print your document. 
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3.5 Limitations 
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3.9 Types of Accounting Packages 
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3.11 Let Sum Up 
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3.1 Introduction 

As its terminology suggests, "computerized accounting" is accounting done with the help of a 

computer. It tends to includecommitted accounting software and digital spreadsheets to keep 

track of a business or client's financial transactions. 

• Computerized accounting is advantageous inpresent advance technologies. Not onlyithas 

replacedthe old-style paper methods of accounting, but it has also produced new types of 

accounting applications for business. Businesses now makecomplete accounting information 

structures that incorporate all business operations, including external suppliers and vendors in 

the value chain. 

• Computerized accounting systems (or software) have provided a substitute against manual 

based accounting in almost all businesses and organizations, providing accountants, 

managers, employees and stakeholders access to fundamental accounting information at the 
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stroke of a button. Computerized accounting systems has mechanized the accounting process-

-improving efficiency and has help in reducing cost. 

•Computerized accounting has number of benefits over traditional paper based accounting 

system. Computerized accounting tends to be more seamless, is faster to use, and is less 

prone to errors than the manual accounting system. 

3.2 Setof Rules& Procedures 

i. Input: The input source to computerized accounting system is the accounting data and 

vouchers, which is obtained from details of each transaction. Data is stem from source 

document and this is created as a result of occurrence of a transaction. This is kept as an 

evidence of transaction. Source document includes invoice, cheques received, expenses 

 

vouchers and sales order forms etc. Inbuilt software e.g. sale invoice software is used for 

billing that becomes source documents and data is automatically entered and updated in to the 

system for further processing. 

Another input to accounting system is set of accounting rules and processes which are coded 

in accounting software and that are run by inbuilt processes of computers, when transactions 

are processed by systems. 

ii. Processing: The computerized accounting systems are designed in a manner that provide 

benefits of fast processing as the capability of modern day computers and soft wares are very 

robust. At this phase the accounting data is processed according to the basic accounting rules 

of double entry system of book keeping. The main feature here is that unlike manual 

accounting system the computerized accounting system are very fast and error free. 

iii. Output: After the processing, the basic output of the computerized system is trading 

account, profit and loss account, and balance sheet. Now a day, the software is so advanced 

that produces additional reports like aging analysis of sundry debtors to manage these 
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account to check the status of the payments. Further reports like fund flow, cash flow 

statement and GST reports etc. can be generated in automation basis for legal compliances. 

Computerized accounting system generates these reports automatically and on user’s request. 

These reports can be created as often as needed which is not available in manual accounting 

system method. The computerized accounting system is so versatile that they transfer output 

of one component of computerized accounting to another system as input. It facilitates data 

sharing in this accounting system with other interfaces. 

3.3 Importance 

Accounting system is the most important procedure of creating accounting information as the 

survival of the business depends on this. Computerized accounting system is the technique of 

generating accounting information for decision making at every level of management. This is 

possible due to robust computer systems along with the support of accounting packages 

(software). This system is very important and helpful to businesses. 

a. Automatic document production: Number of reports can be generated promptly and 

with reliability. Reports like receipts, invoices, credit notes, sales order, purchase 

order, payroll documents, statement of comprehensive income and statement of 

financial position are generated spontaneously and processed automatically. 

b. Availability of information: Financial information is promptly accessible to the users 

of accounting information for decision making at any time. 

c. Storage: Storage of information is bound to happen in business for later on retrieval 

of the same. Computerized accounting system facilitates for storage of information. 

Information protected can also be repossessed whenever needs arise. It is very 

essential to take back up of your data and store it at some other place. The backup 

could be done by the use of flash drive, external back up and any other storage 

devices. 

d. Compatibility: It makes easy for planning of merger and acquisition, where the 

companies involved use the same accounting software as the data synchronisation is 

possible without any hassles. Manual accounting system could be too difficult for the 

provision of accounting for merger and acquisition. 

3.4 Advantages 

Followings are the various advantages of computer based accounting. 
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a. Automation: As all the calculations are controlled by the accounting software, 

computerized accounting eliminates many of the routine and onerous processes associated 

with manual accounting. For instance, once issued, invoices are processed automatically 

making accounting less time-consuming. 

b. Accuracy: The accounting system is designed in such a manner that it provides accuracies 

to the smallest detail. Once the dataflow into the system, all the calculations, including 

additions and subtractions, are done through inbuilt process automatically by the software. 

There is less space for error because only one account entry is needed for each transaction 

unlike repeated posting of the same accounting data in manual system. 

c. Data Access: Through accounting software, it becomes much easier for different persons 

to access accounting data outside of the office, securely through internet. Further, data can be 

secured by application controls. This is predominantly true, if an online accounting solution 

is being used. 

d. Reliability: As the calculations and controls are so accurate, the financial statements 

generated through computers are highly reliable. Computer systems are invulnerable to 

monotony, tiredness or fatigue. Hence, these can do repetitive jobs effectively and are 

extremely reliable as compared to human beings. 

e. Scalable: When the size of the business grows, the data handling of accounting not only 

increases but develops more complexities. With the help of computerized accounting, the 

whole thing is kept easy because filtering via data using software is stress-free rather than 

examining through a bunch of papers. 

f. Speed: By means of accounting software, the entire process of organizing accounts 

becomes faster. Furthermore, statements and reports can be prepared instantly at the hit off of 

a button. Administrators do not have to wait for long, as the reports can be generated on time 

for fast decisions. Computers need far less time as compared to the human beings in 

performance of a specific task. Consequently, accounting data is dealt within quicker mode 

using a computerized accounting system. 

g. Security: The up-to-date data can be protected and stored at offsite sites, so it is safe not 

only from natural and man-made disasters like earthquakes, fires, floods, arson and terrorist 

attacks but from unauthorised access. In case of adversities, the computing system can be 
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swiftly restored on other computers by accessing to proxy servers. This protection is required 

by every organisation for solving the issues of denial of service. 

h. Cost-effective: As using of computerized accounting is more effective than paper-based 

accounting, then obviously, processing of accounting information will be done faster and 

time will be saved. As the cost of accounting packages has been reduced considerably due to 

availability of number of accounting packages. The data can be stored in online mode in 

through cloud computing with less cost.   

i. Visuals: The data processed through computerised accounting system will facilitate in 

generation of reports in different formats like graphics and in report form with relations. You 

can observe data in tables and using various types of charts. Computerized Accounting 

characterizes a technological development in the area of business accounting. 

j. Up-to-date information: The accounting records are automatically updated and so every 

account balances (e.g. customer accounts) will always be up-to-date. 

k. Availability of information: The processed accounting data is instantly accessible and 

can be made available to different end users at diverse places at the same time. This is called 

data sharing. 

l. MIS Reports: MIS reports can be generated and that will help management to monitor and 

control the business affairs, for instance the aging analysis of debtors will depict the position 

of old debtors for noticing those customer accounts whose balance are overdue. Periodic 

reports for trial balance, trading and profit and loss account and balance sheet will help in 

finding the efficiency of the organisation. It is easier to monitor and control the business 

using the real time management information reports generated by the computerized 

information systems. 

m. GST Returns: With the introduction of GST the necessities of the computerised 

accounting has been increased manifolds as number reports are required for e-filing of the 

returns at GST portal. The accounting data are so large which requires the supports of 

computerised system. 

n. Efficiency: Computerised system based accounting improves the overall efficiency of the 

organisation as the financial data is updated in real time basis and supports earlier corrective 
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measures. The computer based accounting system confirms better use of time and human 

resources. 

o. Staff motivation: The computerised accounting system will require workforce to be 

trained to use new skills, which can make them feel more motivated. As computing is a 

specialised skill which can be outsourced to outside agencies, which will motivate the staff as 

additional skills can be learnt that further enhances the operational skills of the staff.  

3.5 Limitations 

There are some limitations for buying the computerised accounting system. 

i. Heavy Cost of Installation: Initial cost of installing computer hardware and software is 

quite large. Further staff needs training which is an additional cost. After installing new 

system, it needs replacement and updatation of software with updated one from time to time 

with the newer versions. 

ii. Cost of Training: To ensure effective and efficient use of computerized system of 

accounting, the businesses are required to use newer versions of hardware and software. This 

needs specific training and cost is incurred to train the staff personnel as specialists. 

Sometime training is required from specialised persons having good experience in their 

respective fields which requires budget for the same.  

iii. Unemployment: With the introduction of the computerised accounting system there is a 

chance of excess staff being laid off from their current positions. The staff worries about 

dismissal of their jobs and show less interest in computers. 

iv. Disruption in Work: When computerized system is introduced, there might be 

interruption in current work due to data migration from manual system. There are also 

changes in work time and working environment. 

v. System Failure: The danger of a system crashing due to any malfunction in hardware can 

lead to subsequent loss of work. This happens when no back-up is retained. 

vi. Time Consuming: In order to prevent loss of work at the time of system failure, there is a 

need for keeping backup arrangements which is a time consuming process. 

vii. Unanticipated Errors Not Known: Unlike human beings, computers do not have the 

competence to assess or find unexpected errors in the system. 
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viii. Breaches of Security: The risk of viruses and hacking into the system from outside 

intruders creates a robust need for security of system. Likewise, the person who has made the 

specific software package can easily take advantage of by tampering with the original 

records. 

ix. Health Dangers: Extensive use of computers may lead to many health crises such as 

eyestrain, muscular complaints, backache etc. This will reduce the working efficiency as well 

as increase medical expenditure. 

3.6 Differences between Manual and Computerized Accounting 

a. Provision of financial statements: In manual accounting, the accountants require trial 

balance to prepare the periodical financial statement. First arithmetical accuracy of the trial 

balance is checked in manual system for proceeding further. But for computerized accounting 

soft ware these are done automatically and financial statements are effortlessly created by the 

software system itself. 

b. Recording of the financial statements: Recording process needs calculating numerical 

functions by hand and putting them down in cash book or journals as well as posting them on 

ledger or books of original entry. But in computerized accounting software does the 

mathematical functions through internal data computation process as long as the right data 

information was punched into the software. 

c. Rate of accounting computation: Computing the transactions in manual accounting is 

slower as it needs a stage by stage computation by use of human mind and hand. 

Computerized software accounting is much faster in processing the transactions as the 

software by design processes the data once it is fed. 

d. Backup retrieval: For manual accounting recovering financial records might be tiring job 

and as it might include observing various paper documents for reference .Computerized 

software accounting effortlessly recovers the backup information as the accountants or 

business owners only have to restore the saved financial records to get the ones they need. 

e. Ease of classifying accounting statements: For manual accounting, prior to ledger 

accounts posting and preparations, the transactions have to be recorded in the books of 

original entries like cashbook journal etc. However, in computerized accounting system, the 

accounting software categorizes the different transactions as per the accounting nature 
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defined in the software and financial statements are prepared automatically. The business 

owners or accountants can just consolidate financial statements as they require at any point of 

time. 

f. Accuracy of Financial Records: For manual accounting records to be precise, the 

accountants and business owners have to be very cautious and extremely proficient to 

compile the financial reports accurately. Bur with the computerized accounting, as long as 

accurate data are punched then rest of the tasks are done by the software programs. In this 

way accurate and reliable financial statements will be prepared. 

g. Review of the records: Manual accounting financial records can be used effortlessly for 

review. The rectifications and modifications can also be easily made. However, in 

computerized software accounting, the review of financial statements is also fast, but the 

knowledge of its working out can be achieved by cautiously examining the financial formula. 

h. Speed: Computerized accounting produces information extremely quicker than manual 

accounting. Accounting software packages, such as Tally, Busy win and QuickBooks come 

with built-in databases that allow users to input data. 

i. Financial Statements: In a manual accounting system, one has to make company's income 

statement, balance sheet and statement of owner's equity manually. Figures from the journal 

entries helps in formulating the company's financial statements. But the computerized 

accounting systems let financial statements to be produced from information stored in the 

database. 

j. Cost: The budget of computerized accounting systems can vary from few thousands of 

rupees to lakhs of rupees for large businesses. A computerized accounting system may save 

on man hours with the robust speeds in compiling financial records and reports. For this 

object, many small and mid-sized businesses are using computerized accounting software. 

k. Reports: Accounts are created in an appropriate way when using a computerized 

accounting system. Reports produced from electronic accounting software permit managers 

to run the business in a more efficient and effective manner. Generating reports in a manual 

accounting system may lead to more time, staff frustration due to manual operations and this 

will result in having to work with outdated information. 
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l. Safety: Accounting records kept on the manual system can be lost or spoiled easily. On the 

other hand, records kept in a computer are expected to be safer as accounting backup is 

available for any unforeseen events. If anyone has lost the pages in a paper pad, then that 

person may have to reconstruct the transactions by doing investigation and writing them in 

again. In a computerized system, one can simply restore the latest backup file and add a few 

transactions that were not saved. In this space, accounting software is excellent to manual 

systems. 

m. Properly Organized: Data processed via accounting software is organized and easy to 

find. That's not possible with manual systems, where one has to analysis several pages to find 

what is needed. For example, if the report in regard to the old stock is needed then same can 

be found with a click of a button by going to inventory management section in the accounting 

software. If the same process is done on a manual system, one has to go through several 

pages and which is a time consuming job. 

n. Significance: Information technology plays a vital role in accounting processes because it 

improves financial reporting techniques and generate errors free financial statements. 

o. Time Frame: Computerized accounting activities assist an accountant to do month-end 

close procedures to judge the operational; efficiency. These actions also help business to 

report profit information over a period, such as a month or quarter 

3.7 Features of accounting packages 

i. Reporting and analysis: Data is strength in today's demanding business atmosphere. 

Therefore, any accounting package one selects for evaluation must have robust reporting and 

analysis competences. Also managers get insight into critical financial events, reporting and 

analysis functions that help businesses to follow the rules and regulations framed by the 

government and industry. 

ii. Graphics: Accounting is mainly a numbers driven activity. Yet graphics, in the form of 

diagrams and other descriptive presentations, is a great tool that can be used to exhibit trends 

for studying past performances and doing forecasting. This will depict the numbers and other 

concepts in easiest way that numbers alone can't express. 

iii. Automation: For lots of companies, provision for simple accounting transactions and 

basic financial management tasks are not adequate. Many businesses need the complete 
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computerization of worker expenses, payrolls and time sheets; company and departmental 

budgets; purchase requisitions and other complicated financial activities.  

iv. Automatic updates: Taxation laws, rules and financial practices vary over time, so it's 

important to use accounting software that can be updated on time with necessary changes. 

v. Customization: There are possibilities that no accounting software will precisely 

correspond to the business's needs. In that case the businesses should explore for a software 

packages that allows the easy customization to become user friendly. 

vi. Internet connectivity: As entire world is moving to the Internet, it's only rational that 

accounting software should go along with the masses. Therefore, it is necessary that 

accounting software which has the capability to send and receive digital records and handle 

electronic fund transfers should be considered.  

vii. Inter-operability: The information entered into the accounting software package can be 

effectively utilised by various business applications like in HR, sales, shipping and other key 

business segments. Accounting programs should be selected keeping in view the ability to 

interoperate with other software's before deciding on whether to purchase it. 

 viii. Scalability: When the business is in the growth phase in the years to come. Accounting 

software should be able to keep the pace with the growth .Companies should look for a 

accounting software that adapts, or can be effortlessly updated to accommodate the fast 

growth. The system should be supportive to a progressively larger number of users and 

increasing amount of financial data and transactions. Comprehensive discussions with the 

vendors should be done for scalability of the product in the growth phase.  

ix. Security: Business mainly depends on the vital information generated through its 

accounting software for its very survival and decision making. If data is lost, compromised or 

manipulated the management will make wrong decisions which stand to lose time, money, 

business secrets (such as sales or profit data). Data security is of great importance, hence, 

software should be tested beforehand and it’s synchronisations with the current accounting 

system should be ensured. All the built in security controls should be tested as claimed by the 

vendors and necessary changes should be done.  

x. Reporting: Moreover, apart from the range of diverse attributes that are accessible in 

accounting software, the quality and quantity of reports the system can create differs 
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extensively. Various systems present a huge variety of reporting alternatives, with almost 

unlimited classifications and reporting options. Others just offer the basic reports: money in 

and money out. Here are some of the better options like Standard reports, Customizable 

reports, Graph summaries, Cost predictions 

xi. Inventory: An accounting system with stock and inventory in built controls can really 

make more efficient business reporting and controls, helping to identify current stock position 

like slow moving stocks and obsolete stock. This will help in taking appropriate remedial 

measures to liquidate the stock which cannot be sold. Some of the reports are like Track 

inventory status, set inventory levels, specify stock locations, Include item images. 

3.8 Points to be considered before sourcing of accounting software 

Accounting software is an essential part of the computerised accounting system. An 

imperative aspect to be deliberated before purchasing accounting software is the accounting 

proficiency of persons in charge in organisation for accounting function. Individuals, not 

PCs, are responsible for accounting. The necessity for accounting software arises in two 

conditions:  

(a) when the computerised accounting system is put into operation to replace the manual 

system or  

(b) when the existing computerised system needs to be interchanged with a new one in view 

of changing needs. 

3.9 Types of Accounting Packages 

Every Computerised Accounting System is put into action for performing accounting 

activities (recording and storing of accounting data) and produce reports as per the 

requirements of the different users.  

From this perspective. The accounting packages are categorized into the following classes: 

(a) Ready to use 

(b) Customised 

(c) Tailored 

Each of these classes offers distinctive characteristics. However, the choice of the accounting 

software would depend upon the suitability to the organisation especially in terms of 

accounting needs. 

a. Ready-to-Use accounting software is appropriate for the businesses running 

small/conventional business, where the occurrence or size of accounting transactions 

is very low. This is because the cost of installation is normally low and number of 
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users is limited. Ready-to-use software is comparatively simpler to learn and people 

(accountant) adaptability is very high. This also indicates that intensity of secrecy is 

comparatively low and the software is susceptible to data frauds. The training 

requirements are minimal and sometimes the vendor (supplier of software)offers the 

training on the software free. However, this types of software presents little scope of 

networking to other information systems and often require replacements with other 

accounting soft wares when the volume of transactions is increased. 

b. Customised 

Accounting software may be customised to meet the specific requirement of the user. 

Standardised accounting software or packaged accounting software available in the 

market may not match or live up to the user requirements. For instance, standardised 

accounting software may comprise of the sales voucher and stock status as distinct 

options. However, when the financial data is so large which requires that inventory 

status to be updated instantly upon entry of sales voucher and report be printed, the 

software needs to be customised. Customised software is suitable for large and medium 

scale business enterprises and can be used as interface to the other information systems. 

The cost of setting up the software and maintenance is relatively high because the high 

cost is to be paid to the vendor for customisation. The customisation contains 

adaptation and addition to the software contents, provision for the specified number of 

users and their authentication, etc. Confidentiality of data and software can be better 

maintained in customised software by application controls and limiting user access. As 

there is a need to train the employees for using the software, the training costs are 

consequently high. 

c. Tailored 

Tailored made accounting software is normally used in large business organisations 

with multi users and geographically scattered locations. These software necessitates 

specialised training to the users. Software like ERP solutions used in the MNC are fit 

in this type of category. Software used by the FMCG companies are quite different 

from the software used by the Banking Companies for accounting applications. The 

tailored software is designed to meet the specific requirements of the users and work 

as back bone of the organisation’s accounting applications and generating MIS 

reports. The confidentiality and authenticity checks are tough in such soft wares and 

they offer high flexibility in terms of number of users. These software work on the 

concept of need to know need to do basis. 
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3.10 General consideration before sourcing accounting software 

The under mentioned factors are usually taken into considerations before sourcingan 

accounting software. 

i. Flexibility: An essential contemplation before purchasing an accounting software is 

flexibility, viz. ease of data entry, processing and the availability of different reports 

as expected from it. Also, it should offer some flexibility between the users of the 

software, the switch over between the accountants (users), operating systems and the 

hardware. The user should be able to run the software on variety of platforms and 

machines, e.g. Windows 98/2000, Linux, etc. 

ii. Cost of Installation and Maintenance: The selection of the accounting software 

apparently requires the willingness of organisation to invest huge amount in buying 

the hardware and software. A clear-cut standard to take such a decision is the cost 

benefit analysis of the available options vis a vis the financial and operational gains 

from the desired software to be installed. Sometimes, a number of software which 

looks cheap to buy, entail heavy maintenance and modification costs, e.g. cost of 

addition of modules, training of staff, updating of versions, data failure/restoring 

costs and annual maintenance charges. On the other hand, the accounting soft ware 

which appear primarily expensive to the buyers initially, may require minimum 

maintenance and free upgrading and negligible alteration costs. 

iii. Size of Organisation: The size of organisation and the volume of business 

transactions do affect the software selections. Small organisations, e.g. in non-profit 

organisations, small trading concerns, where the volume of accounting transactions is 

not so large, may select a simple, single user operated software. For instance, Tally 

accounting software is available with facility of single user and multiuser application 

feature. While, a big business concern may require high-level software to meet the 

multi-user requirements, geographicallyscattered and connected through complex 

networks. 

iv. Ease of adaptation and training needs: A number of accounting software is user 

friendly demanding a simple training to the users. However, some other complex 

software packages connected to other information systems require rigorous training 

on a regular basis. The software must be capable of appealing users and, if its 

necessitates simple training, should be able to motivate its potential users. 
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v. Utilities/MIS Reports: The MIS reports and the extent to which they are used in the 

organisation also decide the procurement of software. For instance, software that 

necessitates merely generating the final accounts or cash flow/ratio analysis can have 

ready to-use software. On the other hand, the software, which is supposed to deliver 

cost records or other sophisticated reports for decision making needs to be 

customised as per user requirements. 

vi. Expected Level of Secrecy (Software and Data): Another attention before 

procurement of the accounting software is the inbuilt security features ,which check 

unauthorised peoples from retrieving and/or manipulating the vital data in the 

accounting system. In tailored software for large companies, the user privileges may 

be limited to purchase vouchers for the purchase departments, ales vouchers to the 

billing accountants and petty cash module access with the cashier. These are called 

application controls. The operating system also be of importance. Unix environment 

allows multi-users compared to Windows. In Unix, the user cannot access the 

computer system for doing the work unless the user clicks with a password, which is 

not a check in Windows. 

vii. Exporting/Importing Data Facility: The transmission of data files to other systems 

or software is needed from time to time from the accounting software. Organisations 

may want to transport data directly from the ledger into spreadsheet software such as 

Lotus or Excel for more flexible reporting. The software should allow the import or 

export of the data in to excel sheets or spreadsheets without any data manipulations. 

Accounting software may be needed to be connected to MIS software in the 

organisation for reporting. In some ready to use accounting software's, the exporting, 

importing capability is available but is limited to MS Office modules only, e.g. MS 

Word, MS Excel, etc. However, tailored software's are configured in such a way that 

they can work together and share information with the numerous sub components of 

the organisational MIS. 

viii. Vendors Reputation and Capability: Additional significant matter is the reputation 

and competence of the vendor. This is contingent upon how long the vendor has been 

in the business of software development. External reports about the vendor from the 

businesses using his software is of great importance. Evaluation of these reports of 

other users of the software and extent of the availability of after sale support is very 

much important for selection of the accounting software. 
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3.11 Let Sum Up 

Computerized accounting" is accounting done with the help of a computer. It tends to 

include committed accounting software and digital spreadsheets to keep track of a 

business or client's financial transactions. Accounting information from the vouchers 

are used as input for processing and desired reports are generated. The importance of 

the computerized accounting system is manifold as this is the technique used for 

generating accounting information for decision making at every level of management. 

This system offers number of advantages like automation, accuracy, data access, 

reliability, speed, security, cost effective, MIS reports, efficiency etc. However, there 

are some limitations like heavy cost of installation, cost of training, unemployment, 

disruption in work, time consuming, breaches of security and health dangers. There 

are different advantages of using computerized accounting system over manual 

accounting system. The accounting packages are categorized into the classes like (a) 

Ready to use, (b) Customised and (c) Tailored. There is certain general consideration 

to be noted before sourcing an accounting software like Flexibility, Cost of 

Installation and Maintenance, Size of Organisation, Ease of adaptation and training 

needs, Utilities/MIS Reports, Expected Level of Secrecy (Software and Data), 

Exporting/Importing Data Facility and Vendors Reputation and Capability 

 

3.12 Test your knowledge. 

Questions 

1. Define a computerised accounting system. 

2. Distinguish between a manual and computerised accounting system.  

3. What is computerized Accounting?  

4. Discuss the limitations of computerized Accounting.  

5. What are rules and procedures involved in computerised accounting? 

6. What are the advantages of computerised accounting? 

7. What are the features to be studied before selecting an accounting software? 

8. Explain the different categories of the accounting packages available in the market. 

9. What points to be considered before buying an accounting software. 
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4.1.1  OBJECTIVES 

After studying the Unit, students will be able to  

 Understand the basic concepts of business storage data. 

 Understand how to work with button on the tool bar. 

 Entering the data in to the worksheet. 

 Understand and apply Cut, Copy, Paste, text and formula.  

 Understand the basic terminology used in Excel. 

 

4.1.2 Introduction 

MS-Excel is a full-featured window based spread sheet program 

developed by Microsoft Corporation is used by millions of people around the 

world. Excel includes all standard features of a spreadsheet package like 

automatic recalculation, graphs & functions. It includes several advanced 

utilities like facility to include other objects within a spreadsheet, table and 

form designing. 



Microsoft Excel is developed on the GUI concept. A spreadsheet is a 

highly interactive computer program that consists of a collection of rows and 

columns that are displayed on the screen in a scrollable window. The 

intersection of each row and column is called a cell. A cell can hold a number, 

a text string or a formula that performs a calculation using one or other cells.  

This chapter gives an introduction to spread sheets. It also highlights the 

new features of MS- Excel, the concept of a workbook and adding or deleting 

rows and columns. 

The most important advantage of using an electronic spreadsheet is that 

formulas recalculate their results if changes are made to the contents of the 

related cells.  

Excel is used for a variety of applications. It is commonly used to 

automatic financial statements, business forecasts, transition registers 

inventory control, accounts receivable and accounts payable. The package 

provides statistical, analytical and scientific functions. Therefore, Excel is used 

in many scientific and engineering environments to analyze numerical data and 

present findings. Excel comes across as a powerful and flexible graphical 

presentation tool. Excel is also able to access data stored in database formats. 

Excel may also used as a powerful application development tool. 

4.1.3 STARTING EXCEL 

1. Click the start button on the task bar. 

2. Point to program. 
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3. Click Microsoft Excel. A blank workbook opens, and the new 

workbook task pane opens on the right side of the screen. 



 
 

4.1.4 EXCEL APPLICATION WINDOW 

The excel application window includes the standard title bar and 

command bars. Below the command bars is a strip that contains the name box 

and the formula bar. 

The excel status bar displays information about current selection, 

commands or operations. The right end of the status bar displays NUM if the 

keyboard’s num lock is on. 

MS-Excel uses personal tool bar, so the command bars may appear side 

by side or one above the other you can drag and drop command bars to 

rearrange them you if wish you can also click the tool bar and drag it to the left 

to along at its display and make more buttons visible. 

4.1.4.1 Components of Excel Application Window  

Microsoft Excel is an electronic spreadsheet. You can use it to organize 

your data into rows and columns. You can also use it to perform mathematical 

calculations quickly. Although knowledge of how to navigate in a Windows 

environment is helpful. 

This chapter will introduce you to the Excel window. You use the window 

to interact with Excel. To begin this chapter, start Microsoft Excel 2007. The 

Microsoft Excel window appears and your screen looks similar to the one 

shown here. 
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Note: Your screen will probably not look exactly like the screen shown. 

In Excel 2007, how a window displays depends on the size of your window, the 
size of your monitor, and the resolution to which your monitor is set. 

Resolution determines how much information your computer monitor can 
display. If you use a low resolution, less information fits on your screen, but 
the size of your text and images are larger. If you use a high resolution, more 

information fits on your screen, but the size of the text and images are smaller. 
Also, settings in Excel 2007, Windows Vista, and Windows XP allow you to 

change the color and style of your windows. 

4.1.5 Anatomy of Excel Worksheet 

The structure of worksheet of MS-Excel from top to bottom with icons are as 

below 

1.The Microsoft Office Button 
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In the upper-left corner of the Excel 2007 window is the Microsoft Office 
button. When you click the button, a menu appears. You can use the menu to 



create a new file, open an existing file, save a file, and perform many other 
tasks. 

2.The Quick Access Toolbar 
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Next to the Microsoft Office button is the Quick Access toolbar. The 

Quick Access toolbar gives you with access to commands you frequently use. 
By default, Save, Undo, and Redo appear on the Quick Access toolbar. You can 

use Save to save your file, Undo to roll back an action you have taken, and 
Redo to reapply an action you have rolled back. 

3. The Title Bar 
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Next to the Quick Access toolbar is the Title bar. On the Title bar, 
Microsoft Excel displays the name of workbook you are currently using. At the 

top of the Excel window, you should see "Microsoft Excel - Book1" or a similar 
name. 

4.The Ribbon 
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 You use commands to tell Microsoft Excel what to do. 
In Microsoft Excel 2007, you use the Ribbon to issue commands.  

 The Ribbon is located near the top of the Excel window, below the 
Quick Access toolbar. 

 At the top of the Ribbon are several tabs; clicking a tab displays 

several related command group Within each group are related 
command buttons. 

 You click buttons to issue commands or to access menus and dialog 
boxes. 

http://www.baycongroup.com/excel2007/01_excel.htm
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 You may also find a dialog box launcher in the bottom-right corner of 
a group.  

 When you click the dialog box launcher, a dialog box makes 
additional commands available. 

5. Formula Bar 
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Formula Bar 

 If the Formula bar is turned on, the cell address of the cell you are in 

displays in the Name box which is located on the left side of the 
Formula bar.  

 Cell entries display on the right side of the Formula bar. 

If you do not see the Formula bar in your window, perform the following 
steps: 

1. Choose the View tab. 

2. Click Formula Bar in the Show/Hide group. The Formula bar appears. 

Note: The current cell address displays on the left side of the Formula 
bar. 

6. Worksheets 
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 Microsoft Excel consists of worksheets.  

 Each worksheet contains columns and rows.  

http://www.baycongroup.com/excel2007/01_excel.htm
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 The columns are lettered A to Z and then continuing with AA, AB, AC 
and so on;  

 The rows are numbered 1 to 1,048,576. 

 The number of columns and rows you can have in a worksheet is 

limited by your computer memory and your system resources. 

 The combination of a column coordinate and a row coordinate make 
up a cell address. 

 For example, the cell located in the upper-left corner of the worksheet 
is cell A1, meaning column A, row 1. Cell E10 is located 
under column E on row 10. You enter your data into the cells on the 

worksheet. 

7. Status Bar 
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 The Status bar appears at the very bottom of the Excel window and 
provides such information as the sum, average, minimum, and 

maximum value of selected numbers.  

http://www.baycongroup.com/excel2007/01_excel.htm
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 You can change what displays on the Status bar by right-clicking on 
the Status bar and selecting the options you want from the Customize 

Status Bar menu.  

 You click a menu item to select it. 

 You click it again to deselect it. 

 A check mark next to an item means the item is selected. 

 

8. Move around Worksheet 

 

 By using the arrow keys, you can move around your worksheet. 

 You can use the down arrow key to move downward one cell at a time. 

 You can use the up arrow key to move upward one cell at a time. 

 You can use the Tab key to move across the page to the right, one cell 
at a time. You can hold down the Shift key and then press the Tab 

key to move to the left, one cell at a time. 

 You can use the right and left arrow keys to move right or left one cell 
at a time.  

 The Page Up and Page Down keys move up and down one page at a 

time.  

 If you hold down the Ctrl key and then press the Home key, you move 
to the beginning of the worksheet. 

9. Working with Excel Worksheet 

 

Move around the Worksheet 

a. The Down Arrow Key 

Press the down arrow key several times. Note that the cursor moves downward 
one cell at a time. 

b. The Up Arrow Key 

Press the up arrow key several times. Note that the cursor moves upward one 
cell at a time. 

c. The Tab Key 

1. Move to cell A1. 

2. Press the Tab key several times. Note that the cursor moves to the right one 
cell at a time. 

c. The Shift+Tab Keys 

Hold down the Shift key and then press Tab. Note that the cursor moves to the 
left one cell at a time. 

d. The Right and Left Arrow Keys 

1. Press the right arrow key several times. Note that the cursor moves to the 



right. 

2. Press the left arrow key several times. Note that the cursor moves to the 
left. 

e. Page Up and Page Down 

1. Press the Page Down key. Note that the cursor moves down one page. 

2. Press the Page Up key. Note that the cursor moves up one page. 

f. The Ctrl-Home Key 

1. Move the cursor to column J. 

2. Stay in column J and move the cursor to row 20. 

3. Hold down the Ctrl key while you press the Home key. Excel moves to cell 
A1. 

10. Go To Cells Quickly 

The following are shortcuts for moving quickly from one cell in a 

worksheet to a cell in a different part of the worksheet. 

Go to -- F5 

The F5 function key is the "Go To" key. If you press the F5 key, you are 
prompted for the cell to which you wish to go. Enter the cell address, and the 

cursor jumps to that cell. 

1. Press F5. The Go To dialog box opens. 

2. Type J3 in the Reference field. 

3. Press Enter. Excel moves to cell J3. 

Go to -- Ctrl+G 

You can also use Ctrl+G to go to a specific cell. 

1. Hold down the Ctrl key while you press "g" (Ctrl+g). The Go To dialog 

box opens. 

2. Type C4 in the Reference field. 

3. Press Enter. Excel moves to cell C4. 

11. The Name Box 

You can also use the Name box to go to a specific cell. Just type the cell 

you want to go to in the Name box and then press Enter. 
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1. Type B10 in the Name box. 

2. Press Enter. Excel moves to cell B10. 

4.1.6 EXCEL FEATURES  

Excel support a variety of features that are helpful for managing the 

spreadsheet data.  

A few important features of excel are: 

1. Excel has 1048576 rows and 16384 columns in it worksheet. 

2. It support what if analysis to help predict the future values if there is 

a change in the cell content which is referred to in the formula. 

3. Based on the data, graphs or charts can be created for quick 

assessment of a situation. 

4. Excel provide facility of manipulation of string data. 

5. Excel support date and time related function. 

6. Huge amount of information stored. 

7. Excel takes advantage of windows environment. The windows 

environment especially applies to DDE (Dynamic Data Exchange) and 

OLE (Object Linking and Embedding) concept within Excel and 

between Excel and other windows application. 

8. Excel also has a drawing tool bar by using which you create your own 

graphs, charts and other pictures. 



9. You can create shortcut keys for processing the task automatically by 

using the keyboard macros. 

10. Excel allow you to define macros, which you can use to combine a 

series of actions to automate your work. 

11. The new share workbook feature lets multiple users open a workbook 

on network and edit it simultaneously. 

12. Solver add-in-enables you to calculate the values needed to reach a 

particular result by adjusting the values of one or more cells. 

4.1.7 UNDO AND REDO  

MS-Excel allows many commands or actions or operations to be reversed 

or roll back i.e. an action can be undone by selecting the undo option from 

Home Tab or by pressing the Ctrl+Z key combination from the keyboard. It can 

deselect or undo previous action or operations. The undo option can be 

selected by clicking the undo button having anti clockwise arrow on the 

standard toolbar. Excel also provides a command to repeat the last action by 

selecting redo option from the Home Tab or by pressing the Ctrl+Y key 

combination as shortcut key. 
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4.1.8 PRINTING  

This section describe the printing process of MS-Excel. MS-Excel 

provides a number of option to improve the appearance of printouts of 
worksheets and charts. The Office button has four options related to printing. 

These are Page Setup, Print Area, Print Preview and Print. These are explained 
as under : 
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Page Set Up :- Page Setup displays a four-part dialog that is used to lay 

out your page. Click the appropriate tab to display the corresponding dialog. 

Page :- This dialog box is used to set page orientation, scaling, and paper 

size. 

Margins :- This dialog box is used to set the left, right, top and bottom 

margins, the distance from the edge of the page to headers or footers, and page 
centering. Click Options to select paper, print quality, fonts, and device 
options. 
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Header and Footer :- If one wish to use headers or footers, use this 

dialog to create and position the text. The Custom buttons provide the ability to 
insert the page number, date, time, filename, or tab name. One can also 

arrange the header/footer information at the left, center or right. 
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Sheet :- It is used to it is set the print area, repeating row and column 

titles, and page printing order i.e. down then over or over then down. User can 

enter a print area by clicking the button in the Print area box and then 

dragging the desired cell range. Rows and Columns Print Titles can also be 

entered by picking the desired cells. User can also print gridlines, column and 

row headings, comments, and set black and white and draft quality printing. 



 

Fig. 

Print Area: It is used to select or to clear the current range of selected 

cells. 

Print Preview:- Print Preview is used to dispaly an image of the printed 

page before send it to printer. 

It is noted that Print Preview gives you direct access to the Print and 

Page Setup dialog boxes. The other buttons let you page through a large 

worksheet, zoom (enlarge or reduce the display), display and adjust margin 

guidelines, close the preview, and display Help. 



 
 



 
Fig.  

Print :- This dialog is used to specify the pages to print use the printer to 

print your work. 

One can also access the Print Preview dialog box here. One can start with 

this selection, perform all necessary preview and setup operations, and then 
print workbook. 



 
Fig. 

4.1.9 MS-EXCEL HELP 

MS-Excel offers many different ways to get help with any program. User 

can ask the office assistant for help that will appear automatically when MS-
Excel is started. Note that there is a very powerful help system behind the 
Office Assistant. The office assistant is a little box with two twinkling eyes. User 

can take any type of help from the assistant or turn it off by clicking the close 
button in its upper right corner. User can also click the tip button or option 
button to get the help about any topic or menu option. A more convenient way 

to get help is through the content and index command on the help menu from 
the Ribbon. There are three options like contents, index and find. The contents 

tab displays all the help content about handling MS-Excel. This index option 
displays the list of help topics in an alphabetical order and the find option 
helps to locate a particular topic. Find option automatically builds up the 

index. User can also take help by using mouse pointer by opening the help 
options and selecting the massage “What’s This ?”. This will change the mouse 

pointer to a question mark and this question mark can be placed on any topic 



or button or Ribbon or option for help. A box will appear indicating the details 
about the concerned topic. 
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4.1.10 QUITTING EXCEL 

The user can quit the Excel application by selecting Exit from the Office 

button. It is always recommended to save and close the file before quitting 

Excel. If a workbook has not been saved, Excel displays a confirmation box as 
shown below to confirm whether to save or quit without saving changes. 
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4.1.11 TEST YOUR UNDERSTANDING (A) 

1.   Explain various features of EXCEL. 

 

……………………………………………………………………………………………… 

 

……………………………………………………………………………………………… 

 

……………………………………………………………………………………………… 

 

……………………………………………………………………………………………… 

 

2.  Difference between Workbook and Worksheet. 

…………………………………………………………………………………..… 

 

……………………………………………………………………………………………… 

 

………………………………………………………………………………………………… 

3. Fill in the Blanks 

a. ----------------- Intersection of Row and Columns. 

b. By default there are --------- sheet. 

c. Collection of worksheet is --------------.  

d. Excel has -------- rows and ------- columns in it worksheet. 

 



 4.1.12Review Question 

 1. Explain the usage of Excel in business? 

 2. What is the Anatomy of Excel Window? 

 3. What are the various features of Excel? 

 4. Differentiate between the followings: 

 1.  Absolute and Cell Reference 

      2.   Relative and Mixed Reference 

      3.  Print and Print Preview 

      4.  Undo and Redo 

Answer Key 4.1.11 

1. cell 

2. three 

3. workbook 

4. 1048576, 16384   

5.  Tuple 
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4.2.1 WORKBOOK 

 

A workbook is an Excel file where  data is  stored.  It consists of many worksheets. A worksheet 

is a page in the workbook where data can be entered. The current sheet is always highlighted in 

the sheet tab. Sheet belonging to a particular application can be stored in the same workbook.  



When the workbook is opened, all the worksheets contained in that workbook are automatically 

opened. Since each workbook contains many sheets you can organize various types of related 

information in single file. 

By default a workbook contains three worksheets. To move from one sheet to another 

sheet, click the sheet tabs. 
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4.2.2 Creating workbook 

 

A new Workbook is created whenever you open MS-Excel or by default whenever user 

starts MS-Excel, it automatically create a new Workbook and name the file “Book1”.  File menu 

or Standard Tool bar below menu bar contains the command New by clicking New command in 

Office button you can create a new Workbook. 
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4.2.3 Opening and exiting workbook 

 

You can open an existing workbook by clicking the “Open” command from Office button. When 

you click “Open” command a window will appear In front of you. if required file is saved in 

different folder or drive then change the current folder or drive by clicking “Look in” button to 

move to the required folder or drive then by selecting your required XLS or MS-Excel file press 

“Open” button. 
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4.2.4 Saving workbook 

You will have to saved the workbook to secondary storage, if you want to use it again. 

While saving a file, a unique name is provided to the file. MS-Excel provides a temporary name 

(Book) to file unless you save it. Performs the following steps to save the workbook: 

(i) Click at the office button. A pull down menu will appear. Select the save command 

from them. 

(ii) On doing so, a dialog box appear. For this you can use „Ctrl+S‟ keys simultaneously 

(Shortcut keys). 



(iii) You can type the appropriate file name in the „File name‟ text box. After doing this 

click at save button or press down the enter key from the keyboard. 

.
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The various types in which you can save the workbook are like Web page, template, text 

etc. 

 

4.2.5 Saving Copy of Workbook (Save as) 

 

Sometimes you need to save a copy of file with a different name than you can use „Save 

As‟ command from office button. A copy of file can be used for backup purpose or where same 

text appears at the starting of two or more workbooks and rest of the contents are different. For 

example in annual report and annual magazine, introduction of the company may remain the 

same.  

Performs the following steps : 

(i) Open the original file. 

(ii) Click Save as option from office button. 



(iii) Choose the folder in which you want to save your file. MS-office files are by default 

saved in “My Document” folder. 

(iv) Type the name of the duplicate file and click save button. 

(v) You will get a copy of the file with a different name. 

 

4.2.6 Closing Workbook 

Once you have done your work in the Workbook and you want to close it.  

The following steps need to be performed: 

(i) Click at the Ribbon from the menu bar. A cascading menu will appear. 

(ii) Select the close command from them with the help of mouse. 

(iii) On doing so the document window will close, if the contents of that document saved 

already. 

(iv) If the contents of that file are not saved a dialog box will appear after click at the 

close button. 

If you click the „Yes‟ button it would save the changes and close the document if you 

click at the „No‟ button it would not save the changes. 

4.2.7 WORKSHEET OR SPREADSHEET 

 

A worksheet consists of rows and columns. Rows run horizontally in a sheet and are 

identified by numbers. Columns run vertically in a sheet and are identified by letters. The 

information of row and column is called a cell. Cells are named by their position in the columns 

and rows. The column letter followed by the row number is called a cell reference. Light gray 

line surround each cell and are known as Gridlines. Spreadsheet programs are developed to 

automate tasks such as technical calculations, inferential statistics, analyzing data, etc. It also has 

a powerful program for graphical preparation of numerical data. It is commonly used in: 

 Production and planning 

 Personnel Management,  

 Marketing 

 Payroll and Accounting 

 Cost Analysis 

 Budget management and sales forecasting. 

4.2.8 Inserting Worksheets 

To add a new worksheet click Insert on Worksheet from the Home Tab. The second 

method to insert the worksheet is to select the worksheet from the worksheet tab by clicking 



mouse, then click the right mouse button, select the insert command to insert new worksheet 

before the present selected worksheet. 
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 To add multiple worksheets, select the multiple worksheet by holding the SHIFT button 

and then click right mouse button and select the insert command, as you selected 3 worksheet, 

before clicking right mouse button the 3 new worksheet will be inserted in the worksheet tab. 
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4.2.9 Deleting Worksheet 

To delete an existing worksheet select the worksheet you are wanted to delete click 

Delete Worksheet from the Home Tab. The second method to delete the worksheet is to select 

the worksheet from the worksheet tab by clicking mouse, then click the right mouse button, 

select the delete command the selected worksheet will be deleted. 
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To delete multiple worksheets, select the multiple worksheet by holding the SHIFT 

button and then click right mouse button and select the delete command, as you selected 3 

worksheet, before clicking right mouse button the all selected worksheets will be deleted from 

the worksheet *tab. 

*
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4.2.10 Renaming and Moving Worksheets 

There are always three worksheets available whenever you open a new workbook, the more 

sheets can be inserted or deleted as you have discussed earlier. You can change the name of 

existing worksheets by the same method as you have discussed for inserting or deleting the 



sheets. Select the sheet then click the right mouse button, here appear the command for renaming 

the sheet select the command and enter the new name of sheet. 

Two ways to Move or Copy worksheets, move the sheet within the same workbook and 

copy or move the sheet from one workbook to other work book: 
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1. To move the worksheet from one place to other within the same workbook is to 

select the worksheet from the sheet tab and DRAG the sheet to target location by 

holding the mouse button or to select the worksheet and click the right mouse button 

to move the selected sheet to required target location. 

2. To move or copy the worksheet to another workbook, select the worksheet, click the 

-right mouse button and select the copy or move command to move or copy the 

worksheet to new workbook. 

 

Fig. 

 

4.2.11 CELL (ADDRESS AND RANGE) 

Worksheet is divided into columns and rows, intersection of column and row is called 

cell. A rectangular box that basically contains the data in MS-Excel. It has a specific width and 

height, although its height or width can be changed by the user according to their requirement. 



A cell where the data is entered by the user or selected cell with black outline is called 

Active cell. Every cell in MS-Excel has a unique name which is called Cell Address like A1, B1, 

C1 etc.  

 

4.2.11.1 Cell Range 

A range is a rectangular group of cells. The smallest range is a single cell and the largest 

range includes all the cells in the worksheet. A range can include cells from same sheet or cells 

from adjacent sheets.‟ Ranges are defined by the addresses of two opposite or diagonally paired 

corner cells separated by a colon or two dots.  

Ranges can be set when only a part of the worksheet has to be printed. To print the 

selected range, follow the steps given below : 

– Select the range of cells to be printed.  

– In the Page Layout, point to the Print Area option and click Set Print Area. The print 

area set is indicated by a dotted line around it in the worksheet.  

– To check click the Print Preview button.  

To print non-adjacent columns or rows in a table, hide the columns or rows not needed to 

print. To do this select the rows or columns and right-click the selection and select Hide.  

4.2.12MANIPULATING CELL CONTENTS  

 

4.2.12.1 Entering Data in cells 

Text, numbers and dates can be entered into any cell of a worksheet. Data can be entered 

in the active cell by clicking the enter box in the formula bar or by pressing F2. An entry can be 

cancelled by clicking the cancel button  on the formula bar or by pressing the ESC key. Each 

cell can hold up to characters. Text is left aligned and numbers are right aligned in Excel and this 

default alignment is called General alignment. The below fig. gives a clear idea on how the data 

is displayed. 
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The column headings may not appear properly, if the column width is not large enough to 

contain them. To increase the column width, place the mouse on the right border of the column 

whose width has to be increased and click drag the mouse button. 

 First, place the cursor in the cell in which you want to start entering data. 

 Type some data, and then press Enter. 

 If you need to delete, press the Backspace key to delete one character at a time. 

Example  To Enter Data 

1. Place the cursor in cell A1. 

2. Type John Jordan. Do not press Enter at this time. 



 

Fig  

4.2.12.2 Delete Data 

 The Backspace key erases one character at a time. 

 Press the Backspace key until Jordan is erased. 

 Press Enter. The name "John" appears in cell A1. 

 

Fig  

4.2.12.3 Edit a Cell 

After you enter data into a cell, you can edit the data by pressing F2 while you are in the 

cell you wish to edit. 



 

Fig  

 If you want to Change "John" to "Jones." 

Method 1  

1. Move to cell A1. 

2. Press F2. 

3. Use the Backspace key to delete the "n" and the "h." 

4. Type nes. 

5. Press Enter. 

 Method 2  

Editing a Cell by Using the Formula Bar 

You can also edit the cell by using the Formula bar. You change "Jones" to "Joker" in the 

following way. 

 



Fig. 

1. Move the cursor to cell A1. 

2. Click in the formula area of the Formula bar. 

 

Fig. 

3. Use the backspace key to erase the "s," "e," and "n." 

4. Type ker. 

5. Press Enter. 

 Method 3 

 Edit a Cell by Double-Clicking in the Cell 

You can change "Joker" to "Johnson" as follows: 



 

Fig. 

1. Move to cell A1. 

2. Double-click in cell A1. 

3. Press the End key. Your cursor is now at the end of your text. 

 

Fig. 

4. Use the Backspace key to erase "r," "e," and "k." 

5. Type hnson. 

6. Press Enter. 

Method 4 



4.2.12.4Change Cell Entry 

Typing in a cell replaces the old cell entry with the new information you type. 

1. Move the cursor to cell A1. 

2. Type Cathy. 

3. Press Enter. The name "Cathy" replaces "Johnson." 

 

Fig. 

4.2.12.5 Entering date and time 

Microsoft Excel stores dates as sequential numbers known as serial values. This scheme 

allocates one digit for every day from January 1 to December 31. Excel also provides formatting 

and formulae to convert the date serial number to a specific calendar date. Dates and times are 

values and hence they can be added, subtracted and included in other calculations. By default the 

dates are displayed in two digit years.  

In Excel the time is added to the date serial number as a decimal fraction of a 24 hour 

day. Therefore, midnight is 0.000000, noon is 0.500000 and 11:59:59 PM is 0.999988. 

Whenever the date or time is to be changed, the cell format is automatically changed from the 

normal format to the appropriate date or time format. 



 

Fig  

4.2.12.6 Entering the data in Series  

Whenever the user wants to fill a cell range with data forms as a series (e.g. 1,2,3,4 or 

Jan, Feb or Mon, Tue) the data input can be automated. 

This can be achieved by using the fill handle. The fill handle is a black square located on 

the lower right corner of the selected cell. This is called Auto fill feature.  

For example, to generate month names in a range of cells, enter Jan into cell Al and point 

to the fill handle with the mouse, the mouse pointer changes to a black cross. Click and drag 

through the cells Al to A12 and then release the mouse button. The series of months from 

January to December will be filled into cells Al through A12 as shown in Fig. 



 

Fig  

4.2.12.7 Copying Data  

While copying or moving data, a copy of that data is placed in 

the clipboard. The clipboard provided by Office 2007 can store multiple 

bits or data (up to 12). To copy a range of data, select the range and 

press CTRL+C or click the Copy button in the Standard toolbar. The 

icons are the same as in MS-Word. Select the destination cell and click 

the Paste button from tb toolbar menu. The Copy and Paste commands 

can be easily accessed from the shortcut menu. 

4.2.12.8 Moving Data  

Moving data is similar to copying, except that the data is 

removed from its original place. To move data choose the Cut button 

from the Standard toolbar.  

Using Drag and Drop  

 
Fig  



The fastest way to copy is to drag and drop the data. To do this, select the cells to be 

copied, hold down the CTRL key and drag the border of the selected range. On releasing the 

mouse button the data is copied to the new location. The data gets moved to the new location if 

the border is dragged without holding down the CTRL key.  

To copy data to a different sheet, press CTRL+ALT while dragging the selection to the 

sheet‟s tab. Excel switches to that sheet, where the selection can be dropped in the appropriate 

location. 

The drag and drop feature can be used to copy or move data to the Office clipboard. 

4.2.12.9 Deleting data 

To delete data in a cell or range of cells, select the cell or the range and press the DEL 

Clear command can be used to clear the format, contents, comments or all of them. 

 

Fig  

T

take over their place. 

4.2.12.10 Select Cells 



 

Fig 

If you wish to perform a function on a group of cells, you must first select those cells by 

highlighting them. The following example will help you how to select. 

Method 1 

To select cells A1 to E1 

1. Go to cell A1. 

2. Press the F8 key. This anchors the cursor. 

3. Note that "Extend Selection" appears on the Status bar in the lower-left corner of the 

window. You are in the Extend mode. 

4. Click in cell E7. Excel highlights cells A1 to E7. 

5. Press Esc and click anywhere on the worksheet to clear the highlighting. 

Method 2 

Select Cells by Dragging 

 You can also select an area by holding down the left mouse button and dragging the 

mouse over the area.  

 In addition, you can select non Contiguous areas of the worksheet by doing the 

following: 



 

Fig  

1. Go to cell A1. 

2. Hold down the Ctrl key. You won't release it until step 9. Holding down the Ctrl key 

enables you to select noncontiguous areas of the worksheet. 

3. Press the left mouse button. 

4. While holding down the left mouse button, use the mouse to move from cell A1 to 

C5. 

5. Continue to hold down the Ctrl key, but release the left mouse button. 

6. Using the mouse, place the cursor in cell D7. 

7. Press the left mouse button. 

8. While holding down the left mouse button, move to cell F10. Release the left mouse 

button. 

9. Release the Ctrl key. Cells A1 to C5 and cells D7 to F10 are selected. 

10. Press Esc and click anywhere on the worksheet to remove the highlighting. 

4.2.12.11 Wrap Text 

When you type text that is too long to fit in the cell, the text overlaps the next cell. If you 

do not want it to overlap the next cell, you can wrap the text. 

Wrap Text 



 

Fig  

1. Move to cell A2. 

2. Type Text too long to fit. 

3. Press Enter. 

 

Fig 

4. Return to cell A2. 

5. Choose the Home tab. 

6. Click the Wrap Text button . Excel wraps the text in the cell. 

 

 

 



4.2.13 IMPORTANT DEFINITIONS 

(i) Cell: Intersection of Row and Column is called cell. 

(ii) Cell Address or Cell name: It is the combination of the column name and row 

number i.e. a cell formed by the intersection of column B and row 5 will be B5. 

(iii) Active cell: The cell that has highlighted thick border around it is called active cell. 

When worksheet opens, the cell displayed has row/and column A1. It is active or 

current cell. 

(iv) Cell Pointer: The Thicker border area that moves from one cell to another is called 

cell pointer. It works like a cursor. You can enter the information, in a particular cell 

where the cell pointer is. 

(v) Work Book: It is a file where data is stored. It consists of many worksheet. 

Example. As the folder contains many files work book contains very worksheet. 

Hence folder is workbook and files are worksheets. 

(vi) Work sheet: It is a page in a workbook where actual data can be entered, the current 

sheet is always highlighted in the sheet tab. 

4.2.13.1 Reference  

A reference identifies a cell or a range of cells on a worksheet and tell Microsoft excel, 

about where to look for the value or data that you want to use in the formula. We can refer to a 

cell or range of cell in formula in three ways. 

4.2.13.2 Relative Reference  

It is a default addressing used by Excel. When you create a formula using relative 

reference. Reference to cells or ranges are usually based upon their position relative to the cell 

that contains the formula. Example The Cell J2 contains a formula 

    J2 = H2 * I2 

This formula is using relative reference; so the formula in the cell J3 will be = H3 * I3 

and so on. This is due to relative reference. Each cell having the formula, store the information 

boot the cells being used in the formula and update this information relatively when you copy the 

formula. 

4.2.13.3 Absolute Reference  

When you don‟t have a series of the data corresponding to the formulae. It refers to a 

specific cell or cells. It is useful when you want to refer the data in a specific cell, rather than 

allowing you reference to change based on column or row. 

Example. If you want to calculate the percentage of every student. The student marks can 

change but formula to calculate is same. 

You can make a column, row or cell absolute by placing ($) dollar sign before the 

reference like $A$4, $3$2 it makes the cell A4 and S2 Absolute. 



 

Fig  

4.2.13.4 Mixed Reference  

Combination of absolute and relative reference is called Mixed reference. 

Example: If you want the row changed but the column to remain the same or vice versa then you 

use the mixed Reference. Examples of Mixed reference are $A1, $B3, A$2, B$3 

To understand this concept let us take a practical Example Suppose in a cell K2 the 

formula is = J2 * J11 has been applied. The cell J11 contains 10% that is the sale tax percentage, 

when you drag the formula to cell K3, it becomes = J3 * J12 due to relative reference. But there 

is no value in J12. Hence no value will be displayed when you drag this formula of cell K2. If we 

write the formula is absolute reference like. 

    K2 = $J$2 * $J$12 

 

Fig  

This will gives you the same result in K3, K4 ...... and other cells which is not needed 

This problem can be solved by using the mixed reference. 

Like K2 is = J2 * $J$11 



When you drag this formula it will change J2 and J3 but $J$11 will remain same or 

constant 

4.2.14 TEST YOUR UNDERSTANDING (A) 

1.   Explain Cell range with Example. 

 

……………………………………………………………………………………………… 

 

……………………………………………………………………………………………… 

 

2.  Difference between Relative and Absolute cell reference. 

…………………………………………………………………………………..… 

 

……………………………………………………………………………………………… 

 

3. Fill in the Blanks 

a.  Cell address is a combination-------and ----------. 

b. Intersection of row and column ---------. 

c. Thicker border area that moves from one cell to another is ---------- 

d. To save the command with different name the button that is used is--------. 

 

4. 2.15 Review Question 

1. What is Excel Workbook and Explain methods of creating and saving workbook? 

2. What is Excel Spreadsheet and write the method of renaming and moving 

spreadsheet? 

3. Differentiate between cell address and cell range ? 

4. Explain following operations in Excel cells and define the following: 

 (i) Copying Data (ii) Moving Data 

 (iii) Deleting Data (iv) Mixed Reference 

 (v) Worksheet (vi) Work Book 

 (vii) Reference (viii) Cell 

 (ix) Active Cell (x) Cell Pointer 

5. What is drag and drop in Excel worksheet ? 

Answer Key 4.2.14 

 

1. Row Number, Column  Number 2. Cell 3. Cell Pointer 4.Save As 

 

 



UNIT5 
APPLICATION OF COMPUTER IN FINACIAL 

ACC0UNTING: GRAPHS & CHARTS - I 

STRUCTURE 

5.1 Introduction 

5.2 Understanding Financial Graphs  

5.3 Graph and Chart  

5.3.1 Pie chart 

5.3.2Series Chart 

5.3.3 Line and area Chart 

5.3.4 Column Chart 

5.3.5 Bar Chart Variation 

5.4Apply Chart Layout 

5.5 Add Label 

5.6 Change the style of chart 

5.7 Financial Data Visualization Using Graph and Charts 

 

5.1 INTRODUCTION 

 

Accounting software is used to implement a computerized accounting system. The 

computer accounting system is based on the concept of databases. It does away with the 

concept of creating and maintaining journals, ledger, etc. which are essential while working 

with manual accounting system.  A computerized accounting system is an accounting 

information system that processes the financial transactions and events as per Generally 

Accepted Accounting Principles (GAAP) to produce reports as per user requirements. Every 

accounting system, manual or computerized, has two aspects. First, it has to work 

under a set of well-defined concepts called accounting principles. Another, 

that there is a user -defined framework for maintenance of records and 

generation of reports. In a computerized accounting system, the framework 

of storage and processing of data is called operating environment that 

consists of hardware as well as software in which the accounting system, 

works. The type of the accounting system used determines the operating 

environment. Both hardware and software are interdependent. The type of 

software determines the structure of the hardware. Further, the selection of 

hardware is dependent upon various factors such as the number of users, 

level of secrecy and the nature of various activities of functional 



departments in an 

organization. All the interested users of financial statement can easily track 

all accounting reports if it is in connected computers. That is the reason, 

today, all accounting departments make accounts in computer. To better 

understand the financial accounting statement the graphical representation 

of data is used in computers. For this the Excel charts are used for the  graphical 

representations of numeric data. Graphs make it easier for users to compare and understand 

numbers, so charts have become a popular way to present numerical data. Every chart tells a 

story. Stories can be simple: “See how our sales have increased” or complex: “This is how 

our overhead costs relate to the price of our product.” Whether simple or complex, the story 

should be readily understandable. If you can’t immediately understand what a chart means, 

then it isn’t a good chart. Graphs are constructed with data points, which are the individual 

number in a worksheet, and data series, which are the groups of related data points within a 

column or row. 

 

5.2 UNDERSTANDING FINANCIAL GRAPHS 

Financial graphs and charts are visual tools that allow companies to monitor various 

performance metrics in areas such as liquidity, budgets, expenses, cash flow, and others.  By 

doing so, they can successfully manage risks to ensure healthy finances and steady growth. 

To ensure the best possible performance for a company, conducting regular financial 

analytics and ensuring the highest quality of data management must be the top priorities of 

companies no matter the size. If the finance department raises an alarm, everyone must 

carefully listen because it concerns the most crucial information and can lead to serious 

damages if ignored. That's why financial charts need to be created with the utmost care and 

attention. As humans, we respond to, and process the visual data better than anything else. 

When it comes to digesting and taking action upon vital financial metrics and insights, well-

designed finance graphs and charts offer the best solution. With the help of graphs 

 One will be able to track the liquidity, cash flow, budgets, and expenses accurately 

with ease, visually, and automate processes that were oftentimes done manually and 

with higher risks of errors. 

 By setting the right financial KPIs for the business, you will be able to set valuable 

goals that result in growth and success. While there are numerous charts out there, we 

will explain the invaluable ones for any business. 

 You will be able to make sense of all the financial information and metrics as they 

will be split into actionable categories and presented in an intuitive, scan able fashion, 

no matter the metric you need to include and analyse. 

 

 

 

 



 

Financial Graph Dashboard 

 

5.3 Graphs and Charts 

Excel comes with a wide variety of charts capable of graphically representing most standard 

types of data analysis, and even some more exotic numeric interpolations. The type of data 

you are using and presenting determines the type of chart you will plot the data on. This 

chapter discusses some of the most frequently used chart types. Excel has graphs in the 

following categories:  

Pie charts: These work best for displaying how much each part contributes to a total 

value. Pie charts can be exploded for greater visual clarity, or turned into doughnut charts, 

which can represent more than just one set of data. 

Line and area charts: These show data points connected with lines, indicating 

upward or downward trends in value. Area charts show the area below a line filled in. Both 

types can be combined with column charts to show more data. 

Column and bar charts: These compare values across categories, with results 

presented vertically in column charts and horizontally in bar charts, The composition of the 



column or bar can be stacked in more than one color to represent the contribution of each 

portion of a category’s data to the total for that category.  

Special charts: Excel includes a number of charts suitable for presenting scientific 

statistical, and financial data. Scatter charts are used to present experimental results. Surface 

and cone charts are good for presenting 3-D and 2-D changes in data. Radar charts show data 

values in relation to a single metric. Stock charts present values for between three and five 

series of data, including open, high, low, close, and volume trading information.  

5.3.1 Pie Charts 

Use pie charts to show the relationships between pieces of an entity. The implication 

is that the pie includes all or something. The pie chart isn’t appropriate for illustrating some 

of anything, so if there’s not an obvious “all” in the data you’re charting, don’t use a pie.  

 

Fig.  

A pie chart can only include one data series. If you select more than one data, series, 

Excel uses the first series and ignores all others. No error message appears, so you won’t 



necessarily know that the chart doesn’t show the data you intended to include, unless you 

examine the chart carefully.  

When you create a pie chart, Excel totals the data points in the series and then divides 

the value of each data point into the series total to determine how large each data point’s pie 

slice should be. Don’t include a total from the worksheet as a data point; this doubles the total 

Excel calculates, resulting in a pie chart with one large slice (50 percent of the pie). 

5.3.2 Series Charts 

In a series chart, you can chart more than one data series. This lets you compare the 

data points in the series, such as January vs. February, or Reno vs. Phoenix. Series charts are 

open-ended; there is no requirement that the data shown is all the data for a month or year. 

There are several types of series charts. You can give the same set of data a very different 

look by simply changing the chart type.  

5.3.3 Line and Area Charts 

The series chart shown in figure is a line chart. In a 2-D version (as shown) or in a 3-

D version that is sometimes called a ribbon chart. An area chart is a line chart with the area 

below the line filled. Line charts and area charts are typically used to show one or more 

variables (such as sales, income, or price) changing over time. 



 

Fig.  

5.3.4 Column Chart  

Figure shows the same information presented as a bar chart. The bars give added 

substance to the chart. In the line chart, what the reader notices is the trend up or down in 

each line and the gaps between the lines.  

Line and area charts share a common layout. The horizontal line is called the X-axis, 

and the vertical line is the Y-axis (the same x- and y-axis you may have learned about in 

algebra or geometry class when plotting data points). In a bar chart, however, the axis are 

turned 90 degrees so that the x-axis is on the left side. 

Excel can also combine columns with line or area charts and embellish line or column 

charts with 3-D effects. You can make the columns and lines on your charts into tubes, 

pyramids, cones, or cylinders; or transform regular bars into floating 3-D bars. Plotting data 

on two axis is also possible with column charts.  



 

Fig.  

5.3.5 Bar Chart Variations  

Column charts are the same as bar charts, but with the X-axis at the bottom. There are 

three-dimensional varieties of bar and column charts, which add depth to the regular chart. 

Cylinders, cones, and pyramids are variations of a column chart.  



 

Fig.  

Excel also offers another style of bar and column chart–the stacked chart. A stacked 

3-D column chart, using the same data as Figure. In a stacked chart, parallel data points in 

each data series are stacked on top or to the right of each other. Stacking adds another 

dimension to the chart, since it allows the user to compare sales between as well as within 

time periods-like providing a column chart and a pie chart for each time·period.  

The 3-D charts have three axis. In a 3-D column chart, the X-axis is on the bottom. 

The vertical axis is the Z-axis; the Y-axis goes from front to back, providing the “third 

dimension” of depth in the chart. Don’t worry about memorizing which axis is which in each 

chart type; there are ways to know which is which when you’re creating or editing the chart.  

5.4 APPLY A CHART LAYOUT 

Context tabs are tabs that only appear when you need them. Called Chart Tools, there 

are three chart context tabs: Design, Layout, and Format. The tabs become available when 

you create a new chart or when you click on a chart. You can use these tabs to customize 

your chart. 

You can determine what your chart displays by choosing a layout. For example, the 

layout you choose determines whether your chart displays a title, where the title displays, 



whether your chart has a legend, where the legend displays, whether the chart has axis labels 

and so on. Excel provides several layouts from which you can choose. 

Steps to Apply a Chart Layout 

 

Fig 11.5 

1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click the Quick Layout button in the Chart Layout group. A list of chart layouts 

appears. 

4. Click Layout 5. Excel applies the layout to your chart. 

5.5 ADD LABELS 

When you apply a layout, Excel may create areas where you can insert labels. You 

use labels to give your chart a title or to label your axes. When you applied layout 5, Excel 

created label areas for a title and for the vertical axis. 

Steps to add labels 

 

Fig  Before 

 

Fig  After 



1. Select Chart Title. Click on Chart Title and then place your cursor before the C in 

Chart and hold down the Shift key while you use the right arrow key to highlight 

the words Chart Title. 

2. Type Toy Sales. Excel adds your title. 

3. Select Axis Title. Click on Axis Title. Place your cursor before the A in Axis. 

Hold down the Shift key while you use the right arrow key to highlight the words 

Axis Title. 

4. Type Sales. Excel labels the axis. 

5. Click anywhere on the chart to end your entry. 

5.6 CHANGE THE STYLE OF A CHART 

A style is a set of formatting options. You can use a style to change the color and 

format of your chart. Excel 2007 has several predefined styles that you can use. They are 

numbered from left to right, starting with 1, which is located in the upper-left corner. 

Steps to change the Style of a Chart 

 

Fig  

1. Click your chart. The Chart Tools become available. 

2. Choose the Design tab. 

3. Click the More button  in the Chart Styles group. The chart styles appear. 



 

Fig  

4. Click Style 42. Excel applies the style to your chart. 

5.7 Financial Data Visualization Using Graphs and Charts 

In the present scenario business will have the opportunity to explore, monitor, and access 

real-time data, but the interactivity levels are an invaluable resource for managing enormous 

amounts of information, especially in the financial sector where a small mistake can lead to 

millions of damages. That's why interaction with the finance charts and graphs is of utmost 

importance: a single KPI can be viewed in numerous useful ways and angles that static 

presentations could never offer. Finally, we cannot avoid mentioning collaboration as one of 

the top roles of modern financial data visualization tools. As we said before finances are 

arguable the most important aspect of any business, if something is wrong with them most 

likely all your company will suffer. By using dashboard tool  such as data pine you will be 

able to share your financial insights live with the rest of the departments in your company and 

enhance a collaborative, data-driven work methodology that will optimize your business 

performance as a whole. Graph use in financial reports is already a business standard in 

today's environment. When you add up intelligent tools, automation, stunning visuals, and 

interactivity for your data visualization process, your finance department will significantly 

increase productivity, and decrease costs. 



 
Some of the of Financial Accounting Graphs 

 

1. GROSS PROFIT MARGIN GRAPH 

As a key component of our profit & loss dashboard this indicator has been developed in 

the form of a traditional pie-style chart but with a more navigable design. The gross 

profit chart shows the overall revenue minus the cost of goods sold, divided by your total 

sales revenue. 

 

https://www.datapine.com/blog/wp-content/uploads/2017/06/financial-performance-dashboard-datapine.png


 

2. Operating Profit Margin 

 

 



As another profit and loss-centric financial chart, this visual is split into an easy-to-digest 

percentage gauge in addition to a detailed bar chart and will help you to accurately calculate 

your Earnings Before Interest and Tax (EBIT). 

The higher your operating income, the more profitable your business will potentially be, and 

this chart will help this metric from dipping through a mix of historical data and priceless 

real-time insights. 

3. Operating Expense Ratio 

 

 

The operating expense ratio is also strongly related to the profit and loss area of your finance 

department's key activities, and this color-coded health gauge will help you gain access to the 

information you need, even at a quick glance. 

The operating expense ratio (OER) will give you the power to understand the operational 

efficiency of your business by comparing your operating expenses to your overall revenue. 

This is the best visual to show profit and loss, but you do need to connect it with other charts 

to create a proper financial data story. By monitoring this information regularly, you will be 

able to decide whether your venture is scalable and make necessary changes to your 

commercial strategy if you feel it isn't. 

4. Accounts Payable Turnover Ratio 



 

Regarding the smooth and responsible handling of your company's cash management 

activities, the accounts payable turnover ratio is another liquidity calculation that will ensure 

that you are able to pay all of your important expenses within the required deadlines or set 

timeframes. 

The ratio itself changes according to real-time shifts and is displayed in a bold numbered 

format, while historical or chronological information is presented in the form of a column 

graph that showcases turnover percentages, split into different periods of time. A higher ratio 

gives suppliers and creditors the assurance that your business pays its bills frequently and is a 

pivotal metric when negotiating a credit line with a supplier, so it's a chart your company 

cannot afford to live without. 

 

5.8 TEST YOUR UNDERSTANDING (A) 

1.   Which type of chart is used for comparing the values over the category? 

 

……………………………………………………………………………………………… 

 

……………………………………………………………………………………………… 

 

2.  What steps will you take to insert a new chart in MS Excel? 

…………………………………………………………………………………..…………. 

 

……………………………………………………………………………………………… 



5.9 Review Questions 

1. Explain the Role of Excel in Financial Accounting. 

2. What are 2D and 3D Graphs, how they are created? 

3. Explain the following : 

      (a) Line Chart  (b) Bar Chart  (c) Area Chart 

4. What are : 

      (i) Legends  (ii) Data labels  (iii) Gridlines 

5. Explain Pie Charts how they created in Excel? 

6. How graphs are created and printed in Excel?  

 

 



  

 

UNIT: 6  

APPLICATION OF COMPUTER IN FINACIAL 
ACC0UNTING: GRAPHS & CHART – II & III 

STRUCTURE 

6.1 Introduction 

6.2 Pivot Table  

6.2.1 Functions performed on Pivot Table 

6.2.2 Creation of PivotTable 

6.2.2.1 Performing Statistics Measures in Pivot Table 

6.2.2.2 To Create a Pivot Table from Multiple Sheets 

6.3 Pivot Chart 

6.3.1 Pivot Chart Vs Table 

6.3.2 Creation of Pivot Chart 

6.3.2.1 Creation of Pivot Chart from Data Source 

6.3.2.2 Creation of Pivot Chart from Pivot Table 

6.4 Customizing Pivot Chart 

6.5 Recommended Pivot charts 

6.6 Pivot Tool 

6.1 INTRODUCTION 

 To set up financial analyses that are more sophisticated than just looking at transactions. 

One of the ways is by means of a pivot table. A pivot table is the most powerful and 

flexible method of data analysis and synthesis available in Excel. We are often confused 

with a high volume of data that probably has some interesting patterns in it — but there's 

so much detail that it's almost impossible to draw the conclusion. 

6.2 Pivot Table 

A PivotTable is an interactive way to quickly summarize large amounts of data. One can use 

a PivotTable to analyse numerical data in detail, and answer unanticipated questions about 

your data. PivotTable is a table of stats that summarizes the data as sums, averages, and many 

other statistical measures. Let us assume that we got data of any real estate project with 

different fields like type of flats, block names, area of the individual apartments, and their 

other cost per various services, etc. 

A PivotTable is especially designed for: 

 Querying large amounts of data in many user-friendly ways. 



  

 

 Subtotalling and aggregating numeric data, summarizing data by categories and 

subcategories, and creating custom calculations and formulas. 

 Expanding and collapsing levels of data to focus your results, and drilling down to 

details from the summary data for areas of interest to you. 

 Moving rows to columns or columns to rows (or "pivoting") to see different 

summaries of the source data. 

 Filtering, sorting, grouping, and conditionally formatting the most useful and 

interesting subset of data enabling you to focus on just the information you want. 

 Presenting concise, attractive, and annotated online or printed reports. 

6.2.1 Functions performed on the Pivot Table 

After you create a PivotTable by selecting its data source, arranging fields in the PivotTable Field List, 
and choosing an initial layout, you can perform the following tasks as you work with a PivotTable: 

1. Explore the data     

 Expand and collapse data, and show the underlying details that pertain to the values. 

 Sort, filter, and group fields and items. 

 Change summary functions, and add custom calculations and formulas. 

2. Change the form layout and field arrangement      

 Change the PivotTable form: Compact, Outline, or Tabular. 

 Add, rearrange, and remove fields. 

 Change the order of fields or items. 

3. Change the layout of columns, rows, and subtotals      

 Turn column and row field headers on or off, or display or hide blank lines. 

 Display subtotals above or below their rows. 

 Adjust column widths on refresh. 

 Move a column field to the row area or a row field to the column area. 

 Merge or unmerge cells for outer row and column items. 

4. Change the display of blanks and errors      

 Change how errors and empty cells are displayed. 

 Change how items and labels without data are shown. 

 Display or hide blank rows 

5. Change the format    

 Manually and conditionally format cells and ranges. 

 Change the overall PivotTable format style. 

 Change the number format for fields. 

 Include OLAP Server formatting. 



  

 

 

6.2.2 Creating Pivot Table 

You can use data from Excel worksheet as the basis for a PivotTable or PivotChart. The data 

should be in list format, with column labels in the first row, which Excel will use for Field 

Names. Each cell in subsequent rows should contain data appropriate to its column heading, 

and you shouldn't mix data types in the same column. For instance, you shouldn't mix 

currency values and dates in the same column. Additionally, there shouldn't be any blank 

rows or columns within the data range. 

Excel tables    Excel tables are already in list format and are good candidates for PivotTable 

source data. When you refresh the PivotTable, new and updated data from the Excel table is 

automatically included in the refresh operation. 

Using a dynamic named range   To make a PivotTable easier to update, you can create a 

dynamic named range and use that name as the PitTable's data source. If the named range 

expands to include more data, refreshing the PivotTable will include the new data. 

Including totals    Excel automatically creates subtotals and grand totals in a PivotTable. If 

the source data contains automatic subtotals and grand totals that you created by using the 

Subtotals command in the Outline group on the Data tab, use that same command to remove 

the subtotals and grand totals before you create the PivotTable. 

 

For example, here's a simple list of household expenses on the left, and a PivotTable based on 

the list to the right: 

Household expense data  Corresponding PivotTable  

 

 

 

 



  

 

 After you create a PivotTable by selecting its data source, arranging fields in the PivotTable  

Below is the raw data for the PivotTable. 

 

 

 6.2.2.1 Performing Statistics Measures in Pivot Table 

1.SUM: 

In the Excel Pivot Table Example, we should perform the sum of the final product value to 

extract the value of different blocks got as below: 

Drag the ―Block Name‖ to ―Rows‖ and ―Sum of Final Product Value‖ to ―Values‖ Fields. 



  

 

 

It shows that we have the ―Cheeku‖ block with 293 million, ―Donald‖ block with 212 

million, ―Mickey‖ block with 324 million, ―Rainbow‖ block with 466 million, and 

―Strawberry‖ with 355 million. This table shows us that the ―Rainbow‖ block got a higher 

value than the other blocks. 

 2. COUNT: 

Let us count the number of flats for different blocks by changing the value field settings in 

Excel PivotTable to count as below: 



  

 

Then, click on ―Value Field Settings.‖ 

 

A dialog box appears. Select ―Count‖ from ―Summarize value field by.‖ 



  

 

 

Then the PivotTable looks like as given below: 



  

 

 

From the above tables, we can see how to change the field settings to count. Here, we can 

note that we got the highest number of flats in the ―Rainbow‖ block and ―Strawberry‖ block 

compared to other blocks. In total, we got 79 flats in this project. 

3. AVERAGE:  

In the PivotTable practice exercise example, we will find out the average price of the flat in 

each block by changing the value field settings from ―Count‖ to ―Average.‖ 



  

 

 

Then, PivotTable changes from ―Count‖ to ―Average,‖ as given below: 

 



  

 

From the above PivotTable example, we can see that we got the average flat price in each 

block. The ―Donald‖ block got the highest average flat price among other blocks. 

Similarly, we can perform other statistical measures like Max, Min, Product, Standard 

deviation, etc. by changing the value field settings in this PivotTable example 

 6.2.2.2 To Create a Pivot Table from Multiple Sheets 

Implementing PivotTables from multiple worksheets has some different processes. This 

process can also be done in different ways. The following are the other methods to create a 

PivotTable from multiple sheets in Excel. 

Procedure: 

In this method, there should be a common row in both tables. It will act as the primary key 

for the first table and the foreign key for the second table. 

Suppose we are using  Sheet 4 and Sheet 5 to create a PivotTable from multiple sheets in 

Excel. 

 Step 1: In sheets 3 and 4, select the table, click ―CTRL + T‖ to select the whole data, 

and draw a table for complete data. Now, it will insert a table in the data. The name 

will be displayed on the table in the left corner. This process can be done for all the 

tables containing the data. 

 

It will add filters in default. If we do not need them, we can turn them off by clicking the 

―CTRL+SHIFT+L‖ shortcut from a keyboard or going to the ―Data― tab and clicking on the 

―Filters‖ option. Then the filters will be disabled. 

These are the steps to be followed to create a PivotTable for the following data. 



  

 

 Step 1: Click on the ―Insert‖ tab and ―PivotTable.‖ A dialog box will appear now, and 

you will be asked whether we should create the PivotTable in a new or the same 

sheet. 

 

It is good to use a new sheet option in excel. 

 Step 2: Lastly, check the box ―Add this data to the Data Model.‖ It is an important 

step in this PivotTable creation process. 



  

 

 

 Step 3: A PivotTable will be created now in the new worksheet. On the right side, we 

may have all the fields related to the PivotTable. 

 

 Step 4: Go to the ―Analyze‖  tab -> Relationships -> New. 



  

 

 

 Step 5: The table is the current table. The related table is the table to be added to the 

PivotTable. The corresponding column is the same in both tables. It is from the first 

table, also called the primary key. A column is the same in the second column, called 

a foreign key. 

 

 Step 6: Now, click on the ok. 



  

 

 

 Step 7: Now, we can select the required fields per the requirement. We can choose 

the fields from all the tables in the PivotTables. For that, it will first ask to create a 

new PivotTable. 

 

 Step 8: Click “Yes.” We can select fields from all the tables to create a PivotTable. 



  

 

 

6.3 PIVOT CHART 

A pivot chart in Excel is a visual representation of the data. It gives you the big picture of 

your raw data. It allows you to analyse data using various types of graphs and layouts. It is 

considered to be the best chart during a business presentation that involves huge data. 

1. Pivot Chart Vs Table 

Pivot Table provides us a way to summarize large data in a grid-like matrix. You can choose 

the fields you wish to use in the table for rows and columns.  

Pivot chart provides us with a graphical representation of the pivot table. You can choose 

from multiple layouts and chart types.This chart also summarizes the data.  

You can create both a pivot table and chart for a data source and handle them simultaneously. 

That means the changes made in the pivot table will reflect in the chart and vice versa. 

After you create a PivotTable by selecting its data source, arranging fields in the PivotTable Field List, 
and choosing an initial layout, you can perform the following tasks as you work with a PivotTable: 

2 Difference between Pivot Chart and Standard Chart 

If you are familiar with standard charts, you will find that most operations are the same in 

Pivot Charts. However, there are some differences: 

Row/Column Orientation Unlike a standard chart, you cannot switch the row/column 

orientation of a PivotChart by using the Select Data Source dialog box. Instead, you can 

pivot the Row and Column labels of the associated PivotTable to achieve the same effect. 

Chart Types You can change a PivotChart to any chart type except an xy (scatter), stock, or 

bubble chart. 

Source data     Standard charts are linked directly to worksheet cells, while PivotCharts are 

based on their associated PivotTable's data source. Unlike a standard chart, you cannot 

change the chart data range in a PivotChart's Select Data Source dialog box. 



  

 

Formatting     Most formatting—including chart elements that you add, layout, and style—is 

preserved when you refresh a PivotChart. However, trend lines, data labels, error bars, and 

other changes to data sets are not preserved. Standard charts do not lose this formatting once 

it is applied. 

Although you cannot directly resize the data labels in a PivotChart, you can increase the text 

font size to effectively resize the labels. 

Data source 

Given below is the data source sample that will be used to understand the Pivot chart.  

Order ID Order Date Product Name Region City Quantity Total Price 

1 03-01-2020 Plain Cookies North New York 33 444.66 

2 04-02-2012 Sugar Cookies South Lima 432 346.33 

3 05-04-2018 Wafers East Boston 33 32.54 

4 06-05-2019 Chocolate West Oak Land 245 543.43 

5 07-07-2020 Ice-Cream North Chicago 324 223.56 

7 09-09-2020 Plain Cookies East Washington 32 34.4 

8 10-11-2020 Sugar Cookies West Seattle 12 56.54 

9 11-12-2017 Wafers North Toronto 323 878.54 

10 12-14-2020 Chocolate South Lima 232 864.74 

11 01-15-2020 Ice-Cream East Boston 445 457.54 

13 03-18-2018 Salt Cookies North New York 5454 34546 

14 04-18-2017 Cheese Cookies South Lima 5653 3456.34 

6.3.2 Creation of Pivot Chart 

There are 2 ways to make a pivot chart in Excel. 

6.3.2.1 Pivot Chart From Data Source 

We can create a chart directly from the datasheet without a pivot table. 

To achieve this follow the below steps. 



  

 

1) Select any cell in the table. 

2) Go to Insert -> Pivot Chart 

 

3) You can choose to create a new sheet or mention the table range you want to place the 

chart under Existing Worksheet. 

 

4) Click OK 

This will create a blank pivot chart and its related pivot table. You can add the desired fields 

to generate a report and chart. 
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6.3.2.2 Creation of Pivot Chart From Pivot Table 

If you have already created a pivot table, you can use the same to generate a pivot chart. We 

have created a sample PivotTable as shown below. 
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 Steps to create a chart. 

1) Select any cell in PivotTable. 

2) Go to Insert-> Pivot chart 

3) It will give you a list of available charts, select the desired chart. 

 

4) Click ok. 

This will generate a chart with data taken from the pivot table. The pivot chart example is 

shown below. 
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6.4 Customizing the Chart 

You can customize the chart using the + and the paint icon present at the right of the chart. 

+ Button – It helps you to add or remove chart elements like titles, gridlines, legends, etc and 

decide their positions. 

 

You can add the title of the chart, mention Axis titles, etc. We have added the chart title and 

Axis title as an example. 

 

Style of the Chart – You can change the chart style and color by clicking on the paintbrush 

icon. 
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You can also change the color of the chart as you desire from the color section. 
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6.5 Recommended Charts 

Excel gives us Recommended Pivot charts that allow us to quickly choose the type of 

PivotChart that meets your business requirements. 

1) Select the data source table. 

2) Go to Insert -> Recommended Charts. 

 

3) Click the Recommended Charts. 

4) Click on the chart you need. 

5) Click OK 
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The resulting pivot table and chart will be created in a new sheet and you can further 

customize them as needed. 

Pivot Chart Fields 

It has 4 fields as shown below. 

1. Filters: Fields under this gives us the ability to add report filters. 

2. Legends (Series): Fields under this represent the Column headers in the pivot table. 

3. Axis (Categories): This represents the Rows in the Pivot Table. These fields are shown in 

the Axis Bar on the chart. 

4. Values: Used to show the summarized numeric values. 
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6.6 Pivot Charts Tools 

Analyze: There are various options available to make the chart more user-friendly. 

 

Chart Name: It is the name of the chart. It is used in writing VBA code and is also in the 

selection pane. It is available in Excel 2010 and later. 

Options: PivotTable Options dialog box will be displayed where you can set Layout & 

Format, set to show/hide grand total, setting sort options, display options, etc. 

Active Field: You can change the column name on the table. For example, Grand Total to 

Final amount, etc., and the same will get updated in the Table and Chart. 

Expand Field: This is used to automatically expand all the values. 

If you have multiple fields like Years, Quarters, and Date then instead of expanding 

individually, you can click on the Expand Field. 

Collapse Field: This is opposite the Expand Field. This will collapse the expanded fields and 

present a compact chart. 
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Expand Example 

 

 

 

Collapse Example 
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Note: Suppose you have only one field in Rows, then by clicking on the Expand Field, you 

give a dialog with all the fields and you can select the desired field. The selected field will be 

added to the Rows section and the Chart will be updated automatically. 

Insert Slicer 

You can insert a slicer into the chart just like the pivot table. 

To integrate the slicer with a chart follow the below steps. 

1. Click on the pivot chart. 

2. Go to the Analyze tab -> Insert Slicer. 

3. In the dialog Select fields, you need to create the slicers. 

4. Click OK 

This will insert the slicer box as shown below. We have seen how to use slicer in our 

previous tutorial. 
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Insert Timeline 

You can insert a Timeline into the chart just like a pivot table. 

To integrate Timeline with the chart follow the below steps. 

1. Click on the pivot chart. 

2. Go to the Analyze tab -> Insert Timeline. 

3. Select the required Date field. 

4. Click OK 

This will insert the timeline as shown below. We saw how to use the timeline in our previous 

tutorial. 
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The result based on the timeline is updated on both the Pivot table as well as the chart. 

Filter Connection 

You can link the slicer or timeline to multiple pivot charts. For example, we have created 2 

Pivot tables and 1 Slicer. You apply the slicer to both charts. 

1. Click on the pivot chart to which the slicer is not currently connected. 

2. Go to Analyze -> Filter Connection 

3. Select the Slicer you want to connect. 

4. Click Ok 
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Now you can handle both charts with a single slicer. 

Calculations 

If you want to add any custom formulas, you can do so using the calculation field. 

Example: 

1) Select the Pivot chart you want to add the custom formulas to. 

2) Go to Analyze -> Fields ->Items -> Sets 

3) Select Calculated Fields. 

 

4) In the Name, enter the name you wish. 

5) In Formula, Add your custom formula. If you are giving a 10% discount on the total sum, 

then you can add a formula as shown below. 
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6) The pivot table, pivot fields, and chart will be updated accordingly. 

 

Refresh 

Whenever you change the values in the data source, click anywhere on the pivot chart and 

Right-click and select Refresh or go to Analyze -> Refresh. Refreshing a pivot table also will 

refresh the chart. 
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Change Data Source 

Whenever you add more rows to the data source, the chart won’t take the added rows, as we 

have defined the range while creating the chart. 

To include the new rows: 

1. Click anywhere on the Pivot Chart. 

2. Go to Analyze -> Change Data Source 

3. Change PivotTable Data Source dialog will appear and you can enter the new data 

range. 

4. Click Ok 

Make sure that you do the above steps for all the charts individually. 

Clear 

Using Clear, you can clear the entire Pivot Chart. It will be an empty Chart and a Table. 

1. Click on the Pivot Chart 

2. Analyze -> Clear -> Clear All 

You can also clear all the applied filters by Analyze -> Clear-> Clear Filters 

Move Chart 

After creating a chart, you can move it to the desired location. 

Follow the below steps: 

1. Click on the pivot chart. 

2. Go to Analyze -> Move Chart 

3. Select the desired option from the dialog: 

o New Sheet: The sheet will be automatically created and the chart will be 

displayed. 

o Object in: You can select among the available sheets and the chart will be 

moved to the selected sheet. 
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Field List: You can show/hide the PivotChart Fields pane. 

Field Buttons: You can show/hide the Legend Field, Axis Field, Value Field, Report filter, 

etc. on the chart. 

 

Design 

There are several options available to design the chart under this tab. 

Add Chart Element: This gives us the same options as we got when we clicked on the + 

button next to the pivot chart. They help us to add elements to the chart like title, error bard, 

etc. 

 

Quick Layout: You can change the default layout and select among the predefined layout 

available. For example, we have moved the Region layout to the Top instead of the right 

side. 
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Change Colors: Select the different colors for your chart. 
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Chart Style: Choose the Style for your chart from these available charts. 

 

Switch Row/Column: You can easily switch Rows and Columns with just one click and the 

pivot table and chart will be updated automatically. 

Before Switching Row/Column 
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After Switching Row/Column 
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Select Data: Suppose you have spent a lot of time formatting a pivot chart according to your 

company standards and all your charts should be in the same format. Then this option comes 

in handy. You can’t directly copy the pivot chart and change the data source. There are a 

couple of steps to be conducted. 

1) Select the desired pivot chart and copy the chart area. 

2) Open a new workbook. File -> New Workbook 

3) Paste the copied chart. You can notice in the Menu bar that it says Chart Tools and not 

PivotChart Tools. 

4) Now select the Chart area and hit the Cut option. 

5) Go to the workbook where you want to use this chart. 

6) Note: You should already have a pivot table created. 

7) Paste the chart from step 4. 
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8) Go to Design present under Chart Tools. Click on Select Data Tab. 

 

9) Click on any cell in the pivot table. 

Pivot Chart will be created with the data present in the new pivot table, but the format 

remains the same as previously. You can modify the Axis and Legend as needed for the new 

table. 

The resulting chart for the new pivot table is shown below. 
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Change Chart Type: You can change the default column chart type to the desired type as 

shown below. 

 

The chart will update automatically based on the selection. 

Pie Chart 
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Bar Chart 

 

Format 

These are basically used to custom format the text present inside the chart. 

Current Selection: This will show all the elements present in the table and you can select the 

one in which you want to change the format style. For example, We will select Chart Title 

and change its style. 

1) Select Chart Title from the drop-down. 
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2) Click on Format Selection. 

 

3) Format Chart Title will Open on the right pane. 

4) Choose the color, style, border, etc as you desire. 

After a few basic formatting, a Chart Title will look as below. 
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Reset to Match Style: This will reset all the changes and give the default style. 

Insert Shapes: You can insert shapes like lines, arrows, and also a text box for a better 

explanation. 

 

Shape Style: You can select different styles for the plot area. Select the area you want to 

change the style and click on the style. 

 

After applying the styles to the entire chart, the Column and Rows are shown below. 
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Arrange: If there are multiple pivot charts and they are overlapping on one another on these 

options. 

 

Bring Forward 

 Select the chart you want to bring in front. 
 Click on Bring Forward option to bring the chart one step forward. 

Bring To Front: This option will bring your chart above all the other charts. 

Send Backward 

 Select the chart you want to send back. 
 Click on the send backward option to send the chart one level back. 

Send to Back: This is used to send the selected chart back to all the other charts. 

Selection Pane 

You can decide the visibility of the chart using the selection pane. This page shows you all 

the charts and slicer available and you can click on the eye icon to decide whether that 

particular item should be visible on the worksheet or not. 

https://www.softwaretestinghelp.com/wp-content/qa/uploads/2020/12/shapestyle-1.png
https://www.softwaretestinghelp.com/wp-content/qa/uploads/2020/12/arrange.png
https://www.softwaretestinghelp.com/wp-content/qa/uploads/2020/12/shapestyle-1.png
https://www.softwaretestinghelp.com/wp-content/qa/uploads/2020/12/arrange.png
https://www.softwaretestinghelp.com/wp-content/qa/uploads/2020/12/shapestyle-1.png
https://www.softwaretestinghelp.com/wp-content/qa/uploads/2020/12/arrange.png
https://www.softwaretestinghelp.com/wp-content/qa/uploads/2020/12/shapestyle-1.png
https://www.softwaretestinghelp.com/wp-content/qa/uploads/2020/12/arrange.png


  

 

 

Size: This is used to customize the pivot chart height, width, scale height, scale width, etc. 

 

 

6.7 Let us Sum Up 

 

 A pivot table is the most powerful and flexible method of data analysis and synthesis 

available in Excel. 

 PivotTable is a table that summarizes the data as sums, averages, and many other 

statistical measures. 

 Expanding and collapsing levels of data to focus your results, and drilling down to details 

from the summary data for areas of interest to you. 

 A pivot chart in Excel is a visual representation of the data. It gives you the big picture of 

your raw data. 

 Pivot Table provides us a way to summarize large data in a grid-like matrix. 
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 Expand and collapse data show the underlying details that pertain to the values. 

6.8 Review Questions 

 

1. Distinguish between Pivot Chart And Standard Chart. 

2. What is the purpose of data source in Creating Pivot Chart? 

3. Define Pivot Table. List the advantages of it. 

4. What are the different types of Pivot chart? 

5. How the pivot chart can be created using Pivot Table? 

6. Give various features of Pivot Chart. 

7. What are the different functions performed on the Pivot Table? 

8. How do you provide Dynamic Range in 'Data Source' of Pivot Tables? 

9. Which option is used to add column(s) in Pivot Tables to compute the values in run-

time? 

10. Is it possible to make Pivot Table using multiple sources of data? 
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UNIT 7: APPLICATIONS OF MIS: MARKETTING FINANCIAL PRODUCTION 

PERSONNEL 

 

7.1.ROLE OF MIS IN GLOBAL BUSINESS 

MIS plays a crucial role in almost all kinds of organizations irrespective of their size and 

nature of business. MIS has evolved from traditional electronic data processing (EDP) 

systems to highly integrated information systems (enterprise information systems like ERP, 

CRM, SCM). Many advances in IS/IT have led to a fundamental shift in the role of 

information systems. As already been mentioned, information systems play three vital roles 

for a business organization today. They support the business processes of an organization, 

decision-making by managers, and the strategies of an organization for gaining a competitive 

advantage. 

MIS has changed the way organizations do business and has increased their efficiencies and 

responsiveness. Today, Internet-based and web-enabled systems and global e-business and e-

commerce systems are becoming quite common in the operation and management of a 

business organization. The Information systems have played a major role in automating 

business transactions, and streamlining routine operations and have also helped organizations 

to make quick and well-informed decisions and thus enabling the organizations to have better 

intimacy with customers and suppliers. In view of the role, integrated MIS can play; 

organizations are implementing these systems to replace their old or legacy systems. 

Let us try to understand the role of MIS in impacting the business globally. 

7.1.1 Integration of functional areas 

Integrated information systems play a very important role in integrating the various 

functional areas of a business organization. Because highly integrated information systems 

like ERP are designed on the premise of a common database and a common interface for all 

the functional areas and thus have the ability to automatically update data among related 

functions or activities. For example, when a customer places an order and the order is entered 

into the system (either online or offline), it triggers many actions across various departments 

or functional areas like inventory management; production planning; finance; marketing, and 

so on. The invoices are generated, the production schedule is planned, the inventory status is 

verified; the items, if not available in the stock, are ordered; and the customer is informed 

about the likely date of the delivery of the ordered item. All these actions are taken 

automatically and data updation happens instantaneously. This role of ERP in integrating 

various functional areas leads to improved responsiveness across the organization, and thus 

enables better decision-making and problem-solving in organizations. This, in turn, leads to 

reduced lead time (the elapsed time between placing an order and receiving it); reduced cycle 

time (the time between placing an order and delivery of the product); efficient use of 

resources; on time delivery of products; transparency; and overall customer satisfaction. 

7.1.2 Reengineering of business processes 



Highly integrated information systems like ERP Systems are process-oriented and one of the 

prerequisites for the implementation of ERP systems is business process re-engineering 

(BPR). Thus, ERP Systems force organizations to re-engineer or redesign their obsolete 

function-oriented business processes. To implement ERP systems, organizations have to 

either adopt ERP-based processes or modify ERP systems so as to match their existing 

business processes. Since ERP systems are designed and developed on the basis of the best 

practices of the industry, it is generally recommended to adopt ERP processes. 

7.1.3 Standardization of systems and procedures 

Highly integrated information systems, which are based on an integrated approach, enable an 

organization to follow standardized systems and procedures across the organizational units. 

This brings about consistency in the entire organization. This becomes all the more important 

for the organizations, which have either acquired other companies or got merged with some 

other company. ERP ensures that the new company after the acquisition or merger uses the 

same information systems throughout and follows similar procedures. 

7.1.4 Networked Business 

The integration of highly integrated information systems nowadays is extended beyond the 

boundaries of an organization leading to networking with the business partners of the 

organization like Supply Chain Management (SCM) systems; Customer Relationship 

Management (CRM) systems, etc. This network with the partners of the organization enables 

it to exchange electronically various business documents like purchase orders, sales orders, 

invoices, billing, etc. (Goyal, 2014) 

 

7.2. MIS: ORGANISATION EFFECTIVENESS 

Management Information System (MIS) should be designed to view the organization as 

discussed earlier. MIS design should give due weightage to the human side of the 

organization and its culture. The task and technology are the physical aspects of the 

organization which can be ascertained very easily. But culture and people are very difficult to 

assess from the design point of view. The structure of the five subsystems should be 

considered while designing the MIS. MIS design should give reports in line with the 

organization’s structure. This means that the main decision-makers and the power centers 

must be recognized in the MIS. Let us discuss these aspects of the organization structure and 

their implications. 

In a tall hierarchy with a high degree of centralization, the MIS should give control 

information to the higher management where decision-making is concentrated. If the system 

is structured on a functional basis where the functional head is a key decision-maker and all 

the functions have equally important roles to play, then the MIS will have a functional design 

with the information support to the functional head. Further, in such a set-up, an integrated 

MIS would be necessary, reporting the corporate status of the business to the top 

management. 



If the organization works on a standardized system where rules, policies, systems, and 

procedures have been laid down, then these become part of the MIS. The processing routines 

in the MIS incorporate these features as an integral part. This is safe as it has already been 

approved by the management of the organization. Along with the information, if the decision-

making responsibilities are also clearly defined and allocated, then the MIS can produce 

information reports by processing the data and summarising the results in line with the 

decision-makers position in the structure. 

If the basic model of the organisation is modified as a product or a project organisation 

system, then the MIS should focus on the management of product or project where the 

concerned manager has a composite responsibility of planning and control of the multiple 

functions Management Information Systems in a Digital Firm. 

Besides these functions, he has to know the status of the other support functions. The 

information should be such that it highlights the trouble spots and shows the interconnection 

with the other functions. It must summarise all information relating to the span of control of 

the product or project manager. The MIS should be able to cater to the view of the product or 

the project manager and also of the top management 

If the organisation’s culture provides sufficient incentive for reticence and results, the MIS 

should support this culture by providing information that will aid the promotion of efficiency. 

If the culture encourages delegation of power and authority, then the MIS should incorporate 

the decision maxing rules in the system.  

The organization system is an open system and MIS should be so designed that it highlights 

the critical business, operational, technological, and environmental changes to the concerned 

level in the organisation, so that action can be taken to correct the situation. The principle of 

the feed-forward control should be extensively used as a design feature to provide a prior 

warning to the decision-maker. 

Since the organization system has a dynamic role to play to meet the changing needs of a 

business, the MIS becomes a common support system for playing the dynamic role. When the 

organisation is moving through the business phases of introduction, growth, maturity, and 

decline, MIS should provide information support, relevant to that phase of the business cycle. 

This means the designer of MIS should foresee such requirements and make the design 

flexible enough to support such requirements 

Organizational learning helps to tone up the behavior of the organization. The MIS should 

support the learning mechanism by identifying the cause and effect in a given situation. It 

should keep the records of action and provide help to analyze the best action in a given 

situation. It should help to build various decision models for use by the managers. The 

information support should be such that the group of enterprising managers should be able to 

improve their capabilities to perform better. 

The design of the MIS, in isolation from organizational factors, is destined to fail as it just 

does not fit into the structure. Since organization systems in the same business differ for 

various reasons such as the leadership style, the management style, culture and group of 



people as a body, and so on, it is difficult to evolve a standard model of the MIS for a 

business and /or an industry. 

MIS plays a very important role in creating organizational behavior which in turn sets the 

goals for achievement. Technology and people decide the organization’s structure and style 

of management, Figure explains the impact and relationship of MIS on the organisation.  

 

7.3. BENEFITS OF MANAGEMENT INFORMATION SYSTEM 

 Aid in Decision Making - MIS can generate synthesized and processed information 

from computerized/ automated and certain manual systems. Information distribution 

to all levels of corporate managers, professionals, and key executives becomes quite 

seamless with streamlined MIS. Managers are able to make quick, timely, and 

informed decisions. Top management and board members can take strategic 

decisions, and plan future growth and business expansion activities based on the data 

and information generated by MIS. 

 Better Planning and Control - MIS is designed and managed in such a way that it 

aggregates information, monitors the company's activities and operations and 

enhances communication and collaboration among employees. This ensures better 

planning for all activities and better ways to measure performance, manage resources 

and facilitate compliance with industry and government regulations. Control helps in 

forecasting, preparing accurate budgets and providing the tools and vital information 

to employees, top management and business partners. 

 Core Competencies - MIS provide the tools necessary to gain a better understanding 

of the market as well as a better understanding of the enterprise itself. Every market 

leading enterprise will have at least one core competency - that is, "a function they 

perform better than their competition". By building an exceptional management 

information system into the enterprise it is possible to push out ahead of the 

competition. 

 Quick Reflexes - As a corollary to improved supply chain management comes an 

improved ability to react to changes in the market. Better MIS enables an enterprise to 

react more quickly to their environment, enabling them to push out ahead of the 

competition and produce a better service and a larger piece of the pie. 

 Enhance Supply Chain Management - Improved reporting of business processes 

lead inevitably to a more streamlined production process. With better information on 

the production process, comes the ability to improve the management of the supply 

chain, including everything from the sourcing of materials to the manufacturing and 

distribution of the finished product. 

 

7.4. MANAGEMENT INFORMATION SYSTEM FOR A DIGITAL FIRM 

Twenty-first-century organizations are E-Enterprises, that run their major operations on the 

Internet/WEB and WAN, spread over a large area. 



The term 'E-Business enterprise' was coined to convey the use of the Internet and IT in key 

resource management processes and to transact business with customers, suppliers, and 

business partners. ERP, SCM, CRM, PLM, and homegrown legacy systems are the main 

applications in the business. The application of the Internet and information technology is in 

key core areas of business. These technologies are used for computing, collaboration, 

communication, and storage of information in all kinds of formats. These applications 

however did not integrate the entire cycle of business starting from Customer to finishing at 

Customer: Customer Ordering to Delivery to Customer Service'. 

 

Figure- Organizational Behaviour and Management Information System 

With the advancement of the Internet, Web communication and network and Information 

technology, business process management crossed the boundaries of the organization and 

embraced every aspect of the business making all its operations 'Digital'. That is capturing the 

data or event, validating, processing, decision making, storing, and delivering. The extent of 

use of these technologies is so much across the boundaries of the organisation that E-

Business enterprise has become completely digitalized all its operations, and hence is now 

called as a "Digital Firm".  

Digital describes electronic technology that generates, captures, validates and stores, and 

processes data in terms of two states: positive and non-positive, Positive is expressed or 

represented by the number 1 and non-positive by the number 0. Digital firms use extensively 



computing, convergence, and content management technologies on internet platform for all 

business processes, transactional and relational. Digital firms rely heavily on Internet and 

Information technology to conduct the E- business operations. The complete change over to 

digital platform makes organisation and its activities more flexible, profitable, competitive 

and efficient than traditional people, paper and process driven organisation. 

Going digital has a clear strategic advantage for the firm and its stakeholders. Supply chain 

management systems, customer relationship management systems, enterprise management 

established infrastructure such as branch office, zonal office. Allow people to work from 

anywhere. Automate processes after reengineering to cut down process cycle time 

Another challenge is to convert domestic process design to work for international processes, 

where integration of multinational information systems using different communication 

standards, country-specific accounting practices, and laws of security are to have adhered to 

strictly. 

Internet and networking technology have thrown another challenge to enlarge the scope of an 

organization where customers and vendors become part of the organization. This technology 

offers a solution to communicate, coordinate, and collaborate with customers, vendors, and 

business partners. This is just not a technical change in business operations but a cultural 

change in the mindset of managers and workers to look beyond the conventional 

organization. It means changing the organization’s behavior to take competitive advantage of 

Digital technology. 

The last but not least important, is the challenge to organise and implement information 

architecture and information technology platforms, considering multiple locations and 

multiple information needs arising due to global operations or the business into a 

comprehensive MIS. 

 

7.5. APPLICATION OF MANAGEMENT INFORMATION SYSTEM 

With computers being as omnipresent as they are today, there's hardly any organization that 

does not rely on the IT systems. 

 Strategic Support - Computers cannot create business strategies by themselves. They 

can assist management in understanding the effects of their strategies, and help enable 

effective decision-making. MIS provides a valuable function; they can collate into 

coherent reports unmanageable volumes of data that would otherwise be broadly 

useless to decision-makers. By studying these reports decision-makers can identify 

patterns and trends that would have remained unseen if the raw data were consulted 

manually. MIS can provide financial statements and performance reports to assist in 

the planning, monitoring, and implementation of the strategy. 

MIS can also use these raw data to run simulations - hypothetical scenarios that 

answer a range of what-if questions regarding alterations in strategy. For instance, 

MIS can provide predictions about the effect on sales that an alteration in price would 

have on a product. These Decision Support Systems (DSS) enable more informed 

decision-making within an enterprise than would be possible without MIS systems. 



 Management by Objectives - MIS is extremely useful in generating statistical 

reports and data analysis they can also be of use as a Management by Objectives 

(MBO) tool. MB is a management process by which managers and subordinates agree 

upon a series of objectives for the subordinate to attempt to achieve within a set time 

frame. Objectives are set using the SMART ratio, that is, objectives should be 

Specific, Measurable, Agreed, Realistic and Time-Specific. 

The aim of these objectives is to provide a set of key performance indicators by which 

an enterprise can judge the performance of an employee or project. The success of 

any MB objective depends upon the continuous tracking of progress. In tracking this 

performance, it can be extremely useful to make use of the MIS. Since all SMART 

objectives are by definition measurable, they can be tracked through the generation of 

management reports to be analyzed by decision-makers. 

 Data Processing - Not only do MIS allow for the collation of vast amounts of 

business data, but they also provide a valuable time-saving benefit to the workforce. 

Where in the past business information had to be manually processed for filing and 

analysis it can now be entered quickly and easily onto a computer by a data processor, 

allowing for faster decision making and quicker reflexes for the enterprise as a whole. 

 

7.6. APPLICATIONS IN THE MANUFACTURING SECTOR 

This is an introduction to the business applications of Management Information systems. It 

gives an overview of the application and does not give small details which may be specific to 

a typical organization. The approach to the application development is on the basis of 

database and not the conventional file system. The MIS model of an application considers 

transaction processing as a basis. The online transaction processing system develops data for 

DBMS and the application development is based on such a database. The model of the 

information processing system is given in the Figure. 

 Model of Information Processing System 

 



For each application, inputs, are processed by online transaction processing (OLTP), and 

systems are determined. The system designer develops the applications with the objective of 

accounting for the transaction-based results and providing reports on the same. The second 

objective is to provide a Query system for assessment of the status of record, result, or 

document. The system provides an on-the-spot screen display showing a status, such as the 

stock of an item, the balance of an account, the position of the purchase order, and so on. The 

third objective is to provide a system of analysis of processed data revealing certain business 

trends or results. It is supposed to give a certain analytical assessment of the event which will 

throw light on the validity of decisions, policies, and rules. It is also supposed to provide 

certain guidelines and norms for strategic and tactical planning. 

The analytical information provides support for decision-making in the Decision Support 

System (DSS). The analysis system provides funds of information at all levels for planning 

and execution of business operations. The fourth objective is to provide control information 

to ensure that the business runs as per the plan, progresses in a set direction, and achieves the 

goals.  

The control information is generated by using the standards, norms, targets, and bud, The 

actual results are compared with these entities, and exceptions are highlighted. Whenever 

possible, the information is provided on the basis of feed-forward control, i.e., providing an 

early signal of probable adverse conditions or results. The designer of business applications 

focuses the development on the aspect of accounting, querying, analysis and control. 

The report generation is decided on the basis of certain business information needs. These 

needs are statutory compliance, Knowledge update, operation management, decision analysis, 

control, and action. The reports are designed for screen display or for print. The contents of 

the reports are decided as per users of the information. The frequency, duration and coverage 

of the report are decided as per the user requirements.  

A typical information system begins with OLTP System, uses RDBMS for the creation of 

Database, 4 GL for application development, and SQL for querying and report generation. It 

uses a program for complex data processing and report generation. It uses business models, 

accounting, and commercial principles for processing the information leading to business 

results. The information system is designed on the principle of open system design, providing 

flexibility and friendliness to the users of the system. 

A typical information system primarily serves the needs at function levels such as Personnel, 

Finance, Production, Materials, Marketing, and Corporate Business Management. These 

systems when integrated provide cross-functional information to management high- lighting 

the business implications of the decisions taken in one area of the business or the other. 

Integrated systems provide data and information for business planning at the middle 

management level and for strategic planning at the top management level. 

 

7.7. INFORMATION SYSTEM AND COMPETITIVE ADVANTAGE 

A business organization generally operates in a competitive environment and thus has 

competitors (rivals) in the industry, in which it operates. In order to survive, grow, and to 



become an industry leader, an organization has to make strategies or in other words, has to 

align itself with its environment. Information Systems support the strategies of an 

organization and thus help an organization in achieving competitive advantage. However, 

until recently, information systems played only a limited role. It is in the last three decades 

that there has been a revolutionary change in the use of information and information systems 

in organizations. Today, a large majority of organizations use information and information 

systems not merely for operational efficiency; rather as a strategic resource for gaining 

competitive advantage. The latest advancements in information technology such as the 

Internet and telecommunication technology further enhanced the capabilities and strategic 

capabilities of information systems. Nowadays, many organizations, especially the service 

industry such as Banking, Airlines, Retail, etc. use information systems extensively and on 

real-time basis and thus cannot afford these systems down even for a few minutes. Such 

systems help organizations to meet the needs of competitive necessity and also to gain 

competitive advantage. The growing use of information systems may largely be attributed to 

the changing concept of the role of information in organizations. The concept of Information 

has evolved from a necessary evil in the past to that of a strategic resource of today. Let us 

understand the evolving role of information so as to understand its relevance in today's 

organizations. 

 

7.8. CHANGING ROLE OF INFORMATION SYSTEM 

The changing role of information and information systems is briefly discussed under 

following, subsections. 

7.8.1. Information as a Necessary Evil 

Information was regarded as a necessary evil, associated with the development, production as 

marketing of products or services. Information was thus merely considered as a by-product. 

transactions in the organizations. As a result, information systems of the 1950s were 

primarily, designed with the aim to reduce the cost of routine paper processing in accounting 

areas. The term "Electronic Data Processing (EDP)' was coined in this period. 

7.8.2. Information for General Management Support 

By mid-sixties, organizations began recognizing information as an important tool which 

could support general management tasks. The information systems corresponding to this 

period were known as Management Information Systems (MIS) and were thought of as 

systems processing data into information. 

7.8.3. Information for Decision-making 

In the early-eighties, information was regarded as providing special-purpose, tailor-made 

management controls over the organization. Decision Support Systems and Executive 

Support Systems were important advancements, which took place during this period. The 

purpose of such information systems was to improve and speed-up the decision-making 

process of top-level managers. 

 



7.8.4. Information as a Strategic Resource 

In the revolutionary change pattern, the concept of information changed again by the mid-

eighties and information has since then been considered as a strategic resource, capable of 

providing competitive advantage or a strategic weapon to fight the competition. Latest 

information systems, which are known as strategic systems, support this concept of 

information. 

 

Changing concepts of information systems 

Time Period 

 

Concept of 

Information 

 

Information 

 

Aims of Information 

System 

 

1950-65 

 

Necessary Evil, A 

by-product 

 

Electronic Data, A 

by-product 

 

Fast Paper 

Processing 

 

1966-70 

 

General Purpose 

Support 

 

Management 

Reporting System 

 

Speedy General 

Report 

Requirement 

 

1971-85 

 

Specific 

Management 

Control Support 

System 

 

Decision Support 

Systems, Executive 

Decision Making 

Improvement, 

Tailor-made 

1986 

 

Strategic Resource, 

Competitive 

Weapon 

 

Strategic Informal 

Systems  

Promote Survival 

and Growth of 

Organisation 

 

 

The table above portrays the changing concepts of information and information systems in 

organizations. 

Information and information systems can be used to gain and sustain competitive advantage 

in organizations. In order to understand how information systems can be used to gain and 

sustain competitive advantage, let us understand the concept of competitive advantage and 

the models for analyzing competitiveness. 

 

7.9. INFORMATION SYSTEM ACTIVITIES 

Regardless of the type of information system, the same basic information system activities 

occur. Let's take a closer look now at each of the basic data or information processing 

activities. You should be able to recognize input, processing, output, storage, and control 

activities taking place in any information system you are studying. Figure lists business 

examples that illustrate each of these information system activities. 



Business examples of the basic activities of information systems. 

Information System Activities 

 

 Input. Optical scanning of bar-coded tags on merchandise. 

 

 Processing. Calculating employee pay, taxes, and other payroll deductions. 

 

 Output. Producing reports and displays about sales performance. 

 

 Storage. Maintaining records on customers, employees, and products. 

 

 Control. Generating audible signals to indicate proper entry of sales data. 

 

 

7.9.1. Input of Data Resources 

Data about business transactions and other events must be captured and prepared for 

processing by the input activity. Input typically takes the form of data entry activities such as 

recording and editing. End users usually enter data directly into a computer system or record 

data about transactions on some type of physical medium such as a paper form. This entry 

includes a variety of editing activities to ensure that they have recorded the data correctly. 

Once entered, data may be transferred onto a machine-readable medium, such as a magnetic 

disk, until needed for processing. 

For example, data about sales transactions may be recorded on source documents such as 

paper order forms. (A source document is the original, formal record of a transaction.) 

Alternatively, salespersons might capture sales data using computer keyboards or optical 

scanning devices; they are visually prompted to enter data correctly by video displays. This 

method provides them with a more convenient and efficient user interface, that is, methods of 

end-user input and output with a computer system. Methods such as optical scanning and 

displays of menus, prompts, and fill-in-the-blank formats make it easier for end users to enter 

data correctly into an information system. 

7.9.2. Processing of Data into Information 

Data are typically subjected to processing activities, such as calculating, comparing, sorting, 

classifying, and summarizing. These activities organize, analyze, and manipulate data, thus 

converting them into information for end users. The quality of any data stored in an 

information system also must be main- tined by a continual process of correcting and 

updating activities. 

Example. Data received about a purchase can be (1) added to a running total of sales results, 

(2) compared to a standard to determine eligibility for a sales discount, (3) sorted in 

numerical order based on product identification numbers, (4) classified into product 

categories (e.g., food and non-food items), (5) summarized to provide a sales manager with 

information about various product categories, and finally (6) used to update sales records. 



7.9.3. Output of Information Products 

Information in various forms is transmitted to end users and made available to them in the 

output activity. The goal of information systems is the production of appropriate information 

products for end users. Common information products include messages, reports, forms, and 

graphic images, which may be provided by video displays, audio responses, paper products, 

and multimedia. We routinely use the information provided by these products as we work in 

organizations and live in society. For example, a sales manager may view a video display to 

check on the performance of a salesperson, accept a computer-produced voice message by 

telephone, and receive a printout of monthly sales results. 

7.9.4. Storage of Data Resources 

Storage is a basic system component of information systems. Storage is the information 

system activity in which data are retained in an organized manner for later use. For example, 

just as written text material gets organized into words, sentences, paragraphs, and documents, 

stored data are commonly organized into a variety of data elements and databases. This 

organization facilitates their later use in, Data Resource Management processing or retrieval 

as output when needed by users of a system.  

7.9.5. Control of System Performance 

An important information system activity is the control of system performance. An 

information system should produce feedback about its input, processing, output, and storage 

activities. This feedback must be monitored and evaluated to determine whether the system is 

meeting established performance standards. Then appropriate system activities must be 

adjusted so that proper information products are produced for end users. 

For example, a manager may discover that subtotals of sales amounts in a sales report do not 

add up to total sales. This conflict might mean that data entry or processing procedures need 

to be corrected. Then changes would have to be made to ensure that all sales transactions 

would be properly captured and processed by a sales information system. 

 

7.10. ACCOUNTING INFORMATION SYSTEM 

Accounting is one of the significant activities in any business. Accounting is mainly 

concerned with the collecting, recording and evaluation of financial data and then, 

communicating this information to the management and other people. It is viewed as an 

information system since it has inputs (financial data), processes (evaluation of data) and 

outputs (financial statements). All organizations need systematic maintenance of their records 

that help in the preparation of the financial statements such as Profit & Loss account and 

Balance sheet 

Operational accounting systems emphasize legal and historical record-keeping and the 

production of accurate financial statements. Typically, these systems include transaction 

processing systems such as order processing, inventory control, accounts receivable, accounts 

payable, payroll, and general ledger systems. Management accounting systems focus on the 

planning and control of business operations. They emphasize cost accounting reports, the 



development of financial budgets and projected financial statements, and analytical reports 

comparing actual to forecasted performance. 

7.10.1 Online Accounting Systems 

It should come as no surprise that accounting information systems are being transformed by 

Internet technologies. Using the Internet and other networks changes how accounting 

information systems monitor and track a business activity. The interactive nature of online 

accounting systems calls for new forms of transaction documents, procedures, and controls. 

This particularly applies to systems like order processing, inventory control, accounts 

receivable, and accounts payable. As outlined in Figure 3.17, these systems are directly 

involved in the processing of transactions between a business and its customers and suppliers. 

So naturally, many companies are using the Internet and other network links to these trading 

partners for such online transaction processing systems, as discussed in Section I. Figure 3.19 

is an example of an online accounting report 

There are 3 general types of Accounting Information Systems: 

 Financial Accounting System: This system provides financial statements to 

investors, governmental authorities, and other interested parties in accordance with 

their reporting formats. 

  Management Accounting System: It provides reports to managers both, for 

strategic and tactical decisions and on profitability of the organization. 

 Cost Accounting System: It provides reports to managers for cost planning and cost 

control of operations. 

All the above three types of accounting information systems process the same accounting 

transactions and often share the data files. Therefore, an accounting information system is 

generally developed as an integrated system providing all the report of the above three types. 

Many types of account books and financial statements can be generated by a financial 

accounting system. In manual system of accounting, maintaining of account books in a 

prescribed manner is called Book Keeping, while preparation of financial statements based 

on the account books is called financial accounting. 

However, in computerized system of accounting, no such distinction is found and a financial 

accounting system generates both account books and financial statements. 

The major types of account books are: 

(a) Voucher. A transaction is recorded by debiting and crediting the two affected accounts, 

called a voucher. 

(b) Journal: It is an account book in which all the transactions are recorded in a 

chronological order (i.e., date wise). It is maintained only in manual system by entering 

information from vouchers and is not required in computerized systems. 

(c) General ledger: All the accounts are recorded and maintained individually in a book 

called general ledger or simply ledger. In manual system of accounting, the ledger is prepared 

by entering information from the journal by a process called posting while in computerized 

system, the data of vouchers (input) is processed to prepare a ledger (output). 



(d) Purchase book: The purchase of goods on credit basis is recorded in another special 

ledger called purchase book. 

(e) Sales book: The credit sales of goods are recorded in a special ledger called sales book. 

(f) Cash book: Cash book is a special type of ledger in which only cash transactions are 

recorded and maintained. 

(g) Bank book: Bank book is another type of ledger in which only bank transactions are 

recorded and maintained. 

(h) Creditor's ledger: The transaction (credit purchases) of all the creditors are recorded and 

maintained in creditor's ledger. 

(i) Debtor's ledger: The transactions (credit sales) of all the debtors are recorded and 

maintained in debtor's ledger. 

After preparation of all the above accounts, the final statements of accounts are generated 

periodically (monthly or yearly). The major financial statements are as follows: 

(a) Trial balance: It is a list or financial statement prepared monthly, quarterly or annually to 

find out the balance at each accounting a trial balance all debtors am shown on one side while 

all creditors are shown on the other. The total of debit balance must match the total of the 

credit balance. 

(b) Trading account: It is a financial statement prepared yearly to find out the gross profit or 

gross loss of the organization. 

(c) Profit and loss account: After preparation of trading accounts, a financial statement 

called Profit & Loss account 15 generated to find out the net profit or net loss of the 

organization. 

(d) Balance sheet: The balance sheet is the most important financial statement of the 

company that shows its position of assets and liabilities on a particular date (generally at the 

end of the accounting year). 

(e) Accounts receivable statement: This statement lists the name of the debtors and, the 

amounts to be received by the company. 

(f) Account payable statement: This statement lists the name of the creditors and, the 

amounts to be paid by the company. 

 

 7.11. A TYPICAL FINANCIAL ACCOUNTING SYSTEM 

The major objectives for implementing a computerized financial accounting system for an 

organization are: 

 Preparation of a general ledger 

 Maintaining account books 

 Generating Profit & Loss account and Balance sheet 



 Generating updated financial data for other systems 

 Generating accounts receivables & accounts payable statements 

The various inputs to the system are: 

 Cash vouchers 

 Bank vouchers 

 Journal vouchers 

 Purchase vouchers or bills from vendor/suppliers 

 Sale vouchers or bills to customers 

A typical financial accounting system generates the following outputs: 

 Account books (cash book, bank book, journal general ledger, purchase book, sales 

 book) 

 Trial balance 

 Trading account 

 Profit & loss account 

 Balance sheet 

 Accounts payable statement 

 Accounts receivable statement 

A typical Accounting Information System includes financial accounting, cost accounting and 

management accounting systems. The major objectives of an accounting information system 

are: 

 Preparation of account books and financial statements 

 Generation of MIS reports 

The various inputs to the system are: 

 Updated financial data from general ledger and accounts 

 Updated purchase data from inventory system 

 Updated production data from production planning and control system 

 Updated sales data from invoicing system 

 Receivable/ payable system 

 Updated pay data from payroll system 

A typical accounting information system generates the following: 

 Account books i.e., cash book, bank book, sales book, purchase book, journal and 

general ledger 

 Financial statements i.e., trial balance, trading accounts, profit & loss account, 

balance sheet, accounts receivable statement and accounts payable statements 

 MIS reports i.e., cost analysis, forecasting and funds management reports (Gupta, 

2011) (Gupta, 2011) 

 

 



7.12. FINANCIAL MANAGEMENT SYSTEM 

Computer-based financial management systems support business managers and professionals 

in decisions concerning (1) the financing of a business and (2) the allocation and control of 

financial resources within a business. Major financial management system categories include 

cash and investment management, capital budgeting, financial forecasting, and financial 

planning.  

For example, the capital budgeting process involves evaluating the profitability and financial 

impact of proposed capital expenditures. Long-term expenditure proposals for facilities and 

equipment can be analyzed using a variety of return on investment (ROI) evaluation 

techniques. This application makes heavy use of spreadsheet models that incorporate present 

value analysis of expected cash flows and probability analysis of risk to determine the 

optimum mix of capital projects for a business. 

 Financial analysts also typically use electronic spreadsheets and other financial planning 

software to evaluate the present and projected financial performance of a business. They also 

help determine the financing needs of a business and analyze alternative methods of 

financing. Financial analysts use financial forecasts concerning the economic situation, 

business operations, types of financing available, interest rates, and stock and bond prices to 

develop an optimal financing plan for the business. Electronic spreadsheet packages, DSS 

software, and Web-based groupware can be used to build and manipulate financial models. 

Answers to what-if and goal-seeking questions can be explored as financial analysts and 

managers evaluate their financing and investment alternatives (Ramesh Behl, 2019). 

 

7.12.1. FINANCIAL INFORMATION SYSTEM 

Financial information system is a sub-system of organizational management information 

system. This sub-system supports the decision-making process of financial functions at the 

level of an organization. The basic financial decisions, which an organization usually takes, 

may include the following. 

(i) Where to invest funds and to what extent? 

(ii) Where to raise funds and what amount? 

(iii) How much to pay in dividends (in case, it is a public company)? 

A brief description of each of the financial decisions, that a financial manager has to take, is 

given below. 

 Capital budgeting decision In this decision, funds are allocated to long-term assets 

which would yield benefits/returns in the future. For example, funds allocated for 

land, building machinery, etc. Before committing funds, it is very important for the 

financial manager bto evaluate the prospective profitability of the new investment. 

 Financing decision It relates to when, where and how to acquire funds to meet the 

investment needs of the organization. The financial manager has to decide about the 

proportion of equity capital and debt capital. He has to determine areas where the use 



of debt capital affects the return and poses a risk to shareholders, The return on equity 

may increase, but so will the risk. Thus, a proper balance will have to strike between 

return and risk. 

 Dividend decision This decision relates to the dividend policy of the organization. A 

decision whether the organization should distribute all profits or retain them or 

distribute a portion and retain the balance, has to be taken by the financial managers. 

 Current asset management in order to safeguard the organization against illiquidity 

or insolvency, current assets of the organization are also required to be efficiently 

managed Investment in current assets affects the organization's profitability, liquidity 

and risk. If sufficient funds are not invested in current assets, the organization may 

become illiquid. But it would lose profitability as idle current assets would not car any 

profits. Thus, a suitable trade-off is needed to be achieved between profitability and 

liquidity. 

Besides the above-mentioned managerial functions, the other functions of financial systems 

may be summarized as below. 

 Controlling the receipt and payments 

 Maintaining statutory records 

 Preparation of periodic reports for statistics, performance and results for internal 

control and audit 

Financial systems also include accounting systems as these systems are concerned with 

recording the transactions of the business, such transactions may include wages and salaries, 

purchases, sales and all other types of income and expenditure. Obviously, records of these 

transactions become the basis for the preparation of periodic or annual profit and loss 

accounts, balance sheets, etc. 

In order to perform the above activities and functions, financial information that is accurate, 

precise and timely has to be supplied to the financial manager. These systems involve large 

amounts of data, concerned primarily with historical and internal information. However, in 

some areas of financial planning, it is future-oriented also. For example, the exercise of 

budgeting is wholly futuristic in nature. 

Financial information systems are computerized: 

 To improve the speed and accuracy of reporting 

 To provide information and analytical support to financial managers to aid them in 

their decision-making. Figure illustrates a financial information system. 



 
Figure- Financial Information System 

 Transactional data is the basis of any type of analysis. This data may include credit 

applications, billing, payment vouchers, stock transfers, cheques, journal and ledger 

entries, etc. 

 Financial intelligence data is collected from banks, government, stock markets, etc., 

which is processed to determine its impact on the organizational economy. 

 Organizational plan is another important input in the financial information system, as 

it portrays the objectives of the organization. This needs to be reflected in the output 

of the financial information system, which may be in the form of financial plans. 

Many software packages on financial accounting are available in the market, which provide 

complete financial accounting. Tally, BMS, etc., are the more common packages. Financial 

planning software (e.g., IFPS, etc.) packages are used for managerial decision-making at 

higher levels. 
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UNIT 8:- DECISION SUPPORT SYSTEM: Concepts and Features MIS vs. DSS, Tools 

      and Models for decision support Group Decision support system. 

8.1. Introduction 

While understanding management as a component of management information system, we 

have advocated that decision-making is the essence of management. In other words, whatever 

 a manager does in an organization, he/she does it through decision-making. That is why, 

 decision-making is regarded as the core of managerial functions. MIS assists every manager/ 

 decision-maker in providing the required information, which is vital and an essential input in 

 any kind of decision-making. 

Decision-making is no longer based on the creativity, intuition, and/or experience of a 

manager or rule of thumb approach; rather today's manager has to operate, under ever-

increasing complexities of business as well as that of management. It is more difficult to 

make decisions for several reasons. For example, the number of available alternatives is 

much larger than ever before because of improved technology and communication systems. 

Secondly, any wrong decision may be very costly because of the complexity and magnitude 

of operations, automation, and the chain reactions that it can cause in an organization. 

Thirdly, the environment today is more dynamic, and finally, the ever-increasing competition 

forces managers to act fast and take quick decisions. The important factors and their effect on 

decision-making are listed in the table below: 

 

FACTORS EFFECT 

More complexity in IT More alternatives 

Increased organizational complexity High cost of wrong decisions 

Presence of globalization, less political 

stability, high government intervention 

More uncertainty 

More changes fluctuations Need for quick decisions 

         

 In order to cope with such a situation, today's manager must understand the decision-making 

process; decision situations; application of new tools and techniques; and the applications d 

computerized support systems in their decision-making. Let us first discuss the concept 

of decision-making. 



8.2. DECISION-MAKING: A CONCEPT 

Literally speaking, decision-making has been taken from the word 'decide', which is a Latin 

word meaning "to cut off" or 'to come to a conclusion. The decision may be regarded as a 

'choice"' whereby a decision-maker comes to a conclusion about a given situation. A decision 

represents a course of behavior selected from a number of (more than one) possible 

alternatives. Decision-making, on the other hand, is a process of selecting one optimum 

alternative from among alternatives of a course of action. Thus, a decision is an end or the 

final product of the decision-making process. However, the decision should not be mistaken 

here as an end in itself, rather it is regarded as a means for action. Decisions are not static and 

have to be responsive to varying situations. In fact, decision-making means, choosing one 

course of action rather than another and finding an appropriate solution to a new problem 

posed by a dynamic world'. It is implied that decision-making envisages two or more 

alternatives from which a final decision can be made. However, if there is no option, i.e. only 

one alternative is available, there is no decision to be made. In organizations, some of the 

decisions can be made easily with a minimum of mental effort but in most cases, decision-

making becomes a complex issue, broader than merely making a commitment after 

evaluating alternatives. It involves the entire process of establishing goals, defining activities, 

searching for other options, and developing plans. It includes all the activities of 

coordinating, information processing, problem-solving, and evaluating that usually precede a 

decision. 

8.2.1. Decision Support Systems - Why? 

Having discussed the conceptual framework for decision-making, let us now understand the 

need for computerized decision support systems. These systems have become necessary for 

today's managers because of the following reasons: 

i. Fast computation: A decision-maker can perform a large number of computations 

very quickly and that too at a low cost with the help of computer support systems. 

Today, in the majority of decisions, time is of the essence. 

ii. Enhanced productivity: Support systems can enhance the productivity of support 

staff and also enable the group members to discuss the problems among themselves at 

a distance. 



iii. Data transmission: Sometimes the data, which may be stored at different locations, 

may be required to be transmitted quickly from distant locations. Computer support 

systems can search, store, and transmit the required data quickly and economically.  

iv. Better decisions: Computer support systems can help a decision-maker in arriving at a 

better decision. For example, more alternatives can be evaluated, risk analysis be 

performed quickly, and views of experts from different places can be collected 

quickly and at a lower cost. 

v. Competitive edge: Decision support systems enable the users to get a competitive 

edge over their competitors as these systems enable organizations to change their 

operations frequently, re-engineer processes and structures, empower employees and 

innovate. Decision support technologies can create useful empowerment by allowing 

people to make good decisions, even if they lack some knowledge. 

In view of the above-stated reasons, decision support systems are important tools in the hands 

of decision-makers, which come in handy, especially in their semi-structured to unstructured 

problems. 

8.2.2. Decision Support Systems - What? 

Decision support systems like MIS have also been defined differently by different people and 

thus there is no universally accepted definition of DSS. It was in the early 1970s, when Scolt 

Morton put forward the concept of DSS and defined DSS as an interactive computer-based 

system, which helps decision-makers utilize data and models to solve unstructured problems, 

and thereafter many other scholars like Little (1970), Alter (1980), Moore and Chang (1950), 

Keen (1950), etc, have defined the concept in different ways. However, the focus of all these 

definitions has been on the 'what' aspect, i.e. what a DSS does and how aspect, i.e. how the 

objectives of DSS can be achieved. For the purpose of this book, we understand the definition 

of DSS as follows: 

"A decision support system is a specialized kind of information system, which is an 

interactive system that supports in the decision-making process of a manager in an 

organization, especially in semi-structured and unstructured situations. The system utilizes 

information, models, and data manipulation tools to help make decisions in semi-structured to 

unstructured situations." 

 



8.3. COMPONENTS OF DECISION SUPPORT SYSTEM 

A decision support system comprises three main components: 

 Database 

The data in the database typically is a combination of master files (internal corporate 

data) and data from external sources. Because of the large size of the data, data 

warehouse is used for handling huge data. 

 Model base 

The second component of the DSS is a library of models to manipulate and analyse 

the data in the desired ways. The model base might include econometric models to 

forecast demand by industry and simulation models of the corporation. It may also 

have data mining tools to extract trends and patterns. 

 Dialogue box 

A user interface is the third component. Through this, the user can communicate with 

the DSS. The physical interface generally consists of a terminal hooked up to the 

mainframe computer, either directly or by telephone. Micro-computers with modems 

are being used ever more frequently for this interface. These elements are illustrated 

in Figure . 

 

Figure -Components of a Typical DSS 

8.4. CHARACTERISTICS AND CAPABILITIES OF DSS 

Decision support systems, as the name implies, support the decision-making process of a 

manager and thus should be able to provide the required support in the decision-making 

process. 



Accordingly, decision-support systems are understood to have the following characteristics 

and capabilities. These have also been depicted in Figure  

 

1. DSS provide support for decision-makers mainly in semi-structured and unstructured 

situation by bringing together human judgements band computerized information. Such 

problem cannot be solved (or cannot be solved conveniently) by other information systems. 

2. Support is provided for various managerial levels, ranging from managers at the strategic 

level to the managers at the operational level. 

 

FIGURE -The ideal characteristics and capabilities of DSS 

 3. DSS provides support to individuals as well as to groups of managers. Less-structured 

problems often require the involvement of several individuals from different department and 

organizational levels or even from different organizations. 

4. DSS provides support to several interdependent and/or sequential decisions. The decision 

may be made once, several times, or repeatedly. 



5.  DSS support all phases of the decision-making process: intelligence, design, choice, and, 

implementation. 

6. DSS supports a variety of decision-making processes and styles. 

7. DSS is adaptive over time. The decision-maker should be reactive, able to confront 

changing conditions quickly and be able to adapt the DSS to meet these changes. DSS is 

flexible, so users can add, delete, combine, change, or rearrange basic elements 

8.. DSS should have the features like user-friendliness, strong graphical capabilities, and an 

English-like interactive human-machine interface. Such features can greatly increase the 

effectiveness of DSS. 

9. DSS attempt to improve the effectiveness of decision-making (accuracy, timelines, quality) 

rather than its efficiency (the cost of making decisions). 

10. The decision-maker has complete control over all steps of the decision-making process in 

solving a problem. A DSS specifically aims to support and not to replace the decision-maker. 

11. End users should be able to construct and modify simple systems by themselves. Larger 

systems can be built with assistance from information system (IS) specialists. 

12. A DSS usually utilizes models for analyzing decision-making situations. The modeling 

capability enables experimenting with different strategies under different configurations. 

13. The DSS should provide access to a variety of data sources, formats, and types, ranging 

from geographic information systems (GIS) to object-oriented ones. A DSS can be employed 

as a standalone tool used by an individual decision-maker in one location, or it can be 

distributed throughout an organization and in several organizations along the supply chain. 

14. It can be integrated with other DSS and/or applications, and it can be distributed 

internally and externally, using networking and Web technologies. 

These characteristics allow decision-makers to make better, more consistent decisions in a 

timely manner, and they are provided by DSS major components. 

 

8.5. INFORMATION, DECISION AND MANAGEMENT 

The figure below emphasizes that the type of information required by decision-makers in a 

company is directly related to the level of management decision-making and the amount of 



structure in the decision situations they face. It is important to understand that the framework 

of the classic managerial pyramid shown in Figure applies even in today's downsized 

organizations and flattened or non-hierarchical organizational structures. Levels of 

management decision-making still exist, but their size, shape and participants continue to 

change as today's fluid organizational structures evolve. Thus, the levels of managerial 

decision-making that must be supported by information technology in a successful 

organization are: 

i. Strategic Management: Typically, a board of directors and an executive committee 

of the CEO and top executives develop overall organizational goals, strategies, 

policies, and objectives as part of a strategic planning process. They also monitor the 

strategic performance of the organization and its overall direction in the political, 

economic, and competitive business environment. 

ii. Tactical Management: Increasingly, business professionals in self-directed teams as 

well as business unit managers develop short- and medium-range plans, schedules, 

and budgets and specify the policies, procedures, and business objectives for their 

subunits of the company. They also allocate resources and monitor the performance of 

their organizational subunits, including departments divisions, process teams, project 

teams, and other workgroups. 

iii. Operational Management: The members of self-directed teams or operating 

managers develop short-range plans such as weekly production schedules. They direct 

the use of resources and the performance of tasks according to procedures and within 

budgets and schedules they establish for the teams and other workgroups of the 

organization. 

8.6. DECISION SUPPORT TRENDS 

The emerging class of applications focuses on personalized decision support, modeling, 

information retrieval, data warehousing, what-if scenarios, and reporting.  

Information systems has been used to support business decision, making it the primary thrusts 

of the business use of information technology. During the 1990s, however, academic 

researchers and business practitioners began to report that the traditional managerial focus 

originating from classic management information systems (1960s), decision support systems 

(1970s), and executive information systems (1980s) was expanding. The fast pace of new 

information technologies like PC hardware and software suites, client/server networks, and 



networked PC versions of DSS software made decision support available to lower levels of 

management, as well as to nonmanagerial individuals self-directed teams of business 

professionals. 

This trend has accelerated with the dramatic growth of the Internet, as well as of intranets and 

extranets that inter-network with companies and their stakeholders. The'-business and e-

commerce initiatives that are being implemented by many companies are also expanding the 

information and decision Support uses and the expectations of a company's employees, 

managers, customers, suppliers, and other business partners. Figure. illustrates that all 

business stakeholders expect easy and instant access to information and Web-enabled self-

service data analysis. Today’s businesses are responding with a variety of personalized and 

proactive Web-based analytical techniques to support the decision-making requirements of all 

of their constituents.

Thus, the growth of corporate intranets and extranets, as well as the Web, has accelerated the 

development and use of "executive-class" information delivery and decision support software 

tools by lower levels of management and by individuals and teams of business professionals. 

In addition, this dramatic the expansion has opened the door to the use of such business 

intelligence (BI) tools by the suppliers, customers, and other business stakeholders of 

company for customer relationship management, supply chain management, and other -

business applications. 



In 1989, Howard Dresner (later a Gartner Group analyst) proposed BI as an umbrella term to 

describe "concepts and methods to improve business decision making by using fact-based 

support systems." It was not until the late 1990s that this usage became widespread. Today, 

BI is considered a necessary and mission-critical element in crafting and executing a firm's 

strategy. Consider the following findings from a 2009 Gartner Group study: 

 Because of a lack of information, processes, and tools, through 2012, more than 35 percent 

of the top 5,000 global companies will regularly fail to make insightful decisions about 

significant changes in their business and markets. 

 By 2012, business units will control at least 40 percent of the total budget for business 

intelligence. 

 By 2010, 20 percent of organizations will have an industry-specific analytic 

application, delivered via software as a service, as a standard component of their 

business intelligence portfolio. 

 In 2009, collaborative decision-making will emerge as a new product category that 

combines social software with business intelligence platform capabilities. 

When you consider some of these findings, it becomes easy to see that BI is rapidly 

becoming the mainstay for business decision-making in modern organizations. Before long, it 

will evolve into; a competitive necessity for many industries. 

As with all concepts in business-related technologies, business intelligence has evolved from 

Dresner’s original definition focusing on concepts and methods to a more action-oriented 

approach referred to as business analytics. Business analytics (BA) refers to the skills, 

technologies, applications, and practices applied to a continuous iterative exploration and 

investigation of a business's historical performance to gain insight and drive the strategic 

business planning process. Business analytics focuses on developing new insights and 

understanding of business performance based on data and statistical methods. In contrast, 

business intelligence traditionally focuses on using a consistent set of metrics to both measure 

past performance and guide business planning, which is also based on data and statistical 

methods. 

Business analytics makes much more extensive use of data, statistical and quantitative 

analysis, explanatory and predictive modeling, and fact-based management to drive decision-

making. Analytics may be used as input for human decisions or may drive fully automated 



decisions. Business intelligence is more associated with querying, reporting, online analytical 

processing (OLAP), and "alerts." In other words, querying, reporting, OLAP, and alert tools 

can answer the questions: what happened; how many; how often; where; where exactly is the 

problem; and what actions are needed. Business analytics, in contrast. can answer the 

questions: why is this happening; what if these trends continue; what will happen next (that 

is, predict); and what is the best that can happen (that is, optimize). 

The figure below highlights several major information technologies that are being 

customized, personalized, and Web-enabled to provide key business information and 

analytical tools for managers, business professionals, and business stakeholders. We highlight 

the trends toward such business intelligence applications in the various types of information 

and decision support systems that are discussed in this chapter. 

 

 

FIGURE 

8.7. MANAGEMENT INFORMATION SYSTEMS 

 Management information systems were the original type of information system developed to 

support managerial decision-making. An MS produces information products that support 

many of the day-to-day decision-making needs of managers and business professionals. 

Reports, displays, and responses produced by management information systems provide 

information that these decision-makers have specified in advance as adequately meeting their 



information needs. Such predefined information products satisfy the information needs of 

decision-makers at the operational and tactical levels of the organization who are faced with 

more structured types of decision situations. 

For example, sales managers rely heavily on sales analysis reports to evaluate differences in 

performance among salespeople who sell the same types of products to the same types of 

customers. They have a pretty good idea of the kinds of information about sales results (by 

product line, sales territory, customer, salesperson, and so on) that they need to manage sales 

performance effectively. Managers and other decision-makers use an MIS to request 

information at their networked workstations that support their decision-making activities. 

This information takes the form of periodic, exception, and demand reports and immediate 

responses to inquiries. Web browsers, application programs, and database management 

software provide access to information in the intranet and other operational databases of the 

organization. Remember, operational databases are maintained by transaction processing 

systems. Data about the business environment are obtained from the Internet or extranet 

databases when necessary.  

 

8.8. DECISION SUPPORT SYSTEM VERSUS MANAGEMENT INFORMATION 

SYSTEM 

Is a DSS an MIS? How does a Decision Support System differ from a Management 

Information System? One can begin drawing distinctions between these two terms by first 

examining the concepts of Management Information System (MIS) and Information System 

(IS). Many authors have used the term "MIS" to describe a broad, general category of 

information systems. Also, MIS and IS are used interchangeably to describe a functional 

department in companies and organizations responsible for managing information systems 

and technology. A number of computing jobs are grouped together under the heading of MIS 

or IS professionals. Finally, the term "Management Information Systems" or "MIS" is used to 

identify an academic major and an area of scholarly inquiry in universities. 

In the 1970s, an MIS generated periodic management reports. Today, managers use data-

driven DSS to meet their management reporting needs. When the term "Management 

Information System" is defined narrowly, it refers to a management reporting system that 

provides periodic, structured, paper-based reports. In contrast, data-driven DSS are intended 

to be interactive, real-time systems that are responsive to unplanned, as well as planned, 



information requests and reporting needs. Model-driven DSS are usually focused on 

modeling a specific decision or a set of related decisions (cf., Power, 1997). 

DSS include a wide variety of analytical information systems. DSS provide managers more 

control of their data, access to analytical tools, and capabilities for consulting and interacting 

with a distributed group of staff. An enterprise wide DSS is linked to a large data warehouse 

and serves many managers within one company. Also, a DSS is defined as an interactive 

system in a networked environment that helps a targeted group of managers make decisions. 

The primary focus in the following discussion is on various types of DSS. The term MIS will 

be used sparingly and will usually refer broadly to an information system that provides 

managers with on-line access to information. 

 

8.9. BUILDING DECISION SUPPORT SYSTEMS 

Traditionally, IS academics and practitioners, have discussed building DSS in terms of four 

major components: 1) the user interface, 2) the database, 3) the models and analytical tools, 

and 4) the DSS architecture and network (cf., Sprague and Carlson, 1982). This traditional 

list of components remains useful because it identifies similarities and differences between 

categories or types of DSS, and it can help managers and analysts build new DSS. The 

expanded DSS framework is based on the different emphases placed on DSS components 

when a specific system is actually constructed. 

Data-driven, document-driven and knowledge-driven DSS need specialized database 

components. A model-driven DSS may use a simple flat-file database with fewer than 1,000 

records, but the model component is very important and it provides the functionality. 

Experience, and some empirical evidence, indicate that design and implementation issues 

vary for data-driven, document-driven, model-driven, and knowledge-driven DSS. 

Multiparticipant systems like group and inter-organizational DSS also create complex 

implementation issues. For instance, when implementing a data-driven DSS, a designer 

should be especially concerned about the user's interest in applying the DSS in unanticipated 

or novel situations. 

In creating an accounting or financial simulation model, a developer should attempt to verify 

that the initial input estimates for the model are thoughtful and reasonable. In developing a 

representational or optimization model, an analyst should be concerned about possible 



misunderstandings of what the model means and how it can or cannot be u2d (cf., Alter, 

1980). Networking issues create challenges for many types of DSS, but especially for 

communications-driven systems with many participants, so-called multiparticipant systems. 

Today, architecture and networking issues are increasingly important in building DSS. DSS 

should be built or implemented using an appropriate process. Many small, specialized model-

driven DSS are built quickly. Large, enterprise-wide DSS are built using sophisticated tools 

and systematic and structured systems analysis and development approaches. 

Communications-driven and GDS are usually purchased as "off-the-shelf" software and then 

implemented in a company. Creating enterprise-wide DSS environments remains an iterative 

and evolutionary task. As an enterprise-wide DSS grows, it inevitably becomes a major part 

of the overall information systems infrastructure of an organization. Despite the significant 

differences created by the specific task and scope of a DSS, all DSS have similar technical 

components and share a common purpose-_supporting decision making. 

A data-driven DSS database is often a collection of current and historical structured data from 

a number of sources that have been organized for easy access and analysis. The above 

framework expands the database component to include unstructured documents in document-

driven DSS and "knowledge" in the form of rules in knowledge-driven DSS. Large databases 

of structured data in enterprise-wide DSS are often called data warehouses or data marts. 

Data-driven DSS usually use data that has been extracted from all relevant internal and 

external databases. Managing information often means managing a database. Supporting 

management decision-making means that computerized tools are used to make sense of the 

structured data or documents in a database. 

Mathematical and analytical models are the major component of a model-driven DSS. DSS 

models should be used and manipulated directly by managers-driven DSS. DSS models 

should be used and manipulated directly by managers and staff specialists. Each model-

driven DSS has a specific set of purposes, and hence, different models are needed and used. 

Choosing appropriate models is a key design issue. Also, the software used for creating 

specific models needs to manage needed data and the user interface. In model-driven DSS the 

values of key variables or parameters are changed to reflect potential changes in supply, 

production, the economy, sales, the marketplace, costs, and/or other environmental and 

internal factors. Information from the models is then analyzed and evaluated by the decision-

maker. Knowledge-driven DSS use special models, an inference engine, for processing rules 

or identifying relationships in data. 



The communications component refers to how hardware is organized, how software and data 

are distributed in the system, and how components of the system are integrated and 

connected. A major issue today is whether DSS should be available, using a Web browser, on 

a company intranet and also available on the global Internet. Both managers and MIS staff 

need to develop an understanding of the technical issues and the security issues related to 

DSS architectures, networks, and the Internet. Networking and communications technology is 

the key driver of communications-driven DSS. 

Managers and DSS analysts also need to emphasize the user interface component. In many 

ways, it is the most important component of any DSS. The tools for building the user 

interface are sometimes termed DSS generators, query and reporting tools, and front-end 

development packages. Much of the DSS design and development effort should focus on 

building the user interface. It is important to remember that the screens and displays in the 

user interface heavily influence how a manager perceives a DSS and whether it is used. What 

one sees is the DSS. (Power, 2002) 

 

8.10. USING DECISION SUPPORT SYSTEM 

A decision support system involves an interactive analytical modeling process. For example, 

using a DSS software package for decision support may result in a series of displays in 

response to the alternative. 

What if changes are entered by a manager. This differs from the demand responses of a 

management information system because decision-makers are not demanding prespecified 

information; they are exploring possible alternatives; Thus, they do not have to specify their 

information needs in advance. Instead, they use the DSS to find the information they need to 

help them make a decision. This is the essence of the decision support system concept. 

Four basic types of analytical modeling activities are involved in using decision support, 

(1) what-if analysis, (2) sensitivity analysis, (3) goal-seeking analysis, and (4) optimization 

analysis briefly looks at each type of analytical modeling that can be used for decision 

support. See Figure below 

Type of Analytical Modeling 

 

Activities and Examples 

 



What-if analysis 

 

Observing how changes to selected 

variables affect other variables. 

Example: What if we cut advertising by 10 

percent? What would happen to sales? 

 

Sensitivity analysis 

 

Observing how repeated changes to a single 

variable affect other variables. 

Example: Let's cut advertising by $100 

repeatedly so we can see its relationship to 

sales. 

 

Goal-seeking analysis 

 

Making repeated changes to selected 

variables until a chosen variable reaches a 

target value. 

Example: Let's try increases in advertising 

until sales reach $1 million. 

 

Optimization analysis 

 

Finding an optimum value for selected 

variables, given certain constraints. 

Example: What's the best amount of 

advertising to have, given our budget and 

choice of media? 

 

 

Activities and examples of the major types of analytical modeling. 

 8.10.1. What-If Analysis 

In what-if analysis, a user makes changes to variables, or relationships among variables, and 

observes the resulting changes in the values of other variables. For example, if you were 

using a spreadsheet, you might change a revenue amount (a variable) or a tax rate formula (a 

relationship among variable) in, simple financial spreadsheet model. Then you could 

command the spreadsheet program to recalculate all affected variables in the spreadsheet 

instantly. A managerial user would be able to observe and evaluate any changes that occurred 

to the values in the spreadsheet, especially to a variable such as net profitable taxes. To many 



managers, net profit after taxes is an example of the bottom line, that is, a key factor in 

making many types of decisions. This type of analysis would be repeated until the manager 

was satisfied with what the results revealed about the effects of various possible decisions.  

8.10.2. Sensitivity Analysis 

Sensitivity analysis is a special case of what-if analysis. Typically, the value of only one 

variable is changed repeatedly, and the resulting changes on other variables are observed. As 

such, sensitivity analysis really a case of what-if analysis that involves repeated changes to 

only one variable at a time. Some DSS packages automatically make repeated small changes 

to a variable when asked to perform sensitivity analysis. Typically, decision makers use 

sensitivity analysis when they are uncertain about the assumptions made in estimating the 

value of certain key variables. In our previous spreadsheet example, the value of revenue 

could be changed repeatedly in small increments, and the effects on other spreadsheet 

variables were observed and evaluated. This process would help a manager understand the 

impact of various revenue levels on other factors involved in decisions being considered. A 

typical example might be determining at what point the interest rate on a loan makes a project 

no longer feasible. By varying the interest rate used in a net present value calculation, for 

example, a manager can determine the range of acceptable interest rates under which a 

project can move forward. Approaching the problem this allows the manager to make 

decisions about a forthcoming project without knowing the actual cost of the money being 

borrowed. 

8.10.3. Goal-Seeking Analysis 

Goal-seeking analysis reverses the direction of the analysis done in what-if and sensitivity 

analyses. Instead of observing how changes in a variable affect other variables, goal-seeking 

analysis (also called bow-can analysis) sets a target value (eon) for a variable and then 

repeatedly changes other variables until the target value is achieved. For example, you could 

specify a target value (goal) of 2 million$ in net profit after taxes for a business venture. Then 

you could repeatedly, change the value of revenue or expenses in a Spreadsheet model until 

you achieved a result of $ 2 million. Thus, you could discover the amount of revenue or level 

of expenses the business venture needs to reach the goal of $2 million is after -tax profits.: 

Therefore, this form of analytical modeling Would kelp answer the question,” How can we 

Achieve $2 million in net profit after taxes?" instead of the question,” What happens if we 

change revenue or expenses?" So, goal-seeking analysis is another important method of 

decision support. 



8.10.4. Optimization Analysis 

Optimization analysis is a more complex extension of goal-seeking analysis. Instead of 

setting a specific target value for a variable, the goal is to find the optimum value for one or 

more target variables, given certain constraints. Then one or more other variables are changed 

repeatedly, subject to the specified constraints until you discover the best values for the target 

variables. For example, you could try to determine the highest possible level of profits that 

could be achieved by varying the values for selected revenue sources and expense categories. 

Changes to such variables could be subject to constraints, such as the limited capacity of a 

production process or limits to available financing. Optimization typically is accomplished 

using software like the Solver tool in Microsoft Excel and other software packages for 

optimization techniques such as linear programming. 

 

8.11. DATA MINING FOR DECISION SUPPORT 

We discussed data mining and data warehouses in Chapter S8 as vital tools for organizing 

and exploiting the data resources of a company. Thus, data mining's main purpose is to 

provide decision support to managers and business professionals through a process referred to 

as knowledge discovery. Data mining software analyzes the vast stores of historical business 

data that have been prepared for analysis in corporate data warehouses and tries to discover 

patterns, trends, and correlations hidden in the data that can help a company improve its 

business performance. 

Data mining software may perform regression, decision tree, neural network, cluster 

detection, or market basket analysis for a business. See Figure . The data mining process can 

highlight buying patterns, reveal customer tendencies, cut redundant costs, or uncover unseen 

profitable relationships, and opportunities. For example, many companies use data mining to 

find more profitable ways to perform successful direct mailings, including e-mailings or 

discover better ways to display products in a store, design a better e-commerce Website, 

reach untapped profitable customers, or recognize customers or products that are unprofitable 

or marginal. 

Market basket analysis (MBA) is one of the most common and useful types of data mining 

for marketing and is a key technique in business analytics. The purpose of market basket 

analysis is to determine which products customers purchase together with other products. 

MBA takes its name from the concept of customers throwing all of their purchases into a 



shopping cart (a marker basket) during grocery shopping. It can be very helpful for a retailer 

or any other company to know which products people purchase as a group. A store could use 

this information to place products frequently sold together into the same area, and a catalogue 

or World Wide Web merchant could use it to determine the layouts of a catalogue and order 

form. Direct marketers could use the basket analysis results to determine which new products 

to offer their prior customers. 

In some cases, the fact that items are sold together is obvious; every fast-food restaurant asks 

its customers "Would you like fries with that?" whenever a customer orders a sandwich. 

Sometimes, however, the fact that certain items would be sold together is far from obvious. A 

well-known example is the relationship between beer and diapers. A supermarket performing 

a basket analysis discovered that diapers and beer sell well together on Thursdays. Although 

the result makes some sense- couples stock upon supplies for themselves and for their 

children before the weekend starts-_it's far from intuitive. The strength of market basket 

analysis is as follows: By using computer data mining tools, it's not necessary for a person to 

think of which products consumers would logically buy together; instead, the customers' sales 

data speak for themselves. This is a good example of data-driven marketing. Consider some 

of the typical applications of MBA:  

 Cross-Selling. Offer the associated items when a customer buys any items from your 

store. 

 Product Placement. Items that are associated (such as bread and butter, tissues, and 

cold medicine, potato chips, and beer) can be put near each other. If the customers see 

them, it has a higher probability that they will purchase them together. 

 Affinity Promotion. Design the promotional events based on associated products. 

 Survey Analysis. The fact that both independent and dependent variables of market 

basket analysis are nominal (categorical) data types makes MBA very useful to 

analyze questionnaire data. 

 Fraud Detection. Based on credit card usage data, we may be able to detect certain 

purchase behaviors that can be associated with the fraud. 

 Customer Behavior. Associating purchases with demographic, and socio-economic 

data (such as age, gender, and preference) may produce very useful results for 

marketing. 



Once it is known that customers who buy one product are likely to buy another, it is possible 

for a company to market the products together or make the purchasers of one product target 

prospects for another. If customers who purchase diapers are already likely to purchase beer, 

they'll be even more likely to buy beer if there happens to be a beer display just outside the 

diaper aisle. Likewise, if its known that customers who buy a sweater from a certain mail-

order catalogue have a propensity towards buying a jacket from the same catalog, sales of 

jackets can be increased by having the telephone representatives describe and offer the jacket 

to anyone who calls in to order the sweater. By targeting customers who are already known to 

be likely buyers, the effectiveness of a given marketing effort is significantly increased- 

regardless of whether the marketing takes the form of in-store displays, catalog layout design, 

or direct offers to customers. 
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UNIT 9: ISSUES AND CHALLENGES 
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9.2.3.4 Health risks 

9.2.3.5 IT ECO-SYSTEM 

9.3 REFERENCES 

9.1CHALLENGES 

There are many challenges in managing information systems in organizations, which are 

important for a manager to understand. 

Understanding the need and aligning business with MIS 

The success of MIS depends significantly on understanding the need for an information 

system and aligning business with IS/IT. Generally, information systems are developed or 

acquired without understanding the specific needs of the organization for such systems. The 

goals of the information system and the reasons for implementing it, along with the sub-

system or major tasks involved, are not clearly defined. Many a time IS/IT systems are 

conceived which may not be aligned with the mission and goals of the organization. As, a 

result the ISs may not be contributing any value to the organization. 
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9.1.1 Requirement Analysis 

Many a time, the manager is not very clear about his/her requirements and thus it is left to the 

It specialist, who does not know much about the business. Thus, there remains a 

communication gap between the user and the IT specialist. As a result, the newly developed 

and implemented information system does not cater to the needs of the user. 

9.1.2 Project Management 

Information system to be successful must be developed/ implemented within time, budget 

and meet the quality standards. This calls for a proper IS project management. There may be 

many challenges in managing an IS/IT project, such as the following: 

 Unrealistic Deadlines: Many IT projects are estimated using optimistic measures. 

Sometimes unrealistic deadlines are difficult to manage. 

 Failure to Manage Risk: The project risks either are not well identified or are not 

managed fully leading to the failure of the project. 

 Lack of Project Management Skills : The It project manager may be lacking the 

knowledge of project management tools and techniques. Instead of understanding It 

project as a socio-technical project, he/she focuses only on the technical aspects of the 

projects. 

 Non-involvement of customers and end-users during the project: There is a big 

communication gap between the user and the technical professionals. The clients and 

end users are not involved during the project, which poses a great challenge to the 

success of the It project. 

9.1.3 Re-engineering of business Process 

Mere automation of the business process may not make the operation efficient and effective, 

rather it is redesigning of the business processes that is more important to improve the 

performance of the business. Re-engineering of the business processes would change the 

structure as well as the way an organization does business and thus leading to change in the 

organizational culture. 

 

9.1.4 Change Management 
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Many IS/IT systems are considered as IT solutions and are not considered as a part of the 

business solution and hence there is no change management strategy in place. 

Integrated Information systems like ERP Systems, being a transformation and an expensive 

solution, is not an easy decision, and thus needs to be dealt with care. While emphasising on 

the challenges of ERP system implementation, Kalakota and Robinson (2000) cautioned the 

organizations when they said that an ERP implementation is like the corporate equivalent of a 

brain transplant. The risk was certainly disruption of business, because if you do not do ERP 

properly, you can kill your company, guaranteed. They stressed this fact further and said that 

the fact cannot be denied that the implementation of ERP system is a complete business 

transformation which provides a competitive edge over other competitors but the costs and 

risks are also high. There have been different ERP implementation experiences from running 

into hundreds of millions of dollars.  

9.2 ISSUES PERTAINING TO MIS  

The ethical, social and managerial issues of the information systems are becoming more 

important these days because of the increased use of the internet and the interconnected 

information systems. These days, it has become much easier than ever before to gather, 

integrate and distribute information and thus has raised new concerns about the appropriate 

use of personal information relating to customers, employees or any other stake holder, 

protection of personal privacy; workplace monitoring and power struggle between employees 

and IS personnel; and the protection of the intellectual property. The other IS concerns relate 

to the deskilling of the employees; alienation or social cut off from the employees; setting of 

standards to protect system quality so as to protect the safety of the individual and the 

society; establishing accountability for the consequences of ISs; and preserving the values of 

the organization. In other words, while using information systems, these issues focus on the 

course of action that is secure, ethical and socially responsible.  

9.2.1 Managerial Issues 

 Organizational Impacts. Technology-supported communications are having various 

organizational impacts. The primary business benefit of networks and mobile 

communication is keeping workers connected. Mobile and collaboration technologies 

need to be in place to ensure that employees can be productive. 
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 Future of Technology Support. From a technology perspective the second half of this 

decade will be seen as a period in which technology moved to support collaboration. 

Whereas for the past five years the computer industry has been focused on providing 

computing for the individual, the emphasis is now firmly connectivity, 

communication, and collaboration. 

 

 Virtual Work. Mobile multimedia technologies make it possible for businesses to 

reinvent the traditional workplace from an office-based activity to a virtual one. 

Employees can collaborate closely in real time with other employees, customers, or 

partners regardless of anyone’s location. 

 

 Extending organizational boundaries. Extranets connect businesses to their customers 

and supply chain partners. As high band-width networks become increasingly 

common, collaborative networking solutions are available for companies of any size. 

 

 Single view of truth. Information silos are the bane of most of the organizations as 

they try to integrate and share data to get a clearer understanding of customers 

products, and other objects of interest. Regulatory compliance, performance 

management, and collaborative business relationships demand a single view of 

relevant information, 

 

 Social and ethical issues. Social networks are redefining the way people 

communicate. Tools that are meant to improve the productivity and quality of life in 

general can also intrude on the personal lives of managers and employees. 
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FIG.1 ETHICAL ISSUES OF INFORMATION SYSTEM 

9.2.2 Ethical Issues 

Ethics may be understood as the principles of right and wrong of the individuals or society 

choose to guide their behaviour. In other words, ethics may be referred as publicly accepted 

norms of behaviour for social engagement. Some proponents claim that ethics are the moral 

rules and codes that are agreed upon to be followed in the society. These moral norms or 

rules may be derived from a particular or a group of religion, and/or an ethos of community. 

Thus, the ethics may differ from one society to that of the other society. Ethics (the widely 

accepted norms of the society) should not be confused with the term legal. What is legal is 

determined by the law of the land, which is generally more explicit and written. Further, any 

legal issue is decided by the system of justice of the country. Whereas ethics are not that 

explicit and written down; they are loosely described rules of conduct and thus act as 

guidelines for the expected ethical behaviour. Though the ethical issues are not the creations 

of the information systems and are not of recent origin, they have been there since long. 

Nevertheless, information technology has heightened ethical concerns. The following ethical 

issues are of concern these days, which have been portrayed in Figure 1. 
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i. Private Data 

ii. Workplace monitoring 

iii. Power of IS professionals over other users. 

9.2.2.1 Private Data 

 The information systems are gathering huge data that may pertain to the employees, 

customers, suppliers or any other stake-holder. This data may be very personal to these 

people and may be very sensitive that needs to be protected and thus handled very carefully. 

For example, the hospital information systems keep a record of the details of the diseases and 

the treatments of their patients; e-commerce sites capture personal details of a customer; e-

governance sites such as income tax department, passport department, etc. capture personal 

details of its citizens. HR information systems collect a lot of personal details of its 

employees. The ethical issues regarding the private data are whether this data relates to the 

person or to the concerned organization and thus whether the organization can use private 

data related to a person for its decision-making/profit making. The answer to this relevant 

ethical issue varies from country to country. 

It is important that the organizations as well as the concerned governments of the respective 

country should have clear policies/laws in place so that the personal data may not be misused. 

9.2.2.2 Workplace Monitoring 

Monitoring at the work place has been established method of controlling the performance and 

the behaviour of the employees. The employees are required to conform to certain work 

norms so as to achieve the pre-determined objectives. The management of an organization 

argues that the employees are required to have a close watch and supervision so as to ensure 

the desired behaviour from their employees that would in turn help achieve the targets of the 

organization. However, the other school of thought on the workplace monitoring opines that 

close supervision leads to loss of privacy and confidence of the employees. 

The increased use of information systems has increased the scale and precision of monitoring 

of employees in the organization. For example, the BPO companies digitally record and save 

conversations of their employees to analyse whether the call was answered as per the 

prescribed norms. However, internet technology has posed new challenges for the workplace 

monitoring that has led to the loss of individual privacy. The complex nature of the 

information systems has made the question of ownership of data complicated, as the 
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information sent over these networked information systems may pass through many different 

computer systems before it reaches final destination, and each of these systems is capable of 

creating, monitoring and storing data. The following examples illustrate the privacy issue: 

i. Some companies monitor employee emails and web surfing activities to minimize the 

wastage of their productive time during office time. 

ii. The movement of the employees is captured from the security systems that use swipe 

cards for opening the office doors. 

iii. The time spent by the employees may also be monitored from the log of the computer, 

where the work is computer intensive and they require logging in every time they 

want to work in the office. 

Internet challenges to privacy 

These days, many organizations are doing business using the internet-based information 

systems and thus many people including customers, suppliers, and the citizens use these 

information systems for their transactions. There are various tools that can monitor the visits 

of users to the websites. The websites can capture the identities of the visitors, once they 

register voluntarily at the site either to purchase a product or service or when they are offered 

free services/products. By using cookie technology, the websites can also capture data about 

the visitors without their knowledge or consent. Cookies are small files that are stored on a 

computer hard drive when a user surf the websites. These files identify the web browser of 

the user and track the visits to the website. For example, when a customer is surfing an e-

commerce site wanting to purchase some item, the cookies would help to keep a track of 

what the user wants, help the user in making the payments and enable the user to move to 

other sites and return back to the website from where the user has made selection of some 

items. However, the users can either enable or disable the cookies in the browsers. 

Cookies pose a great threat to the privacy of the users as the cookies help companies know 

the visitor’s behaviour. Once the companies know the visits to a website by the user, it can 

target the advertisements at the visitor. Cookies data may also be combined with other data 

obtained from other sources such as websites where the user has registered or offline data 

collected from surveys, etc. to know the identity and develop a detailed profile of the visitors. 

Similarly, spyware, which is a small file having some malicious software/ programme that is 

either installed secretly or get installed on the users’ computer to invade the privacy of the 

user by monitoring the activity of the user on the computer. The spyware can also report the 
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sites without the knowledge of the users. A typical spyware may get itself installed through 

the email or through the web browser. 

In view of these challenges, there is a need to formulate adequate policies for the 

organizations so that the users are aware of such a monitoring and also have proper rules/laws 

in case of the exploitation of the individual privacy of the people. 

9.2.2.3 Power of IS professionals over other users 

Information systems are developed and managed by the IS professionals with technical 

knowledge and the users, generally, do not have this technical knowledge. As a result, IS 

professionals, many a times use the power of technical knowledge over the other users in the 

organization. A person would be known to have power over the other person if he/she is able 

to influence the behaviour or thinking of the other person. It has been observed that IT 

professionals many a times influence the thinking or behaviour of the other users and make 

them to listen to and agree to what they say. Since the user, many a times is dependent on the 

IT technology, the IT professionals even go to the extent of dictating terms to the user and 

thus control their behaviour of using information systems. This is known as exercising the 

Power of IS professionals over other users. For example, the consultants who are appointed to 

implement ERP system in an organization, may not listen to the users for their genuine 

requirements for the customization of the system pretext on technical grounds. The exercise 

of power of IS Professionals over other users may be unintentional where both the parties are 

unaware of this exercise of this power. In the case when both the user and the IT 

professionals are aware of the power exercise situation, both the parties would negotiate to 

come to a solution. In still another situation, where the user is not aware of the power 

exercise, this would result into power manipulation by the IT professional. However, if the 

user is aware and the IS professional is not aware of such a situation, then it may lead to the 

resistance of the user. The ethical issues arise in situations where either party is unaware of 

the power exercise, 

Organizations should sensitize all the users as well as the IT professionals in the organization 

so that no one feels that they are being dominated by the other party. Similarly, IT 

programmes and training programmes organized for such people need to sensitize the IT 

professional on this issue. Instead of giving technical reasons, they need to provide logic that 

why a particular process cannot be changed or has to be accepted by the users. 
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9.2.3 Social Issues  

Information systems impact the individuals and the society in a number of ways. The 

negative socials costs of implementing information technologies have already started 

showing up. Information systems, despite many benefits, can damage our culture and society 

in a big way. Some of the negative social consequences of these information systems are 

discussed as below and shown in figure 2 

i. De-skilling 

ii. Alienation and loss of confidence 

iii. Resistance to ISs 

iv. Health risks 

v. IT eco-system 

 

FIGURE 2. SOCIAL ISSUES OF INFORMATION SYSTEMS 
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9.2.3.1 De-skilling 

With the new information system in place, the employees may be required to forget or 

unlearn some of the skills that were required to with the annual or old systems. This process 

of losing the skills because of the new systems is referred to as de-skilling. For example, with 

the dependency of children of the computer systems, their ability to calculate numbers is 

decreasing. Similarly, the employees who used to work with the manual systems were 

supposed to arrange the files region-wise, product-wise, year-wise and so on and read the 

labels of the files to locate the files quickly and were also required to remember the content 

of these files so as to get the right file. However, with the new computerized information 

system, employees do not need this skill as information system will take care of these 

aspects. 

In order to develop the skills which are necessary for the overall development of the users, 

there should be more focus on improving the analytical and aptitude skills and thus more 

programmes need to be organized where the employees find challenges in solving problems 

requiring mental and logical abilities. 

9.2.3.2 Alienation and loss of Confidence 

As the people start doing more tasks using the information system and with the new 

information systems in place, they may not be doing tasks that require meetings and 

discussions with people. Slowly, their interaction with the colleagues would decrease. Even it 

may lead to spending of their lesser time with family members, friends, etc.  

It results alienation among individuals and the lack of socialization may lead to loss of 

confidence among the individuals.  

Organizations should develop more and more programmed/ organized social events also as to 

increase the interaction among the employees.  

9.2.3.3 RESISTANCE TO ISs 

Generally, it is found that whenever an organization wants to implement a new information 

system, it is resisted by the users. This resistance is not because of new technology; rather 

People resists this change because of other reasons that may include  

 Fear of loss of job 

 Fear of loss of athourity  
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 Changed social relations 

 Fear of learning new technology  

 

These reasons for the resistance to change may be reflected in the form of non cooperation in 

the implementation of new information system; denial to use the new information system; 

finding faults with the new systems; sabotaging of the system; damaging the system and even 

preventing others from using of the system.  

Organizations should not forget that the biggest enable of an inormation system are the 

people and any resistance is going to the detrimental for the organization as well as for the 

other stake holders. The social/behavioural aspects of the information systems are required to 

be understood properly before the implementation of the information system.  

9.2.3.4 Health risks  

Working with information system for long hours leads to several health issues. For example, 

the employees, who use computer/ laptop screens for long hours while working with 

information systems for a long time, develop back pain, eye stain, wrist injuries and posture 

problems, etc. It may further lead to mental stress.  

Organizations need to develop policies on the right use of computer/ equipment. They should 

design the equipment and the supporting furniture based on ergonomics design to take care of 

the convenience and comfort of the users. Wellness and rohranmes can also help taking care 

of the employee’s health.  

9.2.3.5 IT ECO-SYSTEM 

The information technology ecosystem comprises hardware, networking equipment, 

computer embedded machines, and software. For developing and using of these information 

systems, many human activities such as research and design, production, assembly, 

packaging, transportation retailing, etc. are required to be exercuted.Similarly, the need users 

also engage in activities such as using, buying, and the eventual disposition of these IT 

components. All these activities create significant environmental problems and this are 

significantly affecting the natural ecosystem of this Planet. Due to the explosive growth in 

global demand for IT, it is increasingly consuming large amounts of energy and natural 

resources. Furthermore, in the field of IT, the rate of obsolescence is very high, and the 
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refresh cycle for IT equipment is relatively short. AT the same time, the users want to 

constantly update their equipment with newer, fancier ones, even though the older equipment 

is often still working. The disposal of all the un-needed electronic devices, which contain a 

lot of toxic substances, creates a huge problem due to the toxic chemicals contained in its 

hardware.  

Organizations need to drastically reduce the amount of energy spent, for which they need to 

implement IT sustainability programmed. The manufacturing companies need to focus on 

developing efficient technology products. Keep e-waste out of landfills and adopt recycle and 

reuse programmes. Using more efficient technology can help consume fewer resources and 

emit less waste. Server virtualization has been found to be an effective strategy to bring 

technologically improved and energy efficiencies to computer hardware. A social movement 

is needed to encourage all organizations and individuals for judicious use of IT products. 

They need to be sensitized that any unnecessary use cause energy waste, and depletion of 

natural resources and energy emission of carbon-di-oxide. To achieve savings in electricity 

consumption, the utility companies should provide helpful tips on how to save energy in 

using computers, printers and lots of other electronics equipment for office and household 

use.  
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10.0 OBJECTIVES 

After studying the Unit, students will be able to  

 Know the fundamentals of database concepts.  

 Understand and apply principles of storing the large amount of data. 

 Understand and apply the various data base languages. 

  Identify and analyze requirements for information systems. 

 Identify the basic components of Data Base Management Systems. 

  Conceptualize the difference between File oriented data base and data Base Management    

System. 

 

10.1 Introduction 

•  A database-management system (DBMS) is a collection of interrelated data and a set 

of programs to access the data. This is a collection of related data with an implicit 

meaning and hence is a database. 

•  The collection of data, usually referred to as the database, contains information relevant 

to an enterprise. 

•  The primary goal of a DBMS is to provide a way to store and retrieve database 

information that is both convenient and efficient. 

•  By data, we mean known facts that can be recorded and that have implicit meaning. For 

example, consider the names, telephone numbers, and addresses of the people you know. 

You may have recorded this data in an indexed address book, or you may have stored it 



on a diskette, using a personal computer and software such as DBASE IV or V, 

Microsoft ACCESS, or EXCEL. 

•  A datum - a unit of data - is a symbol or a set of symbols which is used to represent the 

raw facts and figures. 

•  This relationship between symbols and what they represent is the essence of what we 

mean by information. Hence, information is interpreted data - data supplied with 

semantics. Processed form of data is known as Information. 

•  Knowledge refers to the practical use of information. 

•  While information can be transported, stored or shared without many difficulties the 

same cannot be said about knowledge. Knowledge necessarily involves a personal 

experience. 

•  Referring back to the scientific experiment, a third person reading the results will have 

information about it, while the person who conducted the experiment personally will 

have knowledge about it. 

•  Database systems are designed to manage large bodies of information. 

•  Management of data involves both defining structures for storage of information and 

providing mechanisms for the manipulation of information. 

• In addition, the database system must ensure the safety of the information stored, despite 

system crashes or attempts at unauthorized access. If data are to be shared among several 

users, the system must avoid possible anomalous results. 

•  Because information is so important in most organizations, computer scientists have 

developed a large body of concepts and techniques for managing data. 

•  These concepts and technique form the focus of this book. This chapter briefly 

introduces the principles of database system. 

 

10.2 EVOLUTION OF DATA BASE SYSTEM 

With the advent of civilization, advancement of living standards, the spread of education, 

sharing of knowledge and industrial revolution, the need of record keeping also evolved, which 



included the areas of monetary and non monetary transaction. The records we kept in simple 

plain text or in some formatted manner. 

We, in our daily routine life to maintain the record of one or more activities we may or may 

not putting it on papers. Since our memory is limited by its capacity we tend to put it on the 

papers, those records which are important shall be required for future referencing or for analysis 

or otherwise. 

In the context of Data Base to put the records on the paper is storing of the data and calling 

the records in the future is called retrieving of the data. 

Data Base: A Data Base is the collection of related information. So that it is available to 

many users for different purpose. In late 1950 some companies proposed the notation of 

generalized access to electronically stored data. Here, it becomes relevant to define this notion of 

generalized access. Generalized access means the method by which all sort of data may be read 

and manipulated. In 1960s the two basic models of data storage and retrieval evolved. First was 

the network data model developed by Conference in Data System Language Data Base Task 

Group (CODSYL DBTG) and the Hierarchical data model.  

 

10.3 DATA PROCESSING VS. DATA MANAGEMENT SYSTEMS 

•  Data Processing and Data Management Systems both refer to functions that take raw 

data and transform it into usable information, the usage of the terms is very different. 

•  Data Processing is the term generally used to describe what was done by large 

mainframe computers from the late 1940‟s until the early 1980‟s (and which continues 

to be done in most large organizations to a greater or lesser extent even today): large 

volumes of raw transaction data fed into programs that update a master file, with fixed-

format reports written to paper. 

•  Data Management Systems refers to an expansion of this concept, where the raw data, 

previously copied manually from paper to punched cards, and later into data-entry 

terminals, is now fed into the system from a variety of sources, including ATMs, EFT, 

and direct customer entry through the Internet. 



•  The master file concept has been largely displaced by database management systems, 

and static reporting replaced or augmented by ad-hoc reporting and direct inquiry, 

including downloading of data by customers. 

•  The ubiquity of the Internet and the Personal Computer have been the driving force in 

the transformation of Data Processing to the more global concept of Data Management 

systems. 

 

10.4 CONCEPT OF DATA AND INFORMATION 

DEFINITION 

10.4.1 Data  

Data means facts and figures which itself has no meaning but it helps to make the facts and 

figures meaningful. It can be anything like name of person, place or thing. 

 Example weight, cost, price tax code etc. 

 

10.4.2 Information  

The processed form of the data is called information. After processing of the data it 

produces some surprise value which is very useful for the receiver. After getting the information, 

one can make certain decision and may take certain action. 

 For the decision to be meaningful, the processed data must qualify the following 

characteristics like: 

1. Timely: Information must be on time. Late information is of no use. 

2.  Accuracy: Information must be correct.  

3.  Complete: It should be complete. Incomplete information sometimes produce wrong 

signal.   

4.  Information must be given to the right person. 

Data is converted into a more useful or intelligible form. It is the set of data that has been 

organized for direct utilization of mankind, as information helps the human beings in their 



decision making process. Like Time Table, Merit list, Report card, Pay slips etc. The information 

is obtained by assembling items of data into a meaningful form. 

Example of data and information 

Marks obtained in different subjects in particular examination of a student acts as data. By 

processing this data, result may be obtained. The result is information. On the basis of the result 

student is declared pass or fail. 

Hence, from the above it is clear that data and information are not same. 

10.4.3 Need of Information 

Modern civilization has become so complicated and sophisticated that to survive one has to 

be competitive, this compels the people to keep himself informed of all types of happenings in 

the society. Modern business management system has also rendered itself to bulk collection of 

data from various sources, that needs to rearranged in a fashion so that it can be utilised with 

minimum possible time. This needs a high amount of filing either at the data stage or at the 

information stage: 

Information is needed 

(1) To keep the system update. 

(2) To gain the knowledge about the surroundings and whatever is happening in the 

society. 

(3) To know about the rules and regulation. 

(4) Based on the above three, we conclude that the information helps in planning current 

and prospective action in the process of forming, running and protecting a process or 

system. 

10.4.4 Data Item (Field) 

A set of characters which are used together to represent a specific data element e.g. Name of 

the student in a class is represented by the data item say NAME. 

10.4.5 Record 

Record is the collection of related data items. 

 



10.4.6 File 

File is the collection of various records. It is the basic unit (logical) storage in the computer 

system 

Example: 

Consider the SALARY file. 

SALARY: File 

Here Data items are 

Sr. No., Name, Basic,  DA,  HRA,  Total 

Record 

1. Mayanak 10,000 2500 100 12600 

10.4.7 Data Aggregate 

It is collection of data items within a record, which is given a name and is referred to as a 

whole. 

Example date may be composed of the data items month, day and year. 

10.4.8 Metadata 

Meta data describes the properties or characteristics of other data. In simple terms it is data 

about data. It includes Entity name, Field names, their data type, size and etc. 

 

10.5   FILE ORIENTED APPROACH 

•  The earliest business computer systems were used to process business records and 

produce information. 

•  They were generally faster and more accurate than equivalent manual systems. These 

systems stored groups of records in separate files, and so they were called file 

processing systems. 

•  In a typical file processing systems, each department has its own files, designed 

specifically for those applications. 



•  The department itself working with the data processing staff, sets policies or standards 

for the format and maintenance of its files. 

•  Programs are dependent on the files and vice-versa; that is, when the physical format of 

the file is changed, the program has also to be changed. 

•  Although the traditional file oriented approach to information processing is still widely 

used, it does have some very important disadvantages. 

 

10.6 DATA BASE APPROACH 

•  In order to remove all limitations of the File Based Approach, a new approach was 

required that must be more effective known as Database approach. 

•  Database approach is a computer based storage technology in which related data is 

shared by various application programs.  

•  It is an improvement of traditionally file-based approach of storing data or information.  

•  It is characterized by a database management system and one or more databases. 

•  The database is a collection of related data stored in the database server, the data will be 

stored in the table.  

•  The main purpose of the database to provide a method for storing and retrieving data in 

a database quickly and efficiently.  

•  It is a single state stores data defined once and then access to multiple users.  

•  The main features of the database approach is that the database system contains not only 

data, but contains a complete definition or description of database structure and 

constraints.  

•  This definition is stored in the system directory, which contains information about the 

structure and definitions in the database. 

•  The information stored in a directory called meta-data that describes the database.  

•  Therefore, this approach will work on any database type, for example, the database 

security, airlines, banking data, financial data and company information database.  

• A database system allows several users to access the database concurrently. 



• Answering different questions from different users with the same (base) data is a central 

aspect of an information system.  

• Data capturing and data storage is not redundant, the system can be operated from a 

central control and the data can be updated more efficiently.  

• The database approach is that the database system does not only contain the data but 

also the complete definition and description of these data. These descriptions are 

basically details about the extent, the structure, the type and the format of all data and, 

additionally, the relationship between the data.  

• This kind of stored data is called metadata (“data about data”).  

• Data integrity is a by word for the quality and the reliability of the data of a database 

system.  

• In a broader sense data integrity includes also the protection of the database. 

• Data reflect facts of the real world. Logically, it is demanded that this reflection is done 

correctly. A DBMS should support the task to bring only correct and consistent data into 

the database.  

• Additionally, correct transactions ensure that the consistency is maintained during the 

operation of the system. 

• In a DBMS all data is maintained as long as it is not deleted explicitly. 

• The life span of data needs to be determined directly or indirectly be the user. 

 

10.7 CHARACTERISTICS OF DATABASE APPROACH 

1. Increase data share ability: Large organizations, such as insurance companies, banks, 

local councils and manufacturing companies, have for some time been putting large 

amounts of data onto their computer systems. Frequently, the same data was being 

collected, validated, stored and accessed separately for a number of purposes. For 

example, there could be a file of customer details for sales order processing and another 

for sales ledger. This „data redundancy‟ is costly and can be avoided by following a 

database approach. In fact some data duplication is reasonable in a database 

environment, but it should be known, controlled and be there for a purpose, such as 



efficient response to some database queries. However, the underlying data should be 

collected only once, and verified only once, so that there is little chance of 

inconsistency. With conventional files, the data is often collected at different times and 

validated by different validation routines, and therefore the output produced by different 

systems could well be inconsistent. In such situations the data resource is not easily 

managed and this leads to a number of problems. With reduced redundancy, data can be 

managed and shared, but it is essential that good integrity and security features operate 

in such systems. In other words, there needs to be control of the data resource. 

Furthermore, each application should run „unaware‟ of the existence of others using the 

database. Good share ability implies a ready availability of the data to all users. The 

computer system must therefore be powerful enough so that performance is good even 

when there are a large number of users  concurrently accessing the database. 

2. Increase data integrity: In a shared environment, it is crucial for the success of the 

database users accessing the database, there must be some control to prevent failed 

transactions leaving the database in an inconsistent state. However, this should be easier 

to effect in a database environment, because of the possibilities of central management 

of the data resource, than in an environment where each application sets up its own files. 

Standards need only be agreed and implemented once for all users. 

3. Increase speed of implementing applications: Applications ought to be implemented 

in less time, since systems development staff can largely concentrate on the processes 

involved in the application itself rather than on the collection, validation, sorting and 

storage of data. Much of the data required for a new application may already be held on 

the database, put there for another purpose. Accessing the data will also be easier 

because the data manipulation features of the database management system will handle 

this. 

4. Ease data access by programmers and users: Early database management systems 

used well-known programming languages such as Cobol to access the database. Cobol, 

for example, was extended to include new instructions, which were used when it was 

necessary to access data on the database. However we now have specific database query 

languages, such as SQL, and other software tools that ease the process of applications 



development in a database environment. Once the database had been set up, applications 

development time should be greatly reduced. 

5. Increase data independence: There are many aspects to data independence. It is the 

ability to change the format of the data, the medium on which the data is held or the data 

structures, without having to change the programs that use the data. Conversely, it also 

means that it is possible to change the logic of the programs without having to change 

the file definitions, so that programmer productivity is increased. It also means that there 

can be different user views of the data even though it is stored only once. This 

separation of the issues concerning processes from the issues concerning data is a key 

reason for opting for the database solution. It provides far greater flexibility when 

compared to conventional file-based applications. 

6. Improve standards: Applications tend to be implemented by different project teams of 

systems analysts and programmers and it has been difficult to apply standards and 

conventions for all applications. Computer people are reputed to dislike adopting the 

norms of the firm, and it is difficult to impose standards where applications are 

developed piecemeal. With a central database, it is possible to impose standards for file 

creation, access and update, and to impose good controls, enabling unauthorized access 

to be restricted and providing adequate back-up and security features. 

 

10.8 DEFINITION OF DATA BASE MANAGEMENT SYSTEM 

Data Base: It is the collection of occurrence of multiple, but related files, containing the 

relationship among the records, data aggregates and data items. 

Management : Management means planning, organizing and controlling. 

 (i) Planning Means the task to be performed. 

 (ii) Organizing Means tackling the available resources. 

 (iii) Controlling To control the working of all the components of the  

system. 

In context of Data Base Management we mean management of the data base which includes 

the services like data description, data manipulation and data control. In short we abbreviate it as  



DDL : Data Definition Language 

DML : Data Manipulation Language 

DCL : Data Control Language 

System : System means organized relationship among the different components of the data 

base. 

“System is an orderly grouping of interdependent components linked together according to 

a plan to achieve a specific goal.” 

Combining Data base Management system, is combination of all the above components 

and we derive the one definition of DBMS as data base management system is a software 

system which is used for defining, constructing and controlling the data base. 

By defining a data base it involves specifying the type, its structure and the constraints for 

the data to be stored in the data base. 

By constructing we mean storing the data on some storage medium that is     controlled by 

DBMS. 

By controlling the data base means defining authorization for user and defining their 

access to the right person. 

 

10.9 NEED FOR DATA BASE MANAGEMENT SYSTEM 

Historically, information system involved the development of standalone systems for 

separate application with their own set of file. This means that data such as addresses may be 

duplicated in many separate systems such as employee‟s address once in the payroll system and 

again in personal file. This causes wastage of space and inconsistency. There may be possibility 

for the address to be updated in one system but not in the other and hence making the data 

inconsistent. 

To cope up with the above problem, development of data base approach evolved. In the data 

base approach, an organization attempts to build an integrated data base to support all the data 

requirement of the organization. A DBMS is like a suitcase where all the stuff (data) is put so 

that it is available at one place and easy to access. 



 

10.10 CHARACTERISTICS OF DBMS 

The following are the characteristics of DBMS : 

 1. Minimal Redundancy: Redundancy means duplicacy. In file system each application 

has its own private file. This will result duplicacy and there is a wastage of space. For 

example a personal application and an educational records application may each have its 

own file containing department information for employees. These two files can be 

integrated and the redundancy can be eliminated if the DBA is aware of data 

requirement for both applications. 

 2. Sharing of Data: Sharing of data allows the existing application to use the stored data 

base. It also helps in developing the new application, which will use the same stored 

data. Due to shared data, it is possible to satisfy the data requirement of new application 

without having to create new data. For example in banking the account holder‟s name 

and address can be shared by all the departments. As a result, any change in the current 

account policies can be implemented virtually with no change in the table structure. 

 3. Inconsistency can be Avoided: This is the result of the minimum redundancy. If there 

is no duplicacy or minimum duplicacy it will automatically lead to consistency or 

inconsistency can be avoided. 

  Suppose that an employee E7 works in department D3 is represented by two different 

entries in the data base and that in system is not aware of this duplicacy. Then there will 

be some occasion on which the two entries will not agree. At that time data base is said 

to be inconsistent obviously that data base is in inconsistent state or conflicting the 

information.  

 4. Standard can be Enforced : With the central control of the data base, the DBA can 

ensure that all the applicable standards are followed in representation of the data such as 

format of data items, convention on data name, documentation standard etc. which will 

result in uniformity of the data base as well as its usage. 

 5. Improvement in Data Security: In the data base system data must be secured and 

private. Data security refers to the protection of data against accidental or intentional 



discloser to the unauthorized user. Security is highly complex subject because there are 

so many different aspects to it. The following are essential for data security: 

 (i)  Data should be reconstruct able. 

 (ii)  Data should be auditable. 

 (iii)  System must be able to check user‟s actions whether they are authorized or 

unauthorized. 

 (iv)  Users action should be monitored minutely. 

 (v)  Data should be protected from theft, fire or other form of destruction. With the help 

of DBMS the Data Security can be prevailed. 

 6. Better Interaction with the User: DBMS often provides better interaction to the user. 

In conventional system, usually the information is poorly arranged and as a result the 

availability of data is very poor. 

  However in case of DBMS, the availability of up to date information improves the 

interaction and the data can now be shared. DBMS makes it easy to respond to 

unforeseen information request. Centralizing the data in a data base also means that user 

can obtain new and combined information that would have been impossible to obtain 

otherwise. In addition, use of DBMS allows the users, who do not know programming, 

to interact with the data more easily. 

 7. Efficient System: It is very common to change the contents of stored data. These 

changes can easily be made in DBMS than in a conventional system as these changes do 

not need to have any efficiency impact on application program. It will also increase the 

efficiency of the system. 

 8. Faster Development of New Application: When a new application is proposed, it is 

likely that the data required is already stored in the data base. Therefore, development 

time is reduced as no file creation phase is required for new application. 

 9. Data Migration: With the help of DBMS tool one can transfer the data from one to the 

other table very easily. The rarely accessed data can be stored in a cheaper fashion. 



 10. Tunability: Adjusting a data base to improve its performance is referred to as tunability. 

The DBA is responsible for the tuning and the operation of data base. Effective Tuning 

has two requirements: 

 (i)  Physical data base independence is necessary. 

 (ii) Automatically monitoring of the usage of data base so that appropriate adjustment 

can be made. 

 

10.11 TRADITIONAL FILE PROCESSING ENVIRONMENT 

The earlier business computer system were used to process the business records and 

produce the information. They were generally faster and more accurate than equivalent manual 

system. These systems store group of records in a separate file so they are called file processing 

systems. In a typical processing system, department has its own files designed specifically for 

those application.  

Programs are dependent on files and vice-versa i.e. when the physical format of the file is 

changed, the program has also to be changed. Although the traditional file-oriented approach to 

information processing is still widely used, it does have some disadvantages. 

 

10.12 LIMITATIONS/DISADVANTAGES OF TRADITIONAL FILE PROCESSING 

SYSTEM 

The disadvantages of the Traditional file system are: 

1. Duplicate data: Since all the files are independent of each other. Some files are stored 

in more than one file. 

2. Inconsistency: In file processing system, data is not consistent. If a data item is to be 

changed then all the files containing that data need to be updated. The problem arises 

that all the files might not be updated causing inconsistency. 

3. Poor Data Integrity: A collection of data has integrity, if data is logically consistent 

that is the duplicate data item agree with one another. In a file processing system, poor 

data integrity often develops. 



4. Data is Isolated and separated : If it is needed to extract data from two different files, 

it will be required to determine which parts of each of the files are needed, then 

question arises how the files are related to one another ? 

5. Poor Data Security: Data is stored in different files causing the security problem. 

6. Difficult to represent complex object: Some data object may be of variable length 

which produce difficulty in representation of files. 

7. Incompatible File Forma : Each programmer stores the data in the file in the format as 

per the choice as there is no standard file format for storing the file. It becomes very 

difficult to handle the different file in different format. 

8. Data Dependency: Data dependence means it is impossible to change storage structure 

without affecting the application program. 

9. Lack of Flexibility : In traditional file system, programmes are already told about 

which type of queries need to be answered by the application, and programme code that 

query using the data files for that application only. 

 

10.13 COMPONENTS OF DATA BASE 

There are four components of data base 

1. Data 2. Hardware   

3. Software 4. User 

1. Data: Data stored in the system is partitioned into one or more data base. A data base 

0both integrated and shared. By „integrated‟ we mean that the data base may be thought 

of as a unification of several data files. By „shared‟ we mean that individual piece of 

data may be shared among several different users. 

2. Hardware: The hardware consists of secondary storage volumes disks, drums etc. on 

which the data base resides together with the associated devices, control with channel 

and so forth. 

3. Software: Between the hardware and user there is a layer of software usually called as 

data base management system „„DBMS‟‟. All the request from the user is handled by 

the DBMS. 



4. Data Base User: There are three classes of user. 

 (i) Application Programmer: They are responsible for writing the application 

programs that uses the data base. In typical data base we use the language COBOL 

or PL/I to meet the requirement. 

 (ii) End User: These type of the users access the data base from the terminal. There 

are two types of end user. 

  1. Casual user  2. Naive user. 

 (iii) Data Base Administrator (DBA): DBA is a person or group of persons 

responsible for the overall control of the data base. The Database Administrator 

requires both Technical and Managerial knowledge. 

 

10.14 DATA BASE ENVIRONMENT 

In contrast to the file environment, the integrated data base environment has a single large 

repository of data called the data base, which is used simultaneously by many users. All the files 

are shared by the different users. It is managed by an individual (or groups) called the data base 

administrator (DBA), who is responsible for designing, creating and maintaining the data base to 

satisfy the need of users. All access to the data base is controlled by a sophisticated software 

package called data base management system (DBMS). 

•  Database system refers to a set of components that define and control the collection, 

storage, management and use of data. 

• It is composed of five major parts hardware, software, people, procedures and data. 

1. Hardware: Hardware refers to all of the system‟s physical devices; for example, 

computers storage devices, printers, network devices and etc. 

2. Software: To make the database system work properly, three types of software are 

needed: operating system, DBMS software, and application programs. 

(a) Operating system: It manages all hardware components and allows other software to 

run on the computers. Examples of operating system software include Windows, Linux 

and etc. 



(b) DBMS Software: It manages the database within the database system. Some examples 

of DBMS software include Oracle, Access, MySql and etc. 

(c) Application Programmer: These are used to access and manipulate data in the DBMS 

and to manage the computer environment in which data access and manipulation take 

place. Application programs are most commonly used to access data to generate 

reports. Most of the application programs provide GUI. 

3. People: This component includes all users of the database system. According to the job 

nature, five types of users can be identified: systems administrators, database administrators, 

database designers, systems analysts and programmers, and end users. 

10.14.1. Users of Database Environment 

According to the job nature, there are five types of users that can be identifie : 

(a) System administrator: They supervise the database system‟s general operations. 

(b) Database administrator: They are also known as DBAs. They manage the DBMS and 

ensure that the database is functioning properly. 

(c) Database designers: They design the database structure. They are the database 

architects. As this is very critical, the designer‟s job responsibilities are increased. 

(d) Systems analysts and programmers: They design and implement the application 

programs. They design and create the data entry screens, reports, and procedures 

through which end users can access and manipulate the data. 

(e) End users: They are the people who use the application programs to run the 

organization‟s daily operations. For example, sales-clerks, supervisors, managers are 

classified as end users.   

4. Procedures: Procedures are the instructions and rules that supervise the design and use 

of the database system. Procedures are a critical component of the system. Procedures play an 

important role in a company because they enforce the standards by which business is conducted 

in an organization  

5. Data: Data refers the collection of facts stored in the database. 

 

 



10.15 ADVANTAGES OF USING THE DBMS APPROACH 

1. Controlled Redundancy  

 • In the file processing approach, each user defines and implements the files needed 

and software applications to manipulate those files. 

 • Various files are likely to have different formats and programs may be written in 

different languages and same information may be duplicated in several files. 

 • Data redundancy leads to 

  – Wasted storage space 

  – Duplication of effort (when multiple copies of a datum need to be updated), 

  –  Higher likelihood of the introduction of inconsistency. 

 • Database design stores each logical data item at one place to ensure consistency and 

saves storage. 

 • But sometimes, controlled redundancy is necessary to improve the performance. 

 • Database should have capability to control this redundancy & maintain consistency 

by specifying the checks during database design. 

2. Multiple user interfaces 

 • DBMS provides a variety of user interfaces for the users of varying level of technical 

knowledge. 

 • These includes query language for casual users, programming language interfaces 

for application programmers, forms and command codes for parametric users, menu 

driven interfaces and natural language interfaces for stand alone users etc 

3. Providing Backup & Recovery 

 • Data should be restored to a consistent state at the time system crash and changes 

being made 

 • If hardware or software fails in the middle of the update program, the recovery 

subsystem of DBMS ensures that update program is resumed at the point of failure. 

4. Restricting Unauthorized Access 

 • A DBMS provides a security and authorization subsystem, which is used by DBA to 

create user accounts and to specify restrictions on user accounts. 



 • File processing system provides password mechanism and very less security which 

is not sufficient to enforce security policies like DBMS. 

5. Providing Persistent Storage for Program Objects 

 • Object oriented database systems are compatible with programming languages such 

as C++ and Java. 

 • A DBMS software automatically performs the conversion of a complex object which 

can be stored in object oriented DBMS, such an object is said to be persistent due to 

its survival after the termination of the program. 

6. Providing Storage Structures for Efficient Query Processing 

 • The DBMS utilizes a variety of sophisticated techniques (view, indexes etc.) to store 

and retrieve the data efficiently that are utilized to improve the execution time of 

queries and updates. 

 • DBMS provides indexes and buffering for fast access of query result, the choice of 

index is part of physical database design and tuning. 

 • The query processing and optimization module is responsible for choosing an 

efficient query execution plan for each query submitted to the system. 

7. Representing Complex Relationships among data 

 • A DBMS must have the capability to represent a variety of complex relationship 

among the data, to define new relationships as they arise, and to retrieve and update 

the related data easily and efficiently. 

8. Enforcing Integrity Constraints 

 • The DBMS have certain integrity constraints that hold on data. 

 • These constraints are derived from the meaning of the data and of the miniworld. 

 • Some constraints can be specified to the DBMS at the time of defining data 

definitions and automatically enforced. 

 • Database does not allow violation of constraints at the time of updating the database. 

9. Permitting Inference and Action Using Rules 

 • Deductive database systems provide capabilities for defining deduction rules for 

inference new information from the stored database facts. 



 • Triggers can be associated with tables. 

 • A trigger is a form of a rule activated by updates to the table, which results in 

performing some additional operations to some other tables, sending messages and 

so on. 

 • Stored procedure can also be used as a part of the overall database definition and are 

invoked appropriately when certain conditions are met. 

 • Active database provides more powerful functionality by providing the active rules 

that can automatically initiate actions when certain events and conditions occur. 

 

10.16 CLASSIFICATION OF DBMS 

The DBMSs can be classified into different categories on the basis of several criteria such  

•  Based on data model  

• Based on number of users  

• Based on number of sites  

• Based on purpose  

1. Based on Data Model : 

 • The various data models used in the DBMSs can be classified as Hierarchical, 

network, relational, object-oriented, and object-relational.  

 • Among these, the hierarchical and network data models are the older data models 

and now known as legacy data models.  

 • Some of the old applications still run on the database systems based on these models.  

 • Most of the popular and current commercial DBMSs are based on relational data 

model.  

 • The object-based data models have been implemented in some DBMSs; however, 

have not become popular.  

 • Due to the popularity of relational databases, the object-oriented concepts have been 

introduced in these databases that led to the development of a new class of DBMSs 

called object-relational DBMSs. 

 



2. Based on Number of Users :  

 • Depending on the number of users the DBMS supports, it is divided into two 

categories, namely, single-user system and multi-user system. 

 • In single-user system the database resides on one computer and is only accessed by 

one user at a time.  

 • The user may design, maintain, and write programs for accessing and manipulating 

the database according to the requirements, as well as perform all the user roles.  

 • The user may also hire database system designers to design a system.  

 • In such a case, the single user performs the role of end user only. 

 • However, in most enterprises the large amount of data is to be managed and 

accessed by multiple users and thus, requires multi-user systems.  

 • In multi-user system, multiple users can access the database simultaneously.  

 • In multi-user DBMS, the data is both integrated and shared. 

 • For example, the Online Book database is a multi-user database system in which the 

data of books, authors, and publishers are stored centrally and can be accessed by 

many users. 

 

3. Based on Number of Sites:  

 • Depending on the number of sites over which the database is distributed.  

 • It is divided into two types, namely, centralized and distributed database systems.  

 • Centralized database systems run on a single computer system.  

 • Both the database and DBMS software reside at a single computer site.  

 • The user interacts with the centralized system through a dummy terminal connected 

to it for information retrieval.  

 • In distributed database systems, the database and DBMS are distributed over several 

computers located at different sites.  

 • The computers communicate with each other through various communication media 

such as high-speed networks or telephone lines.  

 • Distributed databases can be classified as homogeneous and heterogeneous. 



 • In homogeneous distributed database system, all sites have identical database 

management system software, whereas in heterogeneous distributed database 

system, different sites use different database management system software. 

 

 

4. Based on the Purpose:  

 • Depending on the purpose the DBMS serves, it can be classified as general purpose 

or specific purpose. 

 • DBMS is a general purpose software system. It can; however, be designed for 

specific purposes such as airline or railway reservation.  

 • Such systems cannot be used for other applications without major changes.  

 • These database systems fall under the category of online transaction processing 

(OLTP) systems.  

 • Online transaction processing system is specifically used for data entry and retrieval.  

 • It supports large number of concurrent transactions without excessive delays.  

 • An automatic teller machine (ATM) for a bank is an example of online commercial 

transaction processing application.  

 • The OLTP technology is used in various industries, such as banking, airlines, 

supermarkets, manufacturing, etc. 

 

10.17    Data Base Languages 

Once data is stored or filled it requires manipulation like insertion, deletion, updating, and 

modification of data. For these operations a set of languages are provided by the database 

management system (DBMS). So, the database languages are used to read, update and store data 

in the database. 

The different types of DBMS languages are as follows − 

 Data Definition Language (DDL) − Create, Drop, Truncate, Rename. 

 Data Manipulation language (DML) − Select, Insert, Delete, Update. 



 Data Control Language (DCL) − Revoke, Grant. 

 Transaction Control Language (TCL) − Rollback, Commit. 

The DBMS languages are pictorially represented as follows: 

 

1. Data Definition Language (DDL) 

It is a language that allows the user to define the data and their relationship to other types of data. 

The DDL commands are: Create, Alter, Rename, Drop, Truncate. 

2. Data Manipulation Language (DML) 



It is a language that provides a set of operations to support the basic data manipulation operation 

on data held in the database. The DML commands are: Insert, delete, update, select, merge, call. 

3. Data Control Language (DCL) 

DCL is used to access the stored data. It is mainly used for revoke and grant the user access to a 

database. The DCL commands are: Grant, Revoke.  

4. Transaction Control Language (TCL) 

TCL is a language which manages the transactions within the database. It is used to execute the 

changes made by the data manipulation language statements. The TCL commands are: Commit, 

Rollback. 

10.18 DATA BASE ADMINISTRATION AND ITS RESPONSIBILITY  

DBA is a person or group of persons responsible for overall control of the data base system. 

All the activities in data base system are controlled by DBA. The DBA must be expert in 

information technology and has a good skill of management. He acts as a mediator between the 

management and computer professional. A DBA must be well equipped with the knowledge of 

new development. The overall goal of DBA is to maintain the data base system and to provide 

the user with access to the required information when they need it. The DBA makes sure that the 

data base is protected and any chance of data loss is minimized. The responsibilities of data base 

administrator are listed below: 

 (i)  Deciding the information contents of database: It is the DBA who decides the 

information contents of data base. DBA decides fields, type of fields, its range of values 

that can be stored in the fields. 

 (ii) Deciding the user and data to be used by the user: It is the DBA who decides the 

users of the data base system. DBA also decides which information contents are to be 

used by any particular user. 

 (iii) Deciding the Hardware device to be used: It is the job of DBA to decide which 

hardware device will be suitable for current data base application. 



 (iv) Deciding the backup and Recovery Method: To avoid the accidental loss of data 

backup of the data is maintained on regular interval. It is the DBA who decides which 

data is to be backed up and when. If data is lost then it is the duty of DBA how to 

recover the data from the existing data backup. 

 (v) Ensuring that the data base is updated regularly and accurately. 

 (vi) Identifying and resolving user‟s problem. 

 (vii)  Procuring and maintaining data base software and related documents and tools. 

 (viii)  Facilitating sharing of common data by proper key management and data dictionary 

maintenance. 

 (ix)  Deciding the validation checks on the data. 

 (x)  Monitoring performance and responding to the changing requirement. The DBA is 

responsible for so organizing the system as to get the performance that is „„the best for 

the enterprise‟‟ and for making the appropriate adjustments as requirement changes. 

 (xi)  Access Strategy: It is the duty of DBA to decide the method of accessing the data. 

DBA also provides the permission who can access the data base and revoke the data 

base. 

10.19 DISADVANTAGES OF DBMS 

1. Complexity: To develop the software that is expected to be a good DBMS makes the 

DBMS extremely complex. Database Designer, Developers, Data Base, Administrator 

and user must understand this functionality to take full advantage of it. Failure to 

understand the system can lead to bad database design decisions which can have a 

serious result for an organization. 

2. Cost of DBMS: The cost of DBMS changes significantly, depending on the 

environment and functionality provided. There is also recurrent annual manual cost.  

3. Cost of Conversion: The cost of the DBMS and extra hardware may be in significant 

and compared with the cost of converting existing application to run on new DBMS 

and hardware. It also includes the cost of training staff to use these new systems and 

possibility. The employment of the specialist staff to help with the conversion and 

running of system. 



4. Higher Impact of Failure: The centralization of resources increases the chances of 

failure. Since all the user and application rely on the availability of DBMS, in failure of 

any component will lead halt of operations. 

5. Size: The functionality of DBMS makes the DBMS extremely large pieces of software, 

occupying many megabytes of disk space and requires subsantial amount of memory to 

run efficiently. 

6. Performance: Typically, file based system is written for the specific application. As a 

result the performance is generally very good. However, the DBMS is written to be 

more general, to satisfy the more application rather than just one. The effect is that 

some application may not run as fast as they used to. 

 

10.20 TEST YOUR UNDERSTANDING (A) 

 

1.  Define DBMS. Explain various components of DBMS. 

……………………………………………………………………………………………… 

……………………………………………………………………………………………… 

……………………………………………………………………………………………… 

……………………………………………………………………………………………… 

 

2.  Difference between Data and Information. 

…………………………………………………………………………………..…………. 

……………………………………………………………………………………………… 

………………………………………………………………………………………………. 

 

3. Fill in the Blanks 

a. ----------------- allows the user to define the data and their relationship to other types of 

data  

b. ------------------- Collection of interrelated data and a set of programs to access the data.  

c. Processed form of data is called ------------------ 

d. Collection of raw facts---------------. 



e. Row value of an Entity----------- 

 

 10.21Review Question 

 1. Define Data and Information ? 

 2. Differentitate between data and information ? 

 3. Define data base management system ? 

 4. What is Traditional file processing system ? 

 5. Give at least three reasons why DBMS is better than traditional file processing system? 

 6. What are the vious users of data base ? 

 7. Define field, data item, record and file ? 

 8. What are the disadvantages of traditional file processing system ? 

 9. List the objectives of DBMS ? 

 10. What are the components of DBMS ? 

 11. What is the significance of system in DBMS? 

 12. What do you understand by Redundancy ? What characteristics of file system can lead to 

it ? 

 13. Define Mata data ? 

 14. What is data migration ? 

 15. What is DBA ? 

 16. What is the role of DB designer in DBMS ? 

 17. Define data dictionary. 

 18. Define instance. 

Answer Key 1.20 A 

1. Data base Management System 

2. System 

3. Information 

4. Data 

5. Tuple 



1 
 

       M.COM 

SEMESTER II 

Course: Computer Applications in Accounting 

 

Structure 

UNIT 11: Introduction to Accounting 

11.1 Introduction  

11.2 Definition of Accounting  

11.3 Objectives and Scope of Accounting 

11.4 Accounting Cycle 

11.5 Accounting Concepts 

11.6 Accounting Conventions 

11.7 Accounting standards   

11.8 Classification of Accounts 

11.9 Accounting Systems 

11.10 Let Sum Up 

11.11 Test your Knowledge 

 

 

11.1 Introduction  

Accounting is a business language. We can use this language to communicate 

financialtransactions and their results. Accounting is a completeorganization to collect, 

analyses, and communicates financial information. The source of accounting is as ancient as 

money. In early days, the number of transactionswas very small, so every businessman could 

keep the record of transactions duringa specific period of time. Twenty-three centuries ago, 

an Indian scholar named Kautilya introduced the accounting concepts in his book 

Arthashastra. In hisbook, he described the art of proper account keeping and methods of 

checking accounts.Accounting records can be traced back to the earliest civilizations of 

China, Babylonia, Greece and Egypt. Accounting was used to keep records regarding the cost 

of labour and materials used in building great structures like the Pyramids.   

 

Steadily, the field of accounting has experiencednoteworthy changes in compliancewith the 

changes happening in the business scenario of the world.An accountant record financial 
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transactionsby following certain accountingprinciples and standards as prescribed,depending 

upon the size,description, volume, and other limitations of a particular business entity. 

Through the accounting process, we can ascertain the profit or loss of the businesson a 

specific date. It also aids us in analysing the historical performance and plan the 

futurecourses of action.Thus, accounting is a system meant for determining business 

activities, processing of transactions into reports and making the final results available to 

decision-makers. The documents, which communicate these findings about the performance 

of an organisation in monetary terms, are called financial statements. 

Just like arithmetic is a procedural element of mathematics, book keeping is the procedural 

element of accounting. Figure 1 shows how an accounting system operates in business 

andhow the flow of information occurs. 

 

 

11.2 Definition of Accounting 

The American Institute of Certified Public Accountant has defined FinancialAccounting 

as:“the art of recording, classifying and summarizing in a significant manner and in termsof 

money, transactions and events which in part at least of a financial character andinterpreting 

the results thereof.” 

 

11.3 Objectives and Scope of Accounting 

The main objectives of Accounting are discussed below: 

a. To keep systematic records: Accounting is done to keep organized record of 

financialtransactions. The mainpurpose of accounting is to help us gather financial 

data andto record it methodically to get correct and useful results of financial 

statements. 
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b. To ascertain profitability: With the help of accounting, we can assess the profits 

andlosses incurred during a specific accounting period. With the help of a Trading 

andProfit & Loss Account, we can effortlessly determine the profit or loss of a firm. 

c. To ascertain the financial position of the business: A balance sheet or a statement 

ofaffairs shows the financial position of a company as on a particular date. A 

correctlyprepared balance sheet gives us a view of financial health of any 

organisation, the financial status of the assets, the natureand value of liability, and 

also the capital position of the firm. With the help of that, wecan effortlesslydetermine 

the strength of any business entity. 

d. To assist in decision-making: For taking financial decisions for the future, one 

requires accurate and reliable financial statements. One of the main intents of 

accounting is to take right financial decisionsat right time. Thus, accounting provides 

you the platform to plan for the future with thehelp of past records by doing financial 

forecasting. 

e. To fulfil compliance of Law: Business entities such as companies, trusts, and 

societiesare being run and governed according to different legislative acts. Also, 

differenttaxation laws (direct and indirect tax) are also applicable to every business 

house. Therefore, everyone has to keep and maintain different types of accounts and 

records as prescribed bycorresponding laws of the land. Accounting helps in running 

a business in compliancewith the law. 

f. Useful for Investors and Creditors: 

Investors and creditors are keen to evaluate the profitability andsolvency of a 

company before they decide to provide money to theorganisation. Therefore, they are 

interested to obtain financialinformation about the company in which they are 

contemplating aninvestment. Financial statements are the principal source of 

informationto them which are published in annual reports of a company and 

variousfinancial dailies and periodicals. 

 

11.4 Accounting Cycle:  

Accounting cycle denotes the precise tasks included in completing an accountingprocess. The 

length of an accounting cycle can be monthly, quarterly, half-yearly, orannually. It may differ 

from organization to organization but the process remains thesame. The following chart 

shows the basic steps in an accounting cycle: 
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Accounting Process / Cycle 

The following are the steps followed in an accounting process: 

1. Collecting and Analysing Accounting Documents: It is a very vital step in which one 

examine the source documents like invoice, expenses vouchers, bank statements etc., and 

analyze them. For example, before entering transactions in books accountants take notice of 

cash, bank,sales, and purchase related documents. This is anongoing process throughout the 

accounting period. 

2. Posting in Journal: On the basis of the above documents, accountant pass journal 

entriesusing double entry system in which debit and credit balance remains equal. This 

processis repeated throughout the accounting period. 

3. Posting in Ledger Accounts: Debit and credit balance of all the above accountsaffected 

through journal entries are posted in ledger accounts. A ledger is simply acollection of all 

accounts bot debit and credit. Ordinarily, this is also a continuous process for the 

wholeaccounting period. 

4. Preparation of Trial Balance: As the name proposes, trial balance is a summary ofall the 

balances of ledger accounts regardless of whether they carry debit balance orcredit balance. 

Since, everyone follow double entry system of accounts, the total of all thedebit and credit 
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balance as appeared in trial balance remains equal. Typically, oneneed toprepare trial balance 

at the end of the said accounting period. 

5. Posting of Adjustment Entries: In this step, the adjustment entries are first passedthrough 

the journal, followed by posting in ledger accounts to give effect to the adjustment done, and 

finally in the trialbalance. As in number of cases, mostly accrual basis of accounting is 

followed to obtain thecorrect value of revenue, expenses, assets and liabilities accounts, for 

this purpose, we need to do these adjustment entries. This procedure is done at the end of 

each accounting period. 

6. Adjusted Trial Balance:After taking into account the above said adjustment entries, the 

next step is to createadjusted trial balance. Adjusted trial balance is a platform to prepare the 

financial statements of a company. 

7. Preparation of Financial Statements: Financial statements are the set of statementslike 

Income and Expenditure Account or Trading and Profit & Loss Account, CashFlow 

Statement, Fund Flow Statement, Balance Sheet or Statement of Affairs Account.With the 

help of trial balance, we classify all the financial information into financial 

statements.Financial statements clearly show the financial health of a firm by portraying its 

profitsor losses and financial position in the form of assets and liabilities as on date. 

8. Post-Closing Entries: All the different accounts of revenue and expenditure of the 

business entity are transferred to the Trading and Profit & Loss account at the end of the 

financial year. With the passing of theseentries, the balance of all the accounts of income and 

expenditure accounts come toNIL. The net balance of these entries which represents the 

profit or loss of the company is finally transferred to the owner‟s equity or capital 

account.We pass these entries only at the end of accounting period. 

9. Post-Closing Trial Balance:After closing, Trial Balance represents the balances ofAsset, 

Liabilities & Capital account at the end of a financial year. These balances are transferred to 

next financialyear as an opening balance. 

 

11.5 Accounting Concepts 

The most important concepts of accounting are as follows: 

a. Business Entity Concept 

Business Entity is the fundamental concepts of accounting. According to this concept, the 

business and the owner of the business are two distinct entities. In other words, the person 

investing in the business and business are separate.For example, Mr Alpha starts a new 

industry in the name and style of M/s XYZ Enterprisesand advanced a capital of Rs 
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10,00,000 in cash. The result will be that the cashbalance of M/s XYZ Enterprises will 

increase by a sum of Rs.10,00,000/-.At the same time, the liability of M/s XYZ Enterprises in 

the form ofcapital will also increase. It means M/ XYZ Enterprises is liable to payRs 

10,00,000 to Mr Alpha.In accounting we make a distinction between business and theowner. 

All the books of accounts records day to day financialtransactions from the view point of the 

business rather than from that ofthe owner. The proprietor is deemed as a creditor of the 

entity to the extent of the capital brought in the business by him. In the case of a limited 

company, this distinction can be easily retained because a company has a legal entity like a 

natural person it can engage itself in economic activities of buying, selling, producing, 

lending, borrowing and consuming of goods and services.  Though, it is somewhat difficult to 

show this distinction in the case of sole proprietorship and partnership.   

b. Money Measurement Concept 

According to this concept, only financial transactions can be recorded in the 

accountingrecord which can be measured in monetary terms.In other words, a fact or 

transaction or event which cannot be measured in terms of money cannot be recorded in the 

accounting books. As money is acknowledged not only as a means of exchange but also as a 

store of value, it has a very significantbenefit. As various assets and equities, which are else 

different, can be measured and expressed in terms of a common denominator i.e. money.  

This concept entails two severe weaknesses. Firstly, there are numerous facts which though 

very significant to the business, cannot be recorded in the books of accounts as they cannot 

be measured in money terms. For instance, general health condition of the Managing Director 

of the company, working conditions in which a worker has to work, sales policy followed by 

the undertaking, quality of product introduced by the enterprise, new competition faced by 

the organisation due to new products, althoughapply a great impact on the productivity and 

profitability of the enterprise, are not recorded in the books. Likewise, the information that a 

strike is about to startsinceworkers are discontented with the poor working conditions in the 

place of work will not be recorded even though this event is of great concern to the business. 

All these have aninfluence on the future profitability of the company.  

Secondly, use of money infers that we accept stable or constant value of rupee. Choosing this 

assumption means that the changes in the money value in future dates are suitably ignored. 

For instance, a piece of factory land purchased in 1995 for Rs. 20lakhs and another bought 

for the same amount in 2005 are recorded at the same price, though the first bought in 1995 

may be worth two times greater than the value recorded in the books because of rise in land 

prices. In fact, most bookkeepersare aware of this fact that purchasing power of rupee does 
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change but very few recognise this fact in accounting books and make allowance for 

changing price level. 

c. Going Concern Concept 

Our accounting is based on the notion that a business unit is a going concern. All the financial 

transaction of a business is recorded keeping this point of view in ourmind that a business 

unit is a going concern. Else, the bankerwill not offer loans, the supplier will not supply 

goods or services, the employeeswill not work properly, and the method of recording the 

transaction will changealtogether. Accounting presupposes that the business entity will 

continue tooperate for a long time in the future unless there is good indication to the contrary. 

The business is viewed as a going concern, that is, ascontinuing in operations, at least in the 

foreseeable future. In otherwords, there is neither the intent nor the necessity to liquidate the 

particular business venture in the predictable future. For of this belief, the accountant while 

valuing the assets does not take into account forced sale value of them. Infact, the assumption 

that the business is not expected to be sell out in the predictable future founds the basis for 

many of the valuations and allocations in accounting. For instance, the accountant charges 

depreciation on fixed assets. It is this assumption which inspires the decision of investors to 

pledge capital to enterprise. Only on the base of this assumption accounting practice can stay 

steady and attain the objective of appropriately reporting and recording on the capital 

invested, the effectiveness of management, and the position of the enterprise as a going 

concern. 

The concept of going concern does not work in the following cases: 

 If a unit is declared sick. 

 When a company is going to liquidate and a liquidator is appointed for the 

same. 

 When a business unit is passing through severe financial crisis and going to 

wind up. 

d. Cost Concept 

It is a very significant concept grounded on the Going Concern Concept. We record the 

valueof assets on the cost basis, not on the net realizable value or market value of the 

assetsbased on the assumption that a business unit is a going concern. No doubt, we decrease   

the value of assets providing depreciation to assets, but we ignore the market value ofthe 

assets.The cost concept ends any type of falsification while taking into account the 

netrealizable value or the market value. On the downside, this concept overlooks the effect of   

price rises in the market, which can from time to time be very steep. Still, the cost concept is   
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extensively and universally accepted on the basis of which we do the accounting of abusiness 

unit.The term „assets‟ denotes the resources land building, machinery etc. owned by a 

business. The money values that are assigned to assets are derived from the cost concept. 

According to this concept an asset is usually entered on the accounting records at the price 

paid to acquire it. For example, if a business buys a plant for Rs. 50 lakhs the asset would be 

recorded in the books at Rs. 50 lakhs, even if its market value at thattime happens to be Rs. 

75 lakhs. Therefore, assets are recorded at their originalpurchase price and this cost is the 

basis for all subsequent accountingfor the business. The term „book value‟ isused for amount 

shown in the accounting records.The cost concept does not mean that all assets remain on the   

accounting records at their original cost for all times to come. The asset   may systematically 

be reduced in its value by charging „depreciation‟. Depreciation   has the effect of reducing 

profit of each period. The prime purpose of   depreciation is to allocate the cost of an asset 

over its useful life and not   to adjust its cost. However, a balance sheet based on this concept 

can be   very misleading as it shows assets at cost even when there are wide   difference 

between their costs and market values. Despite this limitation   you will find that the cost 

concept meets all the three basic norms of   relevance, objectivity and feasibility.    

e. Dual Aspect Concept 

Financial accounting records all the transactions and eventsinvolving financial element. Each 

of such transactions requires twoaspects to be recorded. The acknowledgement of these two 

aspects of everytransaction is known as a dual aspect analysis. According to this concept    

every business transactions has dual effect. For instance, if a company sells goods of Rs. 

5,000 this transaction involves two aspects. One aspect isthe transfer of goods and the other 

part is immediate receipt of cash (inthe case of cash sales). In fact, the term „double entry‟ 

book keeping hascome into existence and in this system the total amount debited always     

equals the total amount credited. It stems from „dual aspect concept‟that at any point of time 

owners‟ equity and liabilities for any accountingentity will be equal to assets owned by that 

entity.  

This view isfundamental to accounting and could be articulated as the followingequalities:     

Assets = Liabilities + Owners Equity … (1)     

Owners’ Equity = Assets- Liabilities … (2)     

The above connection is known as the „Accounting Equation‟. Theterm „Owners Equity‟ 

signifies the funds supplied by the owners of theentity while the term „liabilities‟ signifies the 

claim of external parties suchas creditors, debenture-holders, loans from the bank against the 

assets of the business.Assets are the resources owned by a business. The total of assets will 
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beequal to total of liabilities plus owner‟s capital as all assets of the company are claimed by 

either owners or outsiders.There must be a double entry to complete any financial transaction, 

means debit shouldbe always equal to credit. Hence, every financial transaction has its dual 

aspect. 

f. Accounting Period Concept 

The life of a business unit is indefinite as per the going concern concept. To ascertain the 

profit or loss of a company, and to determine its financial position, profit & loss accountsand 

balance sheets are made at regular intervals of time, usually at the end of eachyear. This one-

year cycle is known as the accounting period. The reason of having anaccounting period is to 

take remedial measures keeping in view the past performances,to nullify the effect of 

seasonal changes, to pay taxes, etc.Based on this concept, revenue expenditure and capital 

expenditure are segregated.Revenues expenditure are debited to the profit & loss account to 

ascertain correct profitor loss during a specific accounting period. Capital expenditure comes 

in the class of those expenses, the advantage of which will be utilized in the next coming 

accountingperiods as well.Accounting period helps us establishthe correct financial position 

of the firm at regular intervals oftime, i.e., at the end of each accounting period. 

Though a twelve-month period is adopted for external reporting, a shorter span of period, 

say one month or three months is applied for internal reporting purposes to assess the 

financial performance. This concept presents difficulty for the process of allocation of long 

term costs. All the revenues and all the cost relating to the year in operation have to be taken 

into account while matching the earnings andthe cost of those earnings for the any accounting 

period. This holds goodnotwithstanding whether or not they have been received in cash or 

paid in      cash. In spite of the problems which stem from this concept, short termreports are 

of vital importance to owners, management, creditors and other interested parties. Hence, the 

accountants have no choice but to settle such difficulties. 

g. Matching Concept 

Matching concept is based on the accounting period concept. The expenditures of a firmfor a 

particular accounting period are to be matched with the revenue of the sameaccounting period 

to ascertain accurate profit or loss of the firm for the same period.This practice of matching is 

widely accepted all over the world. In reality, we match revenues and expenses during the 

accounting periods.Matching is the entire procedure of periodic earnings measurement, 

frequentlylabelled as a process of matching expenses with revenues. In other      words, 

income earned by the enterprise during a period can be measuredonly when the revenue 

earned during a period is compared with theexpenditure incurred for earning that revenue. 
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Broadly speaking revenueis the total amount realised from the sale of goods or provision of 

servicestogether with earnings from interest, dividend, and other items of income.Expenses 

are cost incurred in connection with the earnings of revenues.Costs incurred do not become 

expenses until the goods or services in question are exchanged. Cost is not identical with 

expense sinceexpense is sacrifice made, resource consumed in relation to revenuesearned 

during an accounting period. Only costs that have expired duringan accounting period are 

considered as expenses. For instance, if acommission is paid in January, 2022, for services 

enjoyed in November, 2021, that commission should be taken as the cost for services 

rendered in November 2021. On account of this concept, adjustments are made forall prepaid 

expenses, outstanding expenses, accrued income, etc.,while      preparing periodic reports.       

h. Accrual Concept 

As stated above in the matching concept, the revenue generated in the accounting periodis 

considered and the expenditure related to the accounting period is also considered.Based on 

the accrual concept of accounting, if we sell some items or we rendered someservice, then 

that becomes the point at which revenue is recognised or generatedregardless of whether 

wereceived cash or not. The same notion is relevant in case of expenses also. All theexpenses 

paid in cash or payable are considered and the advance payment of expenses, if any, is not 

taken in to account. The heart of the accrual concept is that net income arises from events that 

change the owner‟s equity in a specified period and that these are not necessarily the same as 

change in the cash position of the business. Thus it helps in proper measurement of income. 

 

i. Objective Evidence Concept 

According to the Objective Evidence concept, every financial entry should be 

supportedby some objective evidence like invoice, expenses voucher etc. Purchase 

should be backed by purchase bills, sale withsale bills, cash payment of expenditure 

with cash memos, and payment to creditors withcash receipts and bank statements. 

Similarly, stock should be checked by physicalverification and the value of it should 

be verified with purchase bills. In the absence ofthese, the accounting result will not be 

reliable, chances of falsification inaccounting records will be high, and no one will be 

able to rely on such financial statements. 

j. Realisation Concept 

Realisation is precisely appreciated as the process of converting non-cash resources 

and rights into money. As accounting principle, it is used to identify exactly the 

amount of revenue to be recognised and the amount of expense to be matched to such 
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revenue for the purpose of income measurement. According to realisation concept 

revenue is recognised when sale is made. Sale is measured to be made at the point      

when the property in goods passes to the buyer and he becomes legally liable to pay. 

This implies that revenue is generally realised when goods are delivered or services are 

rendered. The basis is that delivery legalizes a claim against the customer. Though, in 

case of long run construction contracts revenue is often recognised on the basis of a      

proportionate or partial completion method. Similarly, in case of long run      

instalment sales contracts, revenue is regarded as realised only in proportion to the 

actual cash collection. In fact, both these cases are the exceptions to the notion that an 

exchange is needed to justify the realisation of revenue.      

 

11.6 Accounting Conventions 

Following are the accounting conventions. 

i. Convention of Consistency 

To compare the results of different years over period of time, it is necessary that accounting 

rules,principles, conventions and accounting concepts for similar transactions are 

followedconsistently and continuously. Reliability of financial statements may be affected 

and lost, if there are frequent changes in following the accounting rules, principles, 

conventions while doing accounting treatment. For instance, if a company decidescost or 

market price whichever is lower method for stock valuation and written downvalue method 

for depreciation on fixed assets, it should be followed consistently andcontinuously over the 

long period of time.Consistency also states that if a change becomes necessary, the change 

and its effects onprofit or loss and on the financial position of the company should be clearly 

mentioned.In other words, accounting practices should remain unchanged from one period to 

another. However, this principle does not forbid introduction of improved accounting 

techniques. The application of the principle of consistency is essential for the purpose of 

comparison. One could get valid conclusions from the comparison of data extracted from the 

financial statements of one year with that of the other year. But the inconsistency in the 

application of accounting methods might significantly affect the reported data.   

ii. Convention of Disclosure 

The Companies Act, 2013, has recommended a format in which financial statements must 

beprepared. Every company that fall under this classification has to abide by this 

practice.Numerous provisions are made by the Companies Act to make these 

financialstatements. The main reason of these provisions is to disclose all essential 
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information sothat the view of financial statements should be true and fair. However, the 

term„disclosure‟ does not mean all information. It means disclosure of information that isof 

significance to the users of these financial statements, such as investors, owner, bankers, and 

Government Authorities and creditors. 

iii. Convention of Materiality 

Materiality concept affirms that items of small significance need not be given major 

importance. In fact, there are numerous events in business which are insignificant in nature. 

The cost of recording and showing in financial statement such events may not bejustified as 

there is no usefulnessoriginated from that information. For example, an ordinary calculator 

costing Rs. 200 may have life span of 5 years. Though, the effort involved in allocating its 

cost over the 5 years‟ period is not of any value that can be derived from this exercise. The 

cost incurred on calculator may be treated as the expense of the period in which it is 

purchased. Likewise, when anaging statement of outstanding debtors is prepared for sending 

to top management, figures may be rounded to the nearest ten or hundred. This convention 

will needlesslyoverload an accountant with more details in case he is incapable to find an 

objective difference between material and immaterial events. It should be noticed that an item 

material for one party may be immaterial for another. Actually, there are no hard and fast 

rules to draw the demarcated line between material and immaterial events and therefore, it is 

a subject of judgement and common sense. In spite of this drawback, it is necessary to 

disclose all material information to make the financial statements clear and understandable. 

Materiality should govern the selection and application of accounting policies.If the 

disclosure or non-disclosure of information might influence the decision of theusers of 

financial statements, then that information should be disclosed.  

iv. Conservation or Prudence 

This concept necessitates that the accountants must follow the policy of „„playing safe” while 

recording business transactions and events. That is why, the accountant follows the rule of 

anticipate no profit but provide for all possible losses and diminution in the value of the 

assets, while recording the business events. This rule means that an accountant should record 

lowest possible value for assets and revenues, and the highest possible value for liabilities 

and expenses. According to this concept, revenues or gains should be recognised only when 

they are realised in the form of cash or assets (i.e. debts) the ultimate cash realisation of 

which can be assessed with reasonable certainty. Further, provision must be made for all 

known liabilities, expenses and losses, Likely losses regarding all contingencies should also 

be provided for. „Valuing the stock in trade at market price or cost price whichever is less‟, 
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„making the provision for doubtful debts on debtors in anticipation of actual bad debts‟, 

„adopting written down value method of depreciation as against straight line method‟, not 

providing for discount on creditors but providing for discount on debtors‟, are some of the 

examples of the application of the convention of conservatism. The principle of conservatism 

may also invite disapproval if not applied cautiously. For example, when the accountant 

creates secret reserves, by creating excess provision for bad and doubtful debts, depreciation, 

etc. The financial statements do not present a true and fair view of state of affairs. American 

Institute of Certified Public Accountant have also indicated that this concept need to be 

applied with much more caution and care as over conservatism may result in 

misrepresentation.It is a policy of playing safe. For future events, profits are not anticipated, 

but provisionsfor losses are provided as a policy of conservatism.  

 

11.7 Accounting standards   

The accounting concepts and conventions discussed above are the core elements in the theory 

of accounting. These principles, though, agree to a variety of different practices to co-exist.  

On account of this the financial results of different companies are difficult to compare and 

appraise unless otherwise full information is available about the accounting methods which 

have been followed. The lack of uniformity among accounting practices used by different 

business organisation have made it difficult to compare the financial results of different 

companies. It means that there should not be too much discretion to companies and their 

accountants to present financial information the way they like. In other words, the 

information contained in financial statements should conform to carefully considered 

standards.  

Obviously, accounting standards are needed to:   

a) provide a basic framework for preparing financial statements to be uniformly followed by 

all business enterprises,  

b) Make the financial statements of one firm comparable with the other firm and the financial 

statements of one period with the financial statements of another period of the same firm,   

c) Make the financial statements credible and reliable, and   

d) Create general sense of confidence among the outside users of financial statements.   

In this context unless there are reasonably appropriate standards, neither the purpose of the 

individual investor nor that of the nation as a whole can be served. In order to harmonise 

accounting policies and to evolve standards the need in the USA was felt with the 

establishment of Securities and Exchange Commission (SEC) in 1933. In 1957, a research 
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oriented organisation called Accounting Principles Boards (APB) was formed to spell out the 

fundamental accounting principles. After this the Financial Accounting Standards Board 

(FASB) was formed in 1973, in USA. At the international level, the need for standardisation 

was felt and therefore, an International Congress of accountants was organised in Sydney, 

Australia in 1972 to ensure the desired level of uniformity in accounting practices. Keeping 

this in view, International Accounting Standards Committee (IASC) was formed and was 

entrusted with the responsibility of formulating international standards.  In order to 

harmonise varying accounting policies and practices, the Institute of Chartered Accountants 

of India (ICAI) formed the Accounting Standards Board (ASB) in April, 1977. ASB includes 

representatives from industry and government. The main function of the ASB is to formulate 

accounting standards. This Board of the Institute of Chartered Accountants of India has so far 

formulated around 32 Accounting Standards. 

 

11.8 Classification of Accounts It is essential to have knowledge in regards to the 

classification of accounts and their treatment in double entrysystem of accounts. Broadly, the 

accounts are classified into three categories: 

i. Personal AccountsPersonal accounts may be further classified into three 

categories: 

Natural Personal Account: An account related to any individual like Sanjeev, 

Ronald, Ram, or Shyam is called as aNatural Personal Account. 

Artificial Personal Account: An account related to any artificial person like M/s 

XYZ Ltd, M/s GTAENTERPRISES, etc., is called as an Artificial Personal 

Account. 

Representative Personal Account:Representative personal account represents a 

group of account. If there are a number ofaccounts of similar nature, it is better to 

group them like salary payable account, rentpayable account, insurance prepaid 

account, interest receivable account, capital accountand drawing account, etc. 

ii. Real Accounts: Every Business has some assets and every asset has an account. 

Thus, asset account iscalled a real account. There are two type of assets:Tangible 

assets are touchable assets such as plant, machinery, furniture, stock,cash, 

etc.Intangible assets are non-touchable assets such as goodwill, patent, 

copyrights,etc.Accounting treatment for both type of assets is same. 

iii. Nominal Accounts: As this account does not represent any tangible asset, it is 

called nominal or fictitiousaccount. All kinds of expense account, loss account, 



15 
 

gain account or income accounts.come under this category of nominal account. 

For example, rent account, salary account,electricity expenses account, interest 

income account, etc. 

 

11.9 Accounting Systems 

 There are two systems of accounting followed: 

  Single Entry System 

  Double Entry System 

i. Single Entry System 

Single entry system is an incomplete system of accounting, this system is 

followed by small businessmen, where there are very few transactions. In this 

system ofaccounting, only personal accounts are opened and maintained by a 

business owner.  Occasionally subsidiary books are also maintained but not 

regularly. Since real and nominalaccounts are not opened by the business owner, 

preparation of profit & loss account andbalance sheet is difficult. Hence it is tough 

to ascertain the correct position of profit or loss or financialposition of business 

entity. 

ii. Double Entry System: Double entry system of accounts is a scientific system of 

accounts followed all over theworld without any question. It is an old system of 

accounting. It was developed by „LucoPacioli‟ of Italy in 1494. Under the double 

entry system of account, every entry has itsdual aspects of debit and credit. It 

means, assets of the business always equal to liabilities of the business. 

Assets = Liabilities If we give something, we also get something in return and 

vice versa.Rules of Debit and Credit Under Double Entry System of Accounts 

 

11.10 LET US SUM UP 

 

Accounting is a business language. We can use this language to communicate financial 

transactions and their results. Accounting is a complete organization to collect, analyzes, and 

communicates financial information. It also aids us in analysing the historical performance 

and plan the future courses of action. Thus, accounting is a system meant for determining 

business activities, processing of transactions into reports and making the final results 

available to decision-makers. The main objectives and Scope of Accounting to keep 
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systematic records, to ascertain profitability, to ascertain the financial position of the 

business, to assist in decision-making, to fulfil compliance of Law and useful for investors 

and creditors. Accounting cycle denotes the precise tasks included in completing an 

accounting process. The length of an accounting cycle can be monthly, quarterly, half-yearly, 

or annually. There are number of accounting concepts to be followed for proper maintenance 

of accounts like business entity concept, money measurement concept, going concern 

concept, cost concept, dual aspect concept, accounting period concept, matching Concept, 

accrual concept, objective evidence concept and realisation concept. Every organisation to 

follow certain accounting conventions like consistency, disclosure, materiality and 

conservation or prudence for enhancing the reliability of the user of the financial statements. 

Accounts are to be classified in to personal, real and nominal. There are two accounting 

system namely single entry and double entry system but now a day‟s double entry system is 

in practice. 

 

11.11 Test your Knowledge 

Questions 

1. What are the various interested parties which use accounting information? How is 

such information used?   

2. Examine the role of accounting concepts in the preparation of financial statements. 

Do you find any of the accounting concepts conflicting with each other? Give 

examples.   

3. Discuss briefly the basic concepts and conventions of accounting?     

4. Write short notes on 

             a) Going concern concept  

            b) Dual aspect concept   

            c) Business entity concept  

            d) Convention of materiality  

            e) Convention of conservatism   

      5. Why accounting practices should be standardised? Explain 

      6. Discuss about the accounting conventions followed by the accountants to prepare    

financial statement. 
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12.0 Objective 

 After studying the Unit, you would be able to learn 

 Fundamentals of data and database 

 Use of MS-Excel in Accounting 

 Creation and calculation on data tables 

 Different accounting functions and their usage 

 

12.1 Introduction to Data and Database 

In day-to-day life or in business we need information to take decisions. Information 

should be accurate, precise and well presented for effective decision making. For this, 

we have to collect, store and process the data using software. Data is the raw facts 

which are gathered from different sources and may not be organized form. First we 

have to collect and store the data in forms of files or in database and then we have to 

process it to convert into meaningful information that will help us in making 

decisions. Database is an organized collection of interrelated data.  

Computerized Accounting involves following processes: 



1. Identifying the Resources: The first step in computerized accounting is to identify 

the data resources. It may be the vouchers in which day-to-day transactions are 

recorded.   

2. Data Capture: The data in the vouchers need to be recorded in computers for 

permanent storage. We need to prepare a data entry form to capture the data. The 

data also can be captured directly from business transactions. 

3. Data Storage: A suitable storage structure is required to store the data permanently 

and it can access easily for further processing. It may be in tabular form consists 

of rows and columns.   

4. Data Manipulation: The stored data is processed using the software to generate 

information that will help the managers in making decisions. There are formulas 

or functions to manipulate the data and convert it into meaningful information. 

5. Reports: At the end, the reports will be generated containing output of data for 

making decisions. There are pre-designed accounting reports such as legers, 

balance sheet, profit/loss A/c, etc. 

 

12.2 Introduction to MS-Excel 

 Microsoft Excel is a spreadsheet application software use to create workbooks 

 consists of worksheets. Each worksheet is a collection of rows and columns. The data 

 is organized in form of tables in these worksheets so that it can be easily managed. It 

 is also used as a data manipulation, visualization and analysis tool for generating 

 meaningful information. Excel has built in library functions for financial, logical, 

 mathematical, statistical, text and other formulas. We can do all types of day-to-day 

 and business calculations using these functions. It can be also used as a reporting tool 

 that can generate different types of graphs for better visualization of data.  

 

12.3 Creating Data Table 

 Microsoft Excel is used to store large amount of data in worksheets. One workbook 

 has no of worksheets, consists of rows and columns. The total no of rows and cols 

 varies from version to version. The  intersection of a row and a column is known as a 

 cell. Each cell may have data in different formats or formulas for calculations. 



 

 To create a new workbook we either go to Office Button/File menu then New or use 

 shortcut key Ctrl+N. To open an existing file we go to Office Button/File menu then 

 Open or use shortcut key Ctrl+O. Shift+F11 is used to create a new worksheet. We 

 can now define the column heading and enter the data. Select a cell to enter data or 

 formulas. To move to the next column press Tab and press Enter to move to the next 

 row. We may also use arrow keys to move to other cells.   

 If you want to select any data, then click on the cell. To select multiple continuous 

 data, from the first cell drag the cursor to the end. To select the entire row and column 

 click the row number (1,2…) and column name(A,B...).  

 



 For other basic operations following shortcut keys are used. 

Select entire worksheet Ctrl + A 

Save the Workbook Ctrl + S 

Copy data in a Cell Ctrl + C 

Paste data in a Cell Ctrl + V 

Cut data in a Cell Ctrl + X 

Move to the First Cell Ctrl + Home 

Move to the Last Used Cell Ctrl + End 

Move to the Last Column Ctrl + → 

Move to the Last Row Ctrl + ↓ 

Move to the First Column Ctrl + ← 

Move to the First Row Ctrl + ↑ 

 

12.4 Calculations on Data Table 

 In Microsoft Excel we can do day-to-day calculations like addition, subtraction, 

 multiplication, division, and etc. There are multiple ways to do these operations on 

 rows or columns. We may use our own formula or library functions in the cells to do 

 the calculations.  

  

 

  

 If you select continuous data cells, the sum will be automatically displayed on the 

 status bar of the Excel. You may also use auto sum or SUM formula to do the same.

 In formula bar we may also write the formula starting with = for any calculation 

 using following steps. 

 Step1: Place the cursor on the empty cell bellow the column where you want to 

 calculate the total sum. 



 

Step2: Start typing the formula starting with = sign followed by the formula or 

function. In the parameter mention the range of cells for which you want to calculate 

the sum. Then press enter key to find the result. 

 

 Like SUM other functions can be also used using same procedure. Using these 

 functions calculations will be faster and efficient.  

 For subtraction select the cell where to display the result as C5 in figure below. Type 

 = followed by first cell C2 then – then select the second cell C3. To get the result in 

 C5 press the Enter key. 

 



 Like addition and subtraction we can also find average of a set of data using 

 AVERAGE function in Excel. The AVERAGE function calculates the average of a 

 set of data by taking the value, range or reference to the cell as argument.  

 

The Average function includes Zero values but ignore empty and text values. There is 

another function AVERAGEA which include all values including text value as zero. 

It includes Zero values but ignores empty cells.  AVERAGEIF also can be used to 

find the average of values based on a given condition. 

Check Your Progress 

1. MS-Excel is a flat file database which organizes the data in forms of tables, 

rows and columns. (True/False) 

2. Microsoft Excel is a system software use to create workbooks consists of 

worksheets. (True/False) 

3. What is the shortcut key to create a new worksheet in MS-Excel? 

4. What is the shortcut key to move to the last used cell in the worksheet? 

5. What is the shortcut key to create a new workbook in MS-Excel? 

 

12.5 MS-Excel Functions for Accounting 

 Microsoft Excel is also used for accounting and budgeting. In small organization, 

 Excel may be used to maintain records of accounts. The financial statements and 

 balance sheet can be prepared in MS-Excel. MS-Excel can be integrated with 

 other legacy software platforms for import and export of financial data. The financial 

 data can be organized into accountancy tables using formulas, predefined  functions 

 and templates.  

  



 Accounting Formulas and Functions in Excel 

1. COUNT( ): This function count no of cells containing values. 

=COUNT(value1,[value2],…) OR =COUNT(range of cells) 

 

 Above example counts no of cells containing values in the range D2:D6.  

2. COUNTIF( ): Counts no of cells containing values based on a condition. 

=COUNTIF(range, criteria) 

 

 Above example counts no of cells containing values >=15 in the range D2:D6.   

3. COUNTIFS( ): Counts the no of cells containing values based on multiple 

criteria. 

=COUNTIFS(range1,criteria1,[range2,criteria2],…) 

 This function can be used with condition or criteria based on numbers, text, 

date and other conditions.  

 It supports logical operators (>,<,< >,=) 

 It supports wildcard characters „*‟ and „?‟ for partial matching. 



 

 Above example counts no of cells containing values in the range based on  two 

 conditions. 

1. Quantity should be >=15 

2. Price should be  >= 20000 

4. ROUND( ): This function is used to set the no of decimal places for the result. 

=ROUND(Value,No of Decimal Places) 

 

5. SUMIF( ): Find the sum of values based on condition or criteria 

=SUMIF(range, criteria, [sum range]) 

 



 SUMIF(D2:D7,”>=15”) : Sum the values >=15 in the range D2:D7. 

 SUMIF(D2:D7,”Television”,B2:B7):  Sum of Televisions 

6. Compound Interest: 

The future value at a constant rate of interest of an investment can be calculated 

using following formula. 

=p*(1+r)^n 

 p -> Principal Amount 

 r -> Rate of interest per year 

 n -> No of periods of investment 

 

 The rate of interest can be monthly, quarterly and bi-annually also. 

7. FV( ): The future value of investment can be also calculated using FV( ) function. 

=FV(rate,nper,pmt,[pv],[type]) 

 rate: Rate of interest per period 

 nper: No of compounding period 

 pmt: Additional payment per period 

 pv: Principal Investment (Optional) 

 type: “0” represent payment at the end of the period and “1” represent payment at 

 the beginning of the period. (Optional) 

 Units for rate and nper must be consistent.  

 Payment value must be negative, if pmt is for cash out. 

 Payment value must be positive, if cash received. 

 Example:  

  Future value =FV(B2/B3,B3*B4,0,-B1) 

  B2/B3 – Rate of interest per period 

  B3*B4 – No of compounding period 



  0 – Additional payment per period 

  B1 – Principal Investment 

 

8. PMT( ): This function is used to find the payment for a loan, based on constant 

rate of interest and constant payment. 

=PMT(rate,nper,pv,[fv],[type]) 

 rate: Rate of interest 

 nper: Total no of payments 

 pv: Principal Value 

 fv: Balance after last Instalment [Optional] 

 type: „0‟ - Payment at the end of the period, „1‟- Payment at beginning of the 

 period.[Optional] 

 

9. IPMT( ): It is used to find the interest portion on fixed loan payment for a given 

period. 

=IPMT(rate, per,nper,pv,[fv],[type]) 

rate: Rate of interest 

per: Period to find the interest 



nper: Total number of payments period in a year 

pv: Principal Value 

fv: Balance after the last instalment. (Default Value= 0) [Optional] 

type: “0” – Payment at the end of the period and “1” – Payment at the beginning 

of the period.[Optional] 

 

10. VLOOKUP( ) : This function is used to search for a value in a large table based 

on conditions. It is used find the exact match or the closest match. 

=VLOOKUP(lookup_value,table_array,col_index_num,[range_lookup]) 

 

 In the above example, to calculate the total incentive for an employee we search 

 for the incentive per one unit in the master table using following formula and 

 multiply with quantity sale. 

 Total Incentive = C10*VLOOKUP(B10,$A$2:$E$6,5,FALSE) 

 B10 – The cell value that we want to search in master table. 

 $A$2:$E$6 – The table array representing the master table. 



 5 – The column no of the master table from where we want to extract 

 information 

 FALSE- for the exact match. We may also use TRUE for the closest match 

Check Your Progress 

6. Which function is used to count values based on a condition? 

7. Which function is used to set the no of decimal places for the value? 

8. Which function is used to find the sum of values based on condition or 

criteria? 

9. Which function is used to find the payment for a loan, based on constant rate 

of interest and constant payment? 

10.  Which function is used to find the interest portion on fixed loan payment for a 

given period? 

12.6 Summary 

 MS-Excel is a powerful tool for accounting calculations. The day-to-day transactions 

 can be recorded in MS-Excel as a data table. There are predefined functions to 

 process these data and generate reports. Predefined templates are available for 

 accounting reports like balance sheet, profit loss account, etc. MS-Excel can be also 

 used as database for other legacy software. For small organization all the financial 

 data can be recorded in worksheets, those can be used for business processes and 

 decision making. 

12.7 Keywords 

 DATA   Raw facts and figures gathered from different sources and may 

    not be  organised form. 

 INFORMATION Organised form of data that may be used for further processing. 

 DATABASE  Organised collection of interrelated data. 

 WORKBOOK  Collection of worksheets, those hep to organise data. 

 WORKSHEET Collection of cells organised in rows and columns 

  

12.8 Answer to Test Your Progress 

 1. True    6. COUNTIF 

 2. False    7. ROUND 

 3. Shift+F11   8. SUMIF 

 4. Ctrl+End   9. PMT 

 5. Ctrl+N    10. IPMT 



12.9 Terminal Questions 

 1. Describe the five processes in computerized accounting. 

 2. Describe the application of MS-Excel for accounting. 

 3. Describe different COUNT functions with example. 

 4. Describe the FV function with example. 

 5. Describe VLOOKUP function with example. 

 

12.10 Assignment 

 1. Describe five accounting functions in Ms-Excel with example. 

 2. Describe the five processes in computerized accounting. 

 

  


